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About this topic collection

This PDF has been created from the WebSphere Event Broker Version 6.0 GA
(September 2005) information center topics. Always refer to the WebSphere Event
Broker online information center to access the most current information. The
information center is periodically updated on the [document update|site and this
PDF and others that you can download from that Web site might not contain the
most current information.

The topic content included in the PDF does not include the "Related Links”
sections provided in the online topics. Links within the topic content itself are
included, but are active only if they link to another topic in the same PDF
collection. Links to topics outside this topic collection are also shown, but these
attempt to link to a PDF that is called after the topic identifier (for example,
ac12340_.pdf) and therefore fail. Use the online information to navigate freely
between topics.

Feedback: do not provide feedback on this PDF. Refer to the online information to
ensure that you have access to the most current information, and use the Feedback
link that appears at the end of each topic to report any errors or suggestions for
improvement. Using the Feedback link provides precise information about the
location of your comment.

The content of these topics is created for viewing online; you might find that the
formatting and presentation of some figures, tables, examples, and so on are not
optimized for the printed page. Text highlighting might also have a different
appearance.
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Developing message flows

There are many tasks involved in creating and maintaining message flows:
« |“Designing a message flow” on page 10|

« [“Creating a message flow project” on page 30|

¢ [“Deleting a message flow project” on page 31|

* [“Creating a broker schema” on page 32|

* [“Creating a message flow” on page 32|

* [“Opening an existing message flow” on page 33|

* [“Defining message flow content” on page 41|

* [“Saving a message flow” on page 3§

* ["Copying a message flow using copy” on page 34|

* [“Renaming a message flow” on page 34

e ["Moving a message flow” on page 35|

+ |“Deleting a message flow” on page 36|

+ |“Deleting a broker schema” on page 37|

+ |“Defining promoted properties” on page 51|

+ [“Collecting message flow accounting and statistics data” on page 60)

The workbench provides a set of toolbar icons that invoke wizards that you can
use to create any of the resources associated with message flows, for example,
message flow projects. Hover your mouse pointer over each icon to see its
function.

The workbench lets you open resource files with other editors. Use only the
workbench message flow editor to work with message flow files, because this
editor correctly validates all changes that you make to these files when you save
the message flow.

When you have completed developing your message flow, [deploy it to a broker|to
start its execution.

Message flows overview

A message flow is a sequence of processing steps that execute in the broker when
an input message is received.

You define a message flow in the workbench by including a number of message
flow nodes, each of which represents a set of actions that define a processing step.
The connections in the flow determine which processing steps are carried out, in
which order, and under which conditions. A message flow must include an input
node that provides the source of the messages that are processed. You must then
deploy the message flow to a broker for execution.

You can create a message flow using the built-in nodes or other message flows
(known as subflows). When you want to invoke a message flow to process
messages, you deploy it to a broker, where it is executed within an execution

group.

The following topics describe the concepts that you need to understand to design,
create, and configure a message flow and its associated resources:

* |Projects

* [Node

© Copyright IBM Corp. 2000, 2005 3



+ |"Connections” on page 5|

* |“Properties” on page

* |Accounting and statistics data
* [“Data conversion” on page 18

Message flow projects

A message flow project is a specialized container in which you create and maintain
all the resources associated with one or more message flows.

You can create a message flow project to contain a single message flow and its
resources, or you can group together related message flows and resources in a
single message flow project to provide an organizational structure to your message
flow resources.

Message flow project resources are created as files, and are displayed within the
project in the Navigator view. These resources define the content of the message
flow.

Message flow nodes

4 Message Flows

A message flow node is a processing step in a message flow.

It receives a message, performs a set of actions against the message, and optionally
passes the message on to the next node in the message flow. A message flow node
can be a built-in node , a user-defined node, or a subflow node.

A message flow node has a fixed number of input and output points known as
terminals. You can make connections between the terminals to define the routes
that a message can take through a message flow.

Built-in node
A built-in node is a message flow node that is supplied by WebSphere
Event Broker. The built-in nodes provide input and output functions.

For information on all the built-in nodes supplied by WebSphere Event
Broker, see |“Built-in nodes” on page 107

User-defined node
A user-defined node is an extension to the broker that provides a new
message flow node in addition to those supplied with the product. It must
be written to the user-defined node API provided by WebSphere Event
Broker for both C and Java languages.

Subflow
A subflow is a directed graph that is composed of message flow nodes and
connectors and is designed to be embedded in a message flow or in
another subflow. A subflow must include at least one Input node or one
Output node. A subflow can be executed by a broker only as part of the
message flow in which it is embedded, and therefore cannot be
independently deployed.

The subflow, when it is embedded in a main flow, is represented by a
subflow node, which has a unique icon. The icon is displayed with the
correct number of terminals to represent the Input and Output nodes that
you have included in the subflow definition.



A node does not always produce an output message for every output terminal:
often it produces one output for a single terminal based on the message received
or the result of the operation of the node.

If more than one terminal is connected, the node sends the output message on
each terminal, but sends on the next terminal only when the processing has
completed for the current terminal. Updates to a message are never propagated to
previously-executed nodes, only to nodes following the node in which the update
has been made. The order in which the message is propagated to the different
output terminals is determined by the broker; you cannot change this order.

The message flow can accept a new message for processing only when all paths
through the message flow (that is, all connected nodes from all output terminals)
have been completed.

For information on all the built-in nodes

Connections

A connection is an entity that connects an output terminal of one message flow
node to the input terminal of another. It represents the flow of control and data
between two message flow nodes.

The connections of the message flow, represented by black lines within the
message flow editor view, determine the path that a message takes through the
message flow. You can add bend points to the connection to alter the way in which
it is displayed.

See for a description of bend points. See for a

description of terminals.

Bend points
A bend point is a point that is introduced in a connection between two message
flow nodes at which the line that represents the connection changes direction.

Use bend points to change the visual path of a connection to display node
alignment and processing logic more clearly and effectively. Bend points have no
effect on the behavior of the message flow; they are visual modifications only.

A connection is initially made as a straight line between the two connected nodes
or brokers. Use bend points to move the representation of the connection, without
moving its start and end points.

Terminals
A terminal is the point at which one node in a message flow is connected to
another node.

Use terminals to control the route that a message takes, depending whether the
operation performed by a node on that message is successful. Terminals are wired
to other node terminals using message flow node connections to indicate the flow
of control.

Every built-in node has a number of terminals to which you can connect other
nodes. Input nodes (for example, MQInput) do not have in terminals; all other
nodes have at least one in terminal through which to receive messages to be
processed. Most built-in nodes have failure terminals that you can use to manage
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the handling of errors in the message flow. Most nodes have output terminals
through which the message can flow to a subsequent node.

If you have any user-defined nodes, these might also have terminals that you can
connect to other built-in or user-defined node terminals.

Properties

This topic discusses the following types of broker properties:

* Promoted properties: see[“Promoted properties.”|

Promoted properties
A promoted property is a message flow node property that has been promoted to
the level of the message flow in which it is included.

A message flow contains one or more message flow nodes, each of which is an
instance of a message flow type (a built-in node). You can promote the properties
of a message flow node to apply to the message flow to which it belongs. If you
do this, any user of the message flow can set values for the properties of the nodes
in this higher message flow by setting them at the message flow level, without
being aware of the message flow’s internal structure.

You can promote compatible properties (that is, properties that represent
comparable values) from more than one node to the same promoted property; you
can then set a single property that affects multiple nodes.

A subset of message flow node properties is also configurable (that is, the
properties can be updated at deploy time). You can promote configurable
properties: if you do so, the promoted property (which can have a different name
from the property or properties that it represents) is the one that is available to
update at deploy time. Configurable properties are those associated with system
resources, for example queues: they can be set at deploy time by an administrator
rather than a message flow developer.

Broker schemas

6 Message Flows

A broker schema is a symbol space that defines the scope of uniqueness of the
names of resources (message flows)defined within it.

The broker schema is defined as the relative path from the project source directory
to the flow name. When you first create a message flow project, a default broker
schema named (default) is created within the project.

You can create new broker schemas to provide separate symbol spaces within the
same message flow project. A broker schema is implemented as a folder, or
subdirectory, within the project, and provides organization within that project. You
can also use project references to spread the scope of a single broker schema across
multiple projects to create an application symbol space that provides a scope for all
resources associated with an application suite.

A broker schema name must be a character string that starts with a Unicode
character followed by zero or more Unicode characters or digits, and the
underscore. You can use the period to provide a structure to the name, for example
Stock.Common. A directory is created in the project directory to represent the
schema, and if the schema is structured using periods, further subdirectories are
defined. For example, the broker schema Stock.Common results in a directory
Common within a directory Stock within the message flow project directory.



If you create a message flow resource in the default broker schema within a
project, the file or files associated with that resource are created in the directory
that represents the project. If you create a resource in another broker schema, the
files are created within the schema directory.

For example, if you create a message flow Update in the default schema in the
message flow project Projectl, its associated files are stored in the Projectl
directory. If you create another message flow in the Stock.Common broker schema
within the project Projectl, its associated files are created in the directory
Project]1\Stock\Common.

Because each broker schema represents a unique name scope, you can create two
message flows that share the same name within two broker schemas. The broker
schemas ensure that these two message flows are recognized as separate resources.
The two message flows, despite having the same name, are considered unique.

If you move a message flow from one project to another, you can continue to use
the message flow within the original project if you preserve the broker schema. If
you do this, you must update the list of dependent projects for the original project
by adding the target project. If, however, you do not preserve the broker schema,
the flow becomes a different flow because the schema name is part of the fully
qualified message flow name, and it is no longer recognized by other projects. This
action results in broken links that you must manually correct. For further
information about correcting errors after moving a message flow, see
imessage flow” on page 35/

Do not move resources by moving their associated files in the file system; you
must use the workbench to move resources to ensure that all references are
corrected to reflect the new organization.

Message flow accounting and statistics data

Message flow accounting and statistics data is the information that can be collected
by a broker to record performance and operating details of message flow
execution.

Message flow accounting and statistics data records dynamic information about the
runtime behavior of a message flow. For example, it indicates how many messages
are processed and how large those messages are, as well as CPU usage and
elapsed processing times. The data is collected by the broker and is recorded in a
specified location when one of a number of events occurs (for example, when you
stop data collection).

Accounting and statistics data is collected only for message flows that start with an
MQInput, HTTPInput, or user-defined input node. If you start data collection for a
message flow that starts with this node, the data is collected for all built-in and
user-defined nodes, including those in subflows. If the message flow starts with
another input node (for example, a Real-timelnput node), no data is collected (and
no error is reported).

Collecting message flow accounting and statistics is optional; by default it is
switched off. To use this facility, request it on a message flow, execution group, or
broker basis. Data collection is started and stopped dynamically when you issue
the mgsichangeflowstats command; you do not need to make any change to the
broker or to the message flow, or redeploy the message flow, to request statistics
collection.

Developing message flows 7



8 Message Flows

You can activate data collection on both your production and test systems. If you
collect the default level of statistics (message flow), the impact on broker
performance is minimal. However, collecting terminal statistics can generate high
volumes of report data that might cause a small but noticeable performance
overhead.

When you plan data collection, consider the following points:
* |Collection options
e |Accounting origin|
* |Output formats|

You can find more information on how to use accounting and statistics data to
improve the performance of a message flow in this [developerWorks article onl
Imessage flow performance}

When you have decided how you want to handle data collection, and what
resources you want data collected for, you can invoke the mgsichangeflowstats
command to start the collection.

Message flow accounting and statistics collection options
The options that you specify for message flow accounting and statistics collection
determine what information is collected.

You can request snapshot or archive data collection. You can activate snapshot data
collection while archive data collection is active. The data recorded in both reports
is the same, but is collected for different intervals. If you activate both snapshot
and archive data collection, be careful not to combine information from the two
different reports, because you might count information twice.

* Snapshot data is collected for an interval of approximately 20 seconds. The exact
length of the interval depends on system loading and the level of current broker
activity. You cannot modify the length of time for which snapshot data is
collected. At the end of this interval, the recorded statistics are written to the
output destination and the interval is restarted.

* Archive data is collected for an interval that you have set for the broker on the
mgsicreatebroker or mgsichangebroker command. You can specify an interval of
between 10 and 14400 minutes. At the end of this interval, the recorded statistics
are written to the output destination and the interval is restarted.

An interval is prematurely expired and restarted when any of the following
events occur:

— The message flow is redeployed.

— The set of statistics data to be collected is modified.

— The broker is shut down.

This preserves the integrity of the data already collected when that event occurs.

On z/0S, you can set the command parameter to 0, which means that the
interval is controlled by an external timer mechanism. This support is provided
by the Event Notification Facility (ENF), which you can use instead of the broker
command parameter if you want to coordinate the expiration of this timer with
other system events.

You can use the statistics generated for the following purposes:

* You can record the load that applications, trading partners, or other users put on
the broker. This allows you to record the relative use that different users make of
the broker, and perhaps to charge them accordingly. For example, you could
levy a nominal charge on every message that is processed by a broker, or by a
specific message flow.


http://www.ibm.com/developerworks/websphere/library/techarticles/0406_dunn/0406_dunn.html
http://www.ibm.com/developerworks/websphere/library/techarticles/0406_dunn/0406_dunn.html

Archive data provides the information that you need for a use assessment of this
kind.

* You can assess the execution of a message flow to determine why it, or a node
within it, is not performing as you expect.

Snapshot data is appropriate for performance assessment.

* You can determine the route that messages are taking through a message flow.
For example, you might find that an error path is taken more frequently than
you expect and you can use the statistics to understand when the messages are
routed to this error path.

Check the information provided by snapshot data for routing information; if this
is insufficient for your needs, use archive data.

Message flow accounting and statistics accounting origin
Accounting and statistics data can be identified by the originating message flow.

The accounting origin for all accounting and statistics data for all message flows is
set to Anonymous. You cannot change this value.

Output formats for message flow accounting and statistics data
When you collect message flow statistics, you can choose the output destination
for the data. You can specify one of the following output destinations:

* You can specify that the data collected is published. The publication message is
created in XML format and is available to subscribers registered in the broker
network that subscribe to the correct topic.

The topic on which the data is published has the following structure:
$SYS/Broker/<brokerName>/StatisticsAccounting/<recordType>/<executionGrouplLabel>/<messageFlowLabel>

where recordType is set to Snapshot or Archive, and broker, execution group,
and message flow names are specified according to the subscriber’s
requirements.

Subscribers can include filter expressions to limit the publications that they
receive. For example, they can choose to see only snapshot data, or to see data
collected for a single broker. Wild cards can be specified to receive publications
that refer to multiple resources.

* You can specify that the data collected is written to the user trace log. The data
is written even if trace is currently switched off.

* On z/0S, you can specify that the data collected is written to SMF. SMF
supports the collection of data from multiple subsystems, and you might
therefore be able to synchronize the information recorded. When you want to
interpret the information recorded, you can use any utility program that
processes SMF records. Accounting and statistics data uses SMF type 117
records.

Statistics data is written to the specified output location in the following
circumstances:

* When the archive data interval expires.

* When the snapshot interval expires.

* When the broker shuts down. Any data that has been collected by the broker,

but not yet written to the specified output destination, is written during
shutdown. It might therefore represent data for an incomplete interval.

* When any part of the broker configuration is redeployed. Redeployed
configuration data might contain an updated configuration that is not consistent
with the existing record structure (for example, a message flow might include an
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additional node, or an execution group might include a new message flow).
Therefore the current data, which might represent an incomplete interval, is
written to the output destination. Data collection continues for the redeployed
configuration until you change data collection parameters or stop data collection.

When data collection parameters are modified. If you update the parameters that
you have set for data collection, all data collected for the message flow (or
message flows) is written to the output destination to retain data integrity.
Statistics collection is restarted according to the new parameters.

When an error occurs that terminates data collection. You must restart data
collection yourself in this case.

Designing a message flow

When you design a message flow, consider several design factors which include
some or all of the following options:

Which nodes provide the function that you require. In many cases, you can
choose between several nodes that provide a suitable function. You might have
to consider other factors listed here to determine which node is best for your
overall needs. You can include built-in nodes, user-defined nodes, and subflow
nodes. For more information, see [‘Deciding which nodes to use.”|

Whether it is appropriate to include more than one input node. For more
information, see [“Using more than one input node” on page 13|

Whether you can make use of subflows, for example to define a specific output
node with common properties. For more information, see|“Using subflows” on|
What response times your applications expect from the message flow. This is
influenced by several aspects of how you configure your nodes and the flow. For
more information, see [“Optimizing message flow response times” on page 14

Whether you want to use WebSphere MQ) cluster queues. For more information,
see [‘Using WebSphere MQ cluster queues for input and output” on page 16,

Whether you want to use WebSphere MQ shared queues on z/OS. Their use is
described further in [“Using WebSphere MQ shared queues for input and output]
[(z/OS)” on page 18]

Whether you want your messages to go through data conversion. The options

that you have are described in [‘Configuring message flows for data conversion”|
h

What steps you can take to ensure that messages are not lost. For more
information, see [“Ensuring that messages are not lost” on page 21|

How errors are handled within the message flow. You can use the facilities
provided by the broker to handle any errors that are encountered during
message flow execution (for example, if the input node fails to retrieve an input
message, or if writing to a database results in an error). However, you might
prefer to design your message flow to handle errors in a specific way. For more
information, see [“Handling errors in message flows” on page 23

Deciding which nodes to use

10 Message Flows

WebSphere Event Broker includes a large number of message processing nodes
that you can use within your message flows. You can also choose from
user-defined nodes that have been created and supplied by users, or other vendors
and companies.



Your decision about which nodes to use depends on the processing that you want
to perform on your messages. The built-in nodes can be considered in several
categories, and are displayed in the workbench grouped in those categories
(although this grouping has no effect on their operation). You can also categorize
user-defined nodes in the same way. The categories are:

Input and output
Input and output nodes define points in the message flow to which clients
send messages (input nodes such as MQInput) and from which clients
receive messages (output nodes such as MQOutput). Client applications
interact with these nodes by putting messages to, or getting messages
from, the I/O resource that is specified by the node as the source or target
of the messages. Although a message flow must include at least one input
node, it does not have to include an output node.

 If you are creating a message flow that you want to deploy to a broker,
you must include at least one input node to receive messages. The input
node that you choose depends on the source of the input messages and
where in the flow you want to receive the messages:

MQInput
If the messages arrive at the broker on a WebSphere MQ queue
and the node is to be at the start of a message flow.

MQGet
If the messages arrive at the broker on a WebSphere MQ queue
and the node is not to be at the start of a message flow.

SCADAInput
If the messages are sent by a telemetry device.

Real-timelnput or Real-timeOptimizedFlow
If the messages are sent by a JMS or multicast application.

User-defined input node
If the message source is a client or application that uses a
different protocol or transport.

Input node
If you are creating a message flow that you want to embed in
another message flow (a subflow) that you will not deploy as a
standalone message flow, you must include at least one Input
node to receive messages into the subflow.

An instance of the Input node represents an in terminal. For
example, if you have included one instance of the Input node,
the subflow icon shows one in terminal that you can connect to
other nodes in the main flow in the same way that you connect
any other node.

You can deploy only message flows that have at least one input node. If
your message flow does not contain an input node, you are prevented
from adding it to the broker archive file. The input node can be in the
main flow, or in a message flow that is embedded in the main flow.

You can use more than one input node in a message flow. For more
information, see [“Using more than one input node” on page 13/

* If you want to send the messages produced by the message flow to a
target application, you can include one or more output nodes. The one
that you choose depends on the transport across which the target
application expects to receive those messages:

Developing message flows 11



12 Message Flows

Publication
If you want to distribute the messages using the
publish/subscribe network for applications that subscribe to the
broker across all supported protocols. A Publication node is an
output node that use output destinations that are identified by
subscribers whose subscriptions match the characteristics of the
current message.

MQOutput
If the target application expects to receive messages on a
WebSphere MQ queue, or on the WebSphere MQ reply-to queue
specified in the input message MQMD.

MQReply
If the target application expects to receive messages on the
WebSphere MQ reply-to queue specified in the input message
MQMD

SCADAOutput
If a telemetry device is the target of the output messages, and
the Publication node is not suitable

Real-timeOptimizedFlow
If the target application is a J]MS or multicast application

User-defined output node
If the target is a client or application that uses a different
protocol or transport

The UDPSend node is a working sample of a user-defined node
that provides this function.

Output node
If you are creating a message flow that you want to embed in
another message flow (a subflow) that you will not deploy as a
standalone message flow, you must include at least one Output
node to propagate messages to subsequent nodes that you
connect to the subflow.

An instance of the Output node represents an out terminal. For
example, if you have included two instances of the Output node,
the subflow icon shows two out terminals that you can connect
to other nodes in the main flow in the same way that you
connect any other node.

XMLTransformation

If you want to transform an input XML message into another format using
XMLT style sheets, use the XMLTransformation node. It is imperative that
the data can be parsed into a XML message. The result of the
transformation is output as a BLOB message. The style sheet, using the
rules defined within it, can sort the data; select data elements to include or
to exclude based on some criteria, and transform the data into some other
data format.

The Xalan-Java transformation engine (http://xml.apache.org/xalan-j) is
used as the underlying transformation engine. For details about XMLT,
refer to http://www.w3.org/TR/xs1t.

You can deploy style sheets and XML files to broker execution groups, to
facilitate style sheet and XML file maintenance.



Using more than one input node

You can include more than one input node in a single message flow. You might
find this useful in the following situations:

* The message flow provides common processing for messages that are received

across multiple transports. For example, a single message flow might handle:

— Data in messages received across WebSphere MQ, and therefore through a
WebSphere MQ queue and an MQInput node

— Messages that are received across native IP connections (a Real-timelnput
node)

You need to set standard properties on the MQInput node if input messages:
— are all received across WebSphere MQ, and
— do not include an MQRFH?2 header.

If the required standard properties are not always the same for every message,
you can include more than one input node and configure each to handle a
particular set of properties.

Each input node in a message flow causes the broker to start a separate thread
of execution. Including more than one input node might improve the message
flow performance. However, if you include multiple input nodes that access the
same input source (for example, a WebSphere MQ queue), the order in which
the messages are processed cannot be guaranteed. If you want the message flow
to process messages in the order in which they are received, this option is not
appropriate.

If you are not concerned about message order, consider using additional
instances of the same message flow rather than multiple input nodes. If you set
the Additional Instances property of the message flow when you deploy it to the
broker, multiple copies of the message flow are started in the execution group.
This is the most efficient way of handling multiple instances.

Using subflows

You can include subflows in your message flows in exactly the same way as you
include built-in or user-defined nodes.

You can also connect them to other nodes in the same way. Because you can define
a subflow once, and use it in more than one message flow (and even in more than
one message flow project), a subflow can provide benefits:

Reuse and reduced development time.

A consistent way of achieving a particular function, and increased
maintainability of your message flows (consider a subflow as analogous to a
programming macro, or to inline code that is written once but used in many
places).

Flexibility. If you promote some or all of the properties of the nodes in the
subflow, you can tailor a subflow to a specific context (for example, by updating
the output queue information).

However, you must remember that a subflow is not a single node, and its inclusion
increases the number of nodes in the message flow, which might affect its
performance.

Consider these examples of subflow use:
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* You can define a subflow that provides a common destination for messages that
result in an error within the message flow.

Adding keywords to subflows

You can embed keywords in each subflow that you use in a message flow. A
different keyword must be used in each instance of a subflow. This is because only
the first recorded instance of each keyword within the message flow .cmf file is
available to Configuration Manager Proxy applications and to the toolkit. The
order that subflows appear in the .cmf file is not guaranteed.

Optimizing message flow response times

14 Message Flows

When you design a message flow, the flexibility and richness of the built-in nodes
often means that there are several ways to achieve the processing and therefore the
end results that you require. However, you can also find that these different
solutions deliver different performance and, if this is an important consideration,
you must design for performance as well as function.

There are two ways in which your applications can perceive performance:

1. Response time. This indicates how quickly each message is processed by the
message flow. This is particularly influenced by how you design your message
flows. This is further discussed in this topic.

2. Throughput. This indicates how many messages of particular sizes can be
processed by a message flow in a given time. This is mainly affected by
configuration and system resource factors, and is therefore discussed in
[Optimizing message flow throughput] with other domain configuration
information.

There are several aspects that influence message flow response times. However, as
you create and modify your message flow design to arrive at the best results that
meet your specific business requirements, you must also consider the eventual
complexity of the message flow. The most efficient message flows are not
necessarily the easiest to understand and maintain; experiment with the solutions
available to arrive at the best balance for your needs.

Several factors influence message flow response times:

The number of nodes that you include in the message flow
Every node causes some processing overhead, so consider the content of
the message flow carefully, including the use of subflows.

Use as few nodes as possible in a message flow; every node that you
include in the message flow increases the overhead in the broker. There is
an upper limit to the number of nodes within a single flow. This limit is
governed by system resources, particularly the stack size.

For more information about stack sizes, see [“System considerations for|
Imessage flow development” on page 15.

The use of persistent and transactional messages
Persistent messages are saved to disk during message flow processing. This
is avoided if you can specify that messages either on input, output, or
both, are non-persistent. If your message flow is handling only
non-persistent messages, check the configuration of the nodes and the
message flow itself; if your messages are non-persistent, transactional
support might be unnecessary. The default configuration of some nodes



enforces transactionality; if you update these properties and redeploy the
message flow, response times might improve.

Message size
A larger message takes longer to process. If you can split large messages
into smaller chunks of information, you might be able to improve the
speed at which they are handled by the message flow.

You can find more information on improving the performance of a message flow in
this [developerWorks article on message flow performancel

System considerations for message flow development
Default stack size

When a message flow thread executes, it requires storage to perform the
instructions that are defined by the logic of its connected nodes. This storage
comes from the execution group’s heap and stack size. The default stack size
allocated to a message flow thread depends on the platform used.

Each message flow thread is allocated 1MB of stack space.
Each message flow thread is allocated 8MB of stack space.
Each message flow thread is allocated 1MB of stack space.

Each message flow thread is allocated 512 KB of downward stack space and 50 KB
of upward stack space.

In a message flow, a node typically uses about 2KB of the stack space. A typical
message flow can therefore include roughly 250 nodes on z/OS, 500 nodes on
UNIX platforms and 500 nodes on Windows. This amount can be higher or lower
depending on the type of nodes used and the processing they perform.

Increasing the stack size on Windows and UNIX platforms

You can increase the stack size by setting the MQSI_ THREAD_STACK_SIZE
environment variable to an appropriate value. When you restart brokers running
on the system they will use the new value.

The value of MQSI_THREAD_STACK_SIZE that you set is used for every thread
that is created within a DataFlowEngine process. If the execution group has a large
number of message flows assigned to it, and you set a large value for
MQSI_THREAD_STACK_SIZE, the DataFlowEngine process will therefore need a
large amount of storage for the stack.

Increasing the stack size on z/0S

Integrator components on z/OS are compiled using the new XPLINKage (extra
performance linkage), which adds optimization to the runtime code. However, if
the initial stack size is not large enough, then stack extents will be used. 128KB is
used in each extent. It is very important that a large enough downward stack size
is chosen, because XPLINK performs badly when stack extents are used.

To determine suitable stack sizes, a component administrator for z/OS can use the
LE (Language Environment®) Report Storage tool. To do this, a message flow must

be tested using the RPTSTG option with the _CEE_RUNOPTS environment
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variable. This should be set in the component profile (BIPBPROF for a broker)
during the development and test of message flows intended for production. For
example:

export _CEE_RUNOPTS=XPLINK\(ON\),RPTSTG(ON)

You can then override the default values for the stack sizes on z/OS by altering or
adding the LE_CEE_RUNOPTS environment variable in the component profile.

When updating the component profile you must stop the component, make the
necessary changes to the profile, submit BIPGEN to recreate the ENVFILE and
restart the component.

For example, you can change the default values of 50K and 512K in the following
line to suit your needs:

export _CEE_RUNOPTS=XPLINK(ON),THREADSTACK(ON,50K, 15K, ANYWHERE ,KEEP,512K, 128K)

Using RPTSTG increases the time an application takes to run. You should therefore
use it as an aid to only the development of message flows, and your final
production environment. When you have determined the correct stack sizes
needed you should remove this option from the _CEE_RUNOPTS environment
variable.

Note: XPLINK stacks grow downward in virtual storage while the old standard
linkage grows upward. If your message flow uses user-defined nodes that
have been compiled with the standard linkage convention, you will need to
determine and set a suitable value for the upward stack size.

Determining the correct stack size

In WebSphere Event Broker any processing that involves nested or recursive
processing can cause extensive usage of the stack. For example, in the following
situations you might need to increase the stack size:

* When a message flow is processing a message that contains a large number of
repetitions or complex nesting.

* When a message flow is executing ESQL that recursively calls the same
procedure or function, or when an operator, for example the concatenation
operator, is used repeatedly in an ESQL statement.

Related tasks
[‘Optimizing message flow response times” on page 14|

Related reference

[‘Message flows” on page 105

Using WebSphere MQ cluster queues for input and output

16 Message Flows

When you design the WebSphere MQ network that underlies your WebSphere
Event Broker broker domain, consider whether to use clusters.

Queue manager clusters bring two significant benefits:
1. Reduced system administration

Clusters need fewer definitions to establish a network; you can set up and
change your network more quickly and easily.

2. Increased availability and workload balancing



You can benefit by defining instances of the same queue to more than one
queue manager, thus distributing the workload through the cluster.

If you use clusters with WebSphere Event Broker, consider the following:

For SYSTEM.BROKER queues:
The SYSTEM.BROKER queues are defined for you when you create
WebSphere Event Broker components, and are not defined as cluster
queues. Do not change this attribute.

For broker, Configuration Manager, and User Name Server connectivity:
If you define the queue managers that support your brokers, the
Configuration Manager, and the User Name Server to a cluster, you can
benefit from the simplified administration provided by WebSphere MQ
clusters. You might find this particularly relevant for the brokers in a
collective, which must all have WebSphere MQ interconnections.

For message flow input queues:
If you define an input queue as a cluster queue, consider the implications
for the order of messages or the segments of a segmented message. The
implications are the same as they are for any WebSphere MQ cluster
queue. In particular, the application must ensure that, if it is sending
segmented messages, all segments are processed by the same target queue,
and therefore by the same instance of the message flow at the same broker.

For message flow output queues:

¢ WebSphere Event Broker always specifies MQOO_BIND_AS_Q_DEF
when it opens a queue for output. If you expect segmented messages to
be put to an output queue, or want a series of messages to be handled
by the same process, you must specify DEFBIND(OPEN) when you
define that queue. This ensures that all segments of a single message, or
all messages within a sequence, are put to the same target queue and are
processed by the same instance of the receiving application.

* If you create your own output nodes, specify MQOO_BIND_AS_Q_DEF
when you open the output queue, and DEFBIND(OPEN) when you
define the queue, if you need to guarantee message order, or to ensure a
single target for segmented messages.

For publish/subscribe:

¢ If the target queue for a publication is a cluster queue, you must deploy
the publish/subscribe message flow to all the brokers on queue
managers in the cluster. However, the cluster does not provide any of
the failover function to the broker domain topology and function. If a
broker to which a message is published, or a subscriber registers, is
unavailable, the distribution of the publication or registration is not
taken over by another broker.

* When a client registers a subscription with a broker running on a queue
manager that is a member of a cluster, the broker forwards a proxy
registration to its neighbors within the broker domain; the registration
details are not advertised to other members of the cluster.

To understand clusters, and the implications of using cluster queues, see the
WebSphere MQ Queue Manager Clusters book.
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Using WebSphere MQ shared queues for input and output

(2/0S)

On z/0S systems you can define WebSphere MQ shared queues as input and
output queues for message flows.

Use the WebSphere MQ for z/OS product facilities to define these queues and
specify that they are shared.

For more information about configuring on z/OS, refer to the WebSphere MQ for
z/OS Concepts and Planning Guide.

Using shared queues helps to provide failover support between different images
running WebSphere Event Broker on a sysplex.

You cannot use shared queues for broker or User Name Server component queues
such as SYSTEM.BROKER.CONTROL.QUEUE.

Shared queues are available only on z/OS.

Data conversion

18 Message Flows

Data conversion is the process by which data is transformed from the format
recognized by one operating system into that recognized by a second operating
system with different characteristics such as numeric order.

If you are using a network of systems that use different methods for storing
numeric values, or you need to communicate between users who view data in
different code pages, you must consider how to implement data conversion.

Numeric order
For numeric and encoding aspects, consider:
¢ Big Endian versus Little Endian
* Encoding values in WebSphere MQ (the Encoding field in the MQMD)

Encoding values are system specific. For example, Windows usually has
an encoding of 546, hexadecimal value X’00000222". The three final
hexadecimal digits identify:

1. The float number format

This value can be 1 (IEEE format byte order normal), 2 (IEEE format
byte order reversed), or 3 (zSeries format byte order normal).

2. The packed decimal number format

This value can be 1 (byte order normal) or 2 (byte order reversed).
3. The hexadecimal number format

This value can be 1 (byte order normal) or 2 (byte order reversed).

The bit order within a byte is never reversed. Byte order normal means
that the least significant digit occupies the highest address.

Systems that process numbers in normal byte order are Big Endian
(z/Series, iSeries, Linux, and UNIX). Systems that process numbers in
reversed byte order are Little Endian (mainly PCs).

For further details about numeric order, see Appendix D, Machine
Encodings, in the WebSphere MQ Application Programming Reference.



Code page conversions
Code page conversion might be required for any of the following reasons:
* ASCII versus EBCDIC
* National languages
* Operating system specific code pages

For more information about code page support in WebSphere MQ, see the
WebSphere MQ Application Programming Reference book.

When you use WebSphere Event Broker, you can use the data conversion facilities
of WebSphere MQ.

WebSphere MQ facilities

Headers and message body are converted according to the MQMD values,
and other header format names. You might have to set up data conversion
exits to convert the body of your messages.

When you use WebSphere MQ facilities, the whole message is converted to
the specified encoding and CCSID, according to the setting of the format in
the WebSphere MQ header.

For more detail about data conversion using WebSphere MQ facilities, see
Appendix F, Data Conversion, in the WebSphere MQ Application
Programming Reference.

Configuring message flows for data conversion

If you exchange messages between applications that run on systems that are
incompatible in some way, you can configure your system to provide data
conversion as the message passes through the broker. Data conversion might be
necessary if either of the following two values are different on the sending and
receiving systems:

1. CCSID. The Coded Character Set Identifier refers to a set of coded characters
and their code point assignments. WebSphere Event Broker can process and
construct application messages in any code page for which WebSphere MQ
provides conversion to and from Unicode, on all operating systems. For more
information about code page support, see the WebSphere MQ Application
Programming Reference.

This behavior might be affected by the use of other products in conjunction
with WebSphere Event Broker. Check the documentation for other products,
including any databases that you use, for further code page support
information.

2. Encoding. This defines the way in which a machine encodes numbers, that is
binary integers, packed-decimal integers, and floating point numbers. Numbers
that are represented as characters are handled in the same way as all other
string data.

If the native CCSID and encoding on the sending and receiving systems are the
same, you do not need to invoke data conversion processes.

WebSphere Event Broker and WebSphere MQ provide data conversion facilities to
support message exchange between unlike systems. Your choice of which facilities
to use depends on the characteristics of the messages that are processed by the
message flow:

+ [Messages that contain text only]|

+ [Message that include numerics|
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Messages that contain text only

Read this section if your messages are WebSphere MQ messages that
contain all text (character data or string). If WebSphere MQ supports the
systems on which both sending and receiving applications are running for
data conversion, use WebSphere MQ facilities. This provides the most
efficient data conversion option.

The default behavior of WebSphere MQ is to put messages to queues
specifying the local system CCSID and encoding. Applications issuing
MQGET can request that the queue manager provides conversion to their
local CCSID and encoding as part of get processing.

To use this option:

1. Design messages to be text-only. If you are using COBOL, move
numeric fields to USAGE DISPLAY to put them into string form.

2. Set the Format field in the MQMD to MQFMT_STRING (value
MQSTR).

3. Issue MQGET with MQGMO_CONVERT in the receiving application. If
you prefer, you can convert when the message is received by the
broker, by setting the Convert property of the MQInput node to yes (by
selecting the check box).

If you require more sophisticated data conversion than WebSphere MQ
provides in this way (for example, to an unsupported code page), use
WebSphere MQ data conversion exits. For more information about these,
see the WebSphere MQ Application Programming Reference.

Messages that include numerics

Read this section if your messages include numeric data, or are text only
but are not WebSphere MQ messages. If your messages are WebSphere MQ
messages that include numeric data, you can use WebSphere MQ data
conversion exits. If the messages are not WebSphere MQ messages and are
text only, or text and numeric, you must use procedures invoked by your
own sending or receiving applications.

1. Define the output message in the MRM domain. You can create this
definition in one of the following ways:
* Import an external message definition (for example a C header or
COBOL copybook).
* Create the message model in the message definition editor.
2. Configure a message flow to receive and process this message:
a. If you include an MQInput node, do not request conversion by this
node.
b. Include a Compute node in the message flow to create the output
message with the required content:

* If the output message is a WebSphere MQ message, code ESQL in
the Compute node to set the CCSID and encoding for the target
system in the MQMD.

For example, to set values for a target z/OS system running with
CCSID of 37 and encoding of 785:

SET OutputRoot.MQMD.CodedCharSetlId = 37;
SET OQutputRoot.MQMD.Encoding = 785;

* If the output message is not a WebSphere MQ message, code
ESQL in the Compute node to set the CCSID and encoding for
the target system in the Properties folder.



Ensuring that messages are not lost

It is important to safeguard that messages that flow through your broker domain.
This is true of both application-generated messages and those used internally for
inter-component communication. Messages used internally between components
always use the WebSphere MQ protocol. Application messages can use all
supported transport protocols.

For application and internal messages travelling across WebSphere MQ, two
techniques protect against message loss:

* Message persistence
If a message is persistent, WebSphere MQ ensures that it is not lost when a
failure occurs, by copying it to disk.

* Syncpoint control

An application can request that a message is processed in a synchronized
unit-of-work (UOW)

For more information about how to use these options, refer to the WebSphere MQ
System Administration Guide.

Internal messages

WebSphere Event Broker components use WebSphere MQ messages to
communicate events and data between broker processes and subsystems, and the
Configuration Manager and User Name Server. The components ensure that the
WebSphere MQ features are exploited to protect against message loss. You do not
need to take any additional steps to configure WebSphere MQ or WebSphere Event
Broker to protect against loss of internal messages.

Application messages

If delivery of application messages is critical, you must design application
programs and the message flows that they use to ensure that messages are not lost.
The techniques used depend on the protocol used by the applications.

WebSphere MQ Enterprise Transport and WebSphere MQ Mobile Transport
If you are using the built-in input nodes that accept messages across the
WebSphere MQ or WebSphere MQ Everyplace protocols, you can use the
following guidelines and recommendations:

* Using persistent messages

WebSphere MQ messaging products provide message persistence, which
defines the longevity of the message in the system and guarantees
message integrity. Nonpersistent messages are lost in the event of system
or queue manager failure. Persistent messages are always recovered if a
failure occurs.

You can control message persistence in the following ways:

— Program your applications that put messages to a queue using the
MQI or AMI to indicate that the messages are persistent.

— Define the input queue with message persistence as the default
setting.

— Configure the output node to handle persistent messages.
— Program your subscriber applications to request message persistence.

When an input node reads a message is read from an input queue, the
default action is to use the persistence defined in the WebSphere MQ
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message header (MQMD), that has been set either by the application
creating the message, or by the default persistence of the input queue.
The message retains this persistence throughout the message flow, unless
it is changed in a subsequent message processing node.

You can override the persistence value of each message when the
message flow terminates at an output node. This node has a property
that allows you to specify the message persistence of each message
when it is put to the output queue, either as the required value, or as a
default value. If you specify the default, the message takes the
persistence value defined for the queues to which the messages are
written.

If a message passes through a Publication node, the persistence of
messages sent to subscribers is determined by the subscribers’
registration options. If a subscriber has requested persistent message
delivery, and is authorized to do so by explicit or implicit (inherited)
ACL, the message is delivered persistently regardless of its existing
persistence property. Also, if the user has requested nonpersistent
message delivery, the message is delivered nonpersistent regardless of its
existing persistence property.

* Processing messages under syncpoint control

The default action of a message flow is to process incoming messages
under syncpoint in a broker-controlled transaction. This means that a
message that fails to be processed for any reason is backed out by the
broker. Because it was received under syncpoint, the failing message is
reinstated on the input queue and can be processed again. If the
processing fails, the error handling procedures that are in place for this
message flow (defined either by how you have configured the message
flow, or by the broker) are executed.

For full details of input node processing, see[“Managing errors in thel
[input node” on page 25.|

WebSphere MQ Telemetry Transport
If you are using the built-in input node SCADAInput that accepts
messages from telemetry devices across the MQIsdp protocol, this protocol
does not have a concept of queues. Clients connect to a SCADAInput node
by specifying the port number on which the node is listening. Messages
are sent to clients using a clientId. However, you can specify a maximum
QoS (Quality of Service) within a SCADA subscription message, which is
similar to persistence:
* QoS0 Nonpersistent.
* QoS1 Persistent, but might be delivered more than once
* Q0S2 Once and once only delivery

If a persistent SCADA message is published, it might be downgraded to
the highest level that the client can accept. In some circumstances this
might mean that the message becomes nonpersistent.

WebSphere MQ Real-time Transport and WebSphere MQ Multicast Transport
If you are using the built-in input nodes Real-timelnput and
Real-timeOptimizedFlow that accept messages from JMS and multicast
applications, no facilities are available to protect against message loss. You
can, however, provide recovery procedures by configuring the message
flow to handle its own errors.

Other transports and protocols
For user-defined input nodes that receive messages from another transport
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protocol, you must rely on the support provided by that transport protocol,
or use the recovery procedures provided by the supplier of the
user-defined nodes.

Handling errors in message flows

The broker provides basic error handling for all your message flows. If basic
processing is not sufficient, and you want to take specific action in response to
certain error conditions and situations, you can enhance your message flows to
provide your own error handling.

The options that you can use to do this are quite complex in some cases. The
options that are provided for MQInput nodes are extensive because these nodes
deal with persistent messages and transactions. MQInput is also affected by
configuration options for WebSphere MQ.

Because you can decide to handle different errors in different ways, there are no
fixed procedures to describe. This section provides information about the principles
of error handling, and the options that are available, and you must decide what
combination of choices that you need in each situation based on the details that are
provided in this section.

You can choose one or more of these options in your message flows:

* Connect the failure terminal of any node to a sequence of nodes that processes
the node’s internal exception (the fail flow).

* Connect the catch terminal of the input node to a sequence of nodes that
processes exceptions that are generated beyond it (the catch flow).

* Ensure that all messages received by an MQInput node are processed within a
transaction, or are not.

* Ensure that all messages received by an MQInput node are persistent, or are not.

If you include user-defined nodes in your message flow, you must refer to the
information provided with the node to understand how you might handle errors
with these nodes. The descriptions in this section cover only the built-in nodes.

When you design your error handling approach, consider the following factors:

* Most of the built-in nodes have failure terminals. The exceptions are Input,
Output, Passthrough, Publication, Real-timelnput, and Real-timeOptimizedFlow.

When an exception is detected within a node, the message and the exception
information are propagated to the node’s failure terminal. If the node does not
have a failure terminal, or it is not connected, the broker throws an exception
and returns control to the input node.

If an MQinput node detects an internal error, its behavior is slightly different; if
the failure terminal is not connected, it attempts to put the message to the input
queue’s backout requeue queue, or (if that is not defined) to the dead letter
queue of the broker’s queue manager,

For more information, see the following:

- ["MQInput error handling” on page 2§
¢ The MQInput, and SCADAInput nodes have catch terminals.

A message is propagated to a catch terminal only if it has first been propagated
beyond the node (for example, to the nodes connected to the out terminal).
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* When a message is propagated to the failure or catch terminal, the node creates
and populates a new ExceptionList with an exception that represents the error
that has occurred. The ExceptionList is propagated as part of the message tree.

* The MQInput node has additional processing for transactional messages (other
input nodes do not handle transactional messages).

* If you include a Trace node that specifies $Root or $Body, the complete message
is parsed. This might generate parser errors that are not otherwise detected.

The general principles of error handling are:

* If you connect the catch terminal of the input node, you are indicating that the
flow handles all exceptions that are generated anywhere in the out flow. The
broker performs no rollback and takes no action unless there is an exception on
the catch flow. If you want any rollback action after an exception has been raised
and caught, you must provide this in the catch flow.

* If you do not connect the catch terminal of the MQInput node, you can connect
the failure terminal and provide a fail flow to handle exceptions generated by
the node. The fail flow is invoked immediately when an exception occurs in the
node.

The fail flow is also invoked if an exception is generated beyond the MQInput
node (in either out or catch flows), the message is transactional, and the
reinstatement of the message on the input queue causes the backout count to
reach the backout threshold.

The SCADAInput node does not propagate the message to the failure terminal if
an exception is generated beyond the node and you have not connected its catch
terminal.

* If a node propagates a message to a catch flow, and another exception occurs
that returns control to the same node again, the node handles the message as
though the catch terminal is not connected.

* If you do not connect either failure or catch terminals of the input node, the
broker provides default processing (which varies with the type of input node).

 If you have a common procedure for handling particular errors, you might find
it appropriate to create a subflow that includes the sequence of nodes required.
Include this subflow wherever you need that action to be taken.

Connecting failure terminals

When a node that has a failure terminal detects an internal error, it propagates the
message to that terminal. If it does not have a failure terminal, or if you have not
connected the failure terminal, the broker generates an exception.

The nodes sometimes generate errors that you can predict, and it is in these cases
that you might want to consider connecting the failure terminal to a sequence of
nodes that can take sensible actions in response to the expected errors.

Examples of expected errors are:
* Temporary errors when the input node retrieves the message.

* Messages with an internal or format error that cannot be recognized or
processed by the input node.

You can also connect the failure terminal if you do not want WebSphere MQ to
retry a message or put it to a backout or dead letter queue.



Managing errors in the input node

When you design your message flow, consider which terminals on the input node
to connect:

If the node detects an error, it always propagates the message to the failure
terminal if the node has one and if you have connected a fail flow.

If you connect the catch terminal (if the node has one), this indicates that you
want to handle all exceptions that are generated in the out flow. This handles
errors that can be expected in the out flow. The broker does not take any action
unless there is an exception on the catch flow and the message is transactional.
Connect the failure terminal to handle this case if you choose.

If you do not connect the catch terminal, or the node does not have a catch
terminal, the broker provides default processing. This depends on the node and
whether the message is transactional. Processing for non-transactional messages
is described in this topic. Refer to ["MQInput error handling” on page 26| for
details of how these nodes handle transactional messages (other input nodes do
not support transactional messages).

All input nodes process non-transactional, non-persistent messages. The built-in
input nodes handle failures and exceptions associated with these messages in this
way:

If the node detects an internal error:

— If you have not connected the failure terminal, the node logs the error in the
local error log and discards the message.

The Real-timelnput and Real-timeOptimizedFlow nodes retry once before
they discard the message; that is, they retrieve the message again and attempt
to process it.

— If you have connected the failure terminal, you are responsible for handling
the error in the fail flow. The broker creates a new ExceptionList to represent
the error and this is propagated to the failure terminal as part of the message
tree, but neither the node nor the broker provide any further failure
processing.

If the node has successfully propagated the message to the out terminal and a
later exception results in the message being returned to the input node:

— If you have not connected the catch terminal or the node does not have a
catch terminal, the node logs the error in the local error log and discards the
message.

— If you have connected the catch terminal, you are responsible for handling the
error in the catch flow. The broker creates a new ExceptionList to represent
the error and this is propagated to the catch terminal as part of the message
tree, but neither the node nor the broker provide any further exception
processing.

If the node has already propagated the message to the catch terminal and an
exception is thrown in the catch flow:

— If you have not connected the failure terminal, or the input node does not
have a failure terminal, the node logs the error in the local error log and
discards the message.

— If you have connected the failure terminal, you are responsible for handling
the error in the fail flow. The broker creates a new ExceptionList to represent
the error and this is propagated to the failure terminal as part of the message
tree, but neither the node nor the broker provide any further failure
processing.
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The SCADAInput node does not propagate the message to the failure
terminal if an exception is generated in the catch flow. The node logs the
error in the local error log and discards the message.

* If the node has propagated the message to the failure terminal and an exception
is thrown in the fail flow, the node logs the error in the local error log and
discards the message.

This action is summarized in the table below:

Error event

Failure terminal
connected

Failure terminal
not connected

Catch terminal
connected

Catch terminal
not connected

Node detects
internal error

Fail flow
handles the error

Node logs the
error and
discards the
message

Not applicable

Not applicable

Node propagates
message to out
terminal,
exception occurs
in out flow

Not applicable

Not applicable

Catch flow
handles the error

Node logs the
error and
discards the
message

Node propagates
message to catch
terminal,
exception occurs
in catch flow

Fail flow
handles the error
(not
SCADAInput)

Node logs the
error and
discards the
message

Not applicable

Not applicable

Node propagates
message to
failure terminal,
exception occurs
in fail flow

Not applicable

Not applicable

Node logs the
error and
discards the
message

Node logs the
error and
discards the
message

MQInput error handling:

The MQInput node takes the following actions when it handles errors with
persistent and transactional messages. Errors encountered with non-transactional

messages are handled as described in [‘Managing errors in the input node” on|

* The MQInput node detects an internal error in the following situations:

— A message validation error occurs when the associated message parser is

initialized.

— A warning is received on an MQGET.

— The backout threshold is reached when the message is rolled back to the
input queue.

¢ If the MQInput node detects an internal error, one of the following actions occur:
— If you have not connected the Failure terminal, the MQInput node attempts to

put the message to the input queue’s backout requeue queue, or (if that is not
defined) to the dead letter queue of the broker’s queue manager. If the put
attempt fails, the message is rolled back to the input queue. The MQInput
node writes the original error and the MQPUT error to the local error log.
The MQInput node now invokes the retry logic, described in

Iprocessing”

on page 28

— If you have connected the Failure terminal, you are responsible for handling
the error in the flow connected to the Failure terminal. The broker creates a




new ExceptionList to represent the error and this is propagated to the Failure
terminal as part of the message tree, but neither the MQInput node nor the

broker provide any further failure processing.

* If the MQInput node has successfully propagated the message to the out
terminal and an exception is thrown in the out flow, the message is returned to
the MQInput node:

— If you have not connected the Catch terminal, the message is rolled back to
the input queue. The MQInput node writes the error to the local error log and
invokes the retry logic, described in|“Retry processing” on page 28/

— If you have connected the Catch terminal, you are responsible for handling
the error in the flow connected to the Catch terminal. The broker creates a
new ExceptionList to represent the error and this is propagated to the Catch
terminal as part of the message tree, but neither the MQInput node nor the

broker provide any further failure processing.

* If the MQInput node has already propagated the message to the Catch terminal
and an exception is thrown in the flow connected to the Catch terminal, the
message is returned to the MQInput node:

— The MQInput node writes the error to the local error log.

— The message is rolled back to the input queue.

¢ If the MQInput node has already propagated the message to the Failure terminal
and an exception is thrown in the flow connected to the Failure terminal, the
message is returned to the MQInput node and rolled back to the input queue.
The MQInput node writes the error to the local error log and invokes the retry
logic, described in [“Retry processing” on page 28] The message is not
propagated to the Catch terminal, even if that is connected.

This action is summarized in the table below:

Error event

Failure terminal
connected

Failure terminal
not connected

Catch terminal
connected

Catch terminal
not connected

Node detects
internal error

Flow connected
to the Failure
terminal handles
the error

Message put to
alternative
queue; node
retries if the put
fails

Not applicable

Not applicable

Node propagates
message to out
terminal,
exception occurs
in out flow

Not applicable

Not applicable

Flow connected
to the Catch
terminal handles
the error

Node retries

Node propagates
message to
Catch terminal,
exception occurs
in flow
connected to the
Catch terminal

Error logged,
message rolled
back

Error logged,
message rolled
back

Not applicable

Not applicable

Node propagates
message to
Failure terminal,
exception occurs
in flow
connected to the
Failure terminal

Not applicable

Not applicable

Node retries

Node retries
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Retry processing:

The node attempts retry processing when a message is rolled back to the input
queue. It checks whether the message has been backed out before, and if it has,
whether the backout count has reached (equalled) the backout threshold. The
backout count for each message is maintained by WebSphere MQ in the MQMD.

You specify (or allow to default to 0) the backout threshold attribute BOTHRESH
when you create the queue. If you accept the default value of 0, the node increases
this to 1. The node also sets the value to 1 if it cannot detect the current value.
This means that if a message has not been backed out before, it is backed out and
retried at least once.

1.

If the node has propagated a message to the out terminal many times following
repeated failed attempts in the out flow, and the number of retries has reached
the backout threshold limit, it attempts to propagate the message through the
Failure terminal if that is connected. If you have not connected the Failure
terminal, the node attempts to put the message to another queue.

If a failure occurs beyond the Failure terminal, further retries are made until
the backout count field in the MQMD reaches twice the backout threshold set
for the input queue. When this limit is reached, the node attempts to put the
message to another queue.

If the backout threshold has not been reached, the node gets the message from
the queue again. If this fails, this is handled as an internal error (described
above). If it succeeds, the node propagates the message to the out flow.

3. If the backout threshold has been reached:

* If you have connected the Failure terminal, node propagates the message to
that terminal. You must handle the error on the flow connected to the Failure
terminal.

* If you have not connected the Failure terminal, the node attempts to put the
message on an available queue, in order of preference:

a. The message is put on the input queue’s backout requeue name (queue
attribute BOQNAME), if one is defined.

b. If the backout queue is not defined, or it cannot be identified by the
node, the message is put on the dead letter queue (DLQ), if one is
defined. (If the broker’s queue manager has been defined by the
mgsicreatebroker command, a DLQ with a default name of
SYSTEM.DEAD.LETTER.QUEUE has been defined and is enabled for this
queue manager.)

c. If the message cannot be put on either of these queues because there is an
MQPUT error (including queue does not exist), or because they cannot be
identified by the node, it cannot be handled safely without risk of loss.

The message cannot be discarded, therefore the message flow continues
to attempt to backout the message. It records the error situation by
writing errors to the local error log. A second indication of this error is
the continual incrementing of the BackoutCount of the message in the
input queue.

If this situation has occurred because neither queue exists, you can define
one of the backout queues mentioned above. If the condition preventing
the message from being processed has cleared, you can temporarily
increase the value of the BOTHRESH attribute. This forces the message
through normal processing.



4. If twice the backout threshold has been reached or exceeded, the node attempts
to put the message on an available queue, in order of preference, as defined in
the previous step.

Handling message group errors:

WebSphere MQ supports message groups. You can specify that a message belongs
to a group and its processing is then completed with reference to the other
messages in the group (that is, either all messages are committed or all messages
are rolled back). When you send grouped messages to a broker, this condition is
upheld if you have configured the message flow correctly, and errors do not occur
during group message processing.

To configure the message flow to handle grouped messages correctly, follow the
actions described in the ["MQInput node” on page 134]| However, correct processing
of the message group cannot be guaranteed if an error occurs while one of the
messages is being processed.

If you have configured the MQInput node as described, under normal
circumstances all messages in the group are processed in a single unit of work
which is committed when the last message in the group has been successfully
processed. However, if an error occurs before the last message in the group is
processed, the unit of work that includes the messages up to and including the
message that generates the error is subject to the error handling defined by the
rules documented here, which might result in the unit of work being backed out.

However, any of the remaining messages within the group might be successfully
read and processed by the message flow, and therefore are handled and committed
in a new unit of work. A commit is issued when the last message is encountered
and processed. Therefore if an error occurs within a group, but not on the first or
last message, it is possible that part of the group is backed out and another part
committed.

If your message processing requirements demand that this situation is handled in a
particular way, you must provide additional error handling to handle errors within
message groups.

Managing message flows

This section contains information on managing message flows:

* |“Creating a message flow project” on page 30|

* [“Deleting a message flow project” on page 31|

« [“Creating a broker schema” on page 32|

* |“Creating a message flow” on page 32

* |“Opening an existing message flow” on page 33|

+ [“Copying a message flow using copy” on page 34|

* |“Renaming a message flow” on page 34

* |"Moving a message flow” on page 35

* [“Deleting a message flow” on page 36|

* |"Message flow version and keywords” on page 37|

+ [“Saving a message flow” on page 38
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Creating a message flow project

30 Message Flows

A message flow project is a container for message flows; you must create a project
before you can create a message flow.

The project and its resources are stored in a file system or in a shared repository. If
you are using a file system, this can be the local file system or a shared drive. If
you store files in a repository, you can use any of the available repositories that are
supported by Eclipse, for example CVS.

To create a message flow project:
1. Switch to the Broker Application Development perspective.

2. Click File » New » Message Flow Project or right-click any resource in the
Navigator view and click New » Message Flow Project.

You can also press Ctrl+N. This displays a dialog that allows you to select the
wizard to create a new object. Click Message Brokers in the left view; the right
view displays a list of objects that you can create for WebSphere Event Broker.
Click Message Flow Project in the right view, then click Next. The New
Message Flow Project wizard displays.

3. Enter a name for the project. Choose a project name that reflects the message
flows that it contains. For example, if you want to use this project for financial
processing message flows, you might give it the name Finance_Flows.

4. Leave the Use default check box checked (it is checked when the dialog opens)
This applies if you want to use the default location for the new message project
directory, that is, in the \workspace subdirectory of your current installation.
You cannot edit the Directory entry field.

a. Alternatively, clear the Use default check box and specify a location for the
new message flow project files in the Directory entry field. This applies if
you do not want to use the default location.

b. Use the Browse button to find the desired location or type the location in.

5. Click Next if you want to specify that this message flow project depends on
other message flow projects, or on message set projects, You are presented with
a list of current projects. Select one or more message flow projects from the list
to indicate this new message flow project’s dependencies.

This message flow project has a dependency on another message flow project if
you intend to use subflows within it that are defined in another project.

You can add dependencies after you have created the message flow project by
right-clicking the project in the Resource Navigator and clicking Properties.
Click References and select the dependent message flow or message set project
from the list of projects displayed.

6. Click Finish to complete the task.

The project file is created within a directory that has the same name as your
message flow project in the specified location. All other files that you create (or
cause to be created) related to this message flow project are created in this same
directory.

A default broker schema (default) is also created within the project. You can
create and use different schemas within a single project to organize message flow
resources, and to provide the scope of resource names to ensure uniqueness.



Deleting a message flow project

A message flow project is the container in which you create and maintain all the
resources associated with one or more message flows. These resources are created
as files, and are displayed within the project in the Resource Navigator view. If
you do not want to retain a message flow project, you can delete it.

Before you start

To complete this task, you must have completed the following task:

“Creating a message flow project” on page 30|

Deleting a message flow project in the workbench deletes the project and its
resources; the Configuration Manager does not hold a copy. If you are using a
shared repository, the repository might retain a copy of a deleted resource.

In previous releases you could remove resources from the Control Center, which
removed the reference in your workspace, but retained the resource in the
Configuration Manager repository.

To delete a message flow project:
1. Switch to the Broker Application Development perspective.

2. Highlight the message flow project that you want to delete and click Edit -»
Delete You can also press Del, or right-click the project in the Navigator view
and click Delete

3. You must choose if you want the contents of the message flow project folder
deleted with this action on the displayed confirmation dialog. The dialog
contains two buttons:

a. The first confirms that all contents are to be deleted.

b. The second requests that the directory contents are not deleted. The default
action is not to delete the contents, and the second button is selected by
default when the dialog is initially displayed.

a. Select the appropriate button. If you choose not to delete the contents of the
message flow project directory, all the files and the directory itself are
retained.

If you later create another project with the same name, and specify the same
location for the project (or accept this as the default value), you can access
the files previously created.

If you choose to delete all the contents, all files and the directory itself are
deleted.

4. Click Yes to complete the delete request, or No to terminate the delete request.
When you click Yes, the requested objects are deleted.

If you maintain resources in a shared repository, a copy is retained in that
repository. You can follow the instructions provided by the repository supplier to
retrieve the resource if required.

If you are using the local drive or a shared drive to store your resources, no copy

of the resource is retained. Be very careful to select the correct resource when you
complete this task.
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Creating a broker schema

If you want to organize your message flow project resources, and to define the
scope of resource names to ensure uniqueness, you can create broker schemas. A
default schema is created when you create the message flow project, but you can
create additional schemas if you choose.

Before you start

To complete this task, you must have completed the following task:

“Creating a message flow project” on page 30|

To create a broker schema:
1. Switch to the Broker Application Development perspective.

2. Click File » New » BrokerSchema or right-click any resource in the Navigator
view and click New » BrokerSchema.

You can also press Ctrl+N. This displays a dialog that allows you to select the
wizard to create a new object. Click Message Brokers in the left view. The right
view displays a list of objects that you can create for WebSphere Event Broker.
Click Broker Schema in the right view, then click Next. The New Broker
Schema wizard displays.

3. Enter the message flow project in which you want the new schema to be
created. If you have a message flow project or one of its resources highlighted
when you invoke the wizard, that project name appears in the dialog. If a name
does not appear in this field, or if you want to create the schema in another
project, click Browse and select the correct project from the displayed list.

You can type the project name in, but you must enter a valid name. The dialog
displays a red cross and the error message The specified project does not
exist if your entry is not a valid project.

4. Enter a name for the schema. Choose a name that reflects the resources that it
contains. For example, if you want to use this schema for message flows for
retail applications, you might give it the name Retail.

A broker schema name must be a character string that starts with a Unicode
character followed by zero or more Unicode characters or digits, and the
underscore. You can use the period to provide a structure to the name, for
example Stock.Common.

5. Click Finish to complete the task.

The schema directory is created in the project directory. If the schema is structured
using periods, further subdirectories are defined. For example, the broker schema
Stock.Common results in a directory Common within a directory Stock within the
message flow project directory.

Creating a message flow
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Create a message flow to specify how to process messages in the broker. You can
create any number of message flows and deploy them to one or more brokers.

Before you start

To complete this task, you must have completed the following task:
+ |“Creating a message flow project” on page 30|




The message flow and its resources are stored in a file system or in a shared
repository. If you are using a file system, this can be the local drive or a shared
drive. If you store files in a repository, you can use any of the available repositories
that are supported by Eclipse, for example CVS.

Use this process to create a complete message flow that you can deploy, or a
subflow that provides a subset of function (for example, a reusable error
processing routine) that you cannot deploy on its own.

To create a message flow:
1. Switch to the Broker Application Development perspective.

2. Check that you have already created the message flow project in which you
want to create the message flow. You can only create a message flow in an
existing project. The project can be empty, or can already have message flows
defined in it.

3. Click File » New » Message Flow or right-click any resource in the Navigator
view and click New » Message Flow.

You can also press Ctrl+N. This displays a dialog that allows you to select the
wizard to create a new object. Click Message Brokers in the left view. The right
view displays a list of objects that you can create for WebSphere Event Broker.
Click Message Flow in the right view, then click Next. The New Message Flow
wizard displays.

4. Identify the project in which you want to define the message flow. If you have
a resource selected in the Navigator view, the name of the corresponding
project is displayed in the first entry field, Project.

If you do not have a resource selected, the first field is blank. Click Browse to
select the appropriate project for this message flow. A dialog containing a list of
valid projects is displayed. Select the correct project and click OK.

You can type the project name in, but you must enter a valid name. The dialog
displays a red cross and the error message The specified project does not
exist if your entry is not a valid project.

5. Complete the Schema and Name fields when the project is correct:

a. In Schema, enter the identifier of the broker schema in which the message
flow is defined. When you create a message flow project, a default schema
is created within it, and this default value is always assumed if you do not
enter a value in this field, or do not select a value using the Browse button.

You can create and use different schemas within a single project to organize
message flow resources, and to provide the scope of resource names to
ensure uniqueness.

b. In Name, enter the name of the message flow. You can use any valid
character for the name; choose a name that reflects its function, for example
OrderProcessing.

6. Click Finish.

The new message flow (<message_flow_name>.msgflow) is displayed within its
project in the Navigator view. The editor view is empty and ready to receive your
input.

Opening an existing message flow

Open an existing message flow to change or update its contents, or to add or
remove nodes.
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Before you start

To complete this task, you must have completed the following tasks:
+ |"Creating a message flow” on page 32|

To open an existing message flow:

1. Switch to the Broker Application Development perspective. The Navigator view
is populated with all the message flow and message set projects that you have
access to. A message flow is contained in a file called
<message_flow_name>.msgflow.

2. Right-click the message flow that you want to work with, and click Open.
Alternatively you can double-click the message flow in the Navigator view.

The graphical view of the message flow is displayed in the editor view. You
can now work with this message flow, for example, adding or removing nodes,
changing connections, or modifying properties.

Copying a message flow using copy

You might find it useful to copy a message flow as a starting point for a new
message flow that has similar function. For example, you might want to replace or
remove one or two nodes to process messages in a different way.

Before you start

To complete this task, you must have completed the following task:

+ |“Creating a message flow” on page 32|

To copy a message flow:
1. Switch to the Broker Application Development perspective.

2. Select the message flow (<message_flow_name>.msgflow) that you want to
copy in the Navigator view.

a. Right-click the file and click Copy from the menu.

3. Right-click the broker schema within the message flow project to which you
want to copy the message flow and click Paste. You can copy the message flow
within the same broker schema within the same message flow, or to a different
broker schema within the same message flow project, or to a broker schema in
a different message flow project.

The message flow is copied with all property settings intact. If you intend to use
this copy of the message flow for another purpose, for example to retrieve
messages from a different input queue, you might have to modify its properties.

You can also use File » Save As to copy a message flow. This is described in
[“Saving a message flow” on page 38)

Renaming a message flow

34 Message Flows

You can rename a message flow. You might want to do this if you have modified
the message flow to provide a different function and you want the name of the
message flow to reflect this new function.

Before you start



To complete this task, you must have completed the following task:

* |“Creating a message flow” on page 32|

To rename a message flow:

1. Switch to the Broker Application Development perspective.

2. Right-click the message flow that you want to rename
(<message_flow_name>.msgflow) in the Navigator view, and click Rename, or
click File » Rename. If you have the message flow selected, you can also press
F2. The Rename Resource dialog is displayed.

3. Type in the new name for the message flow.

4. Click OK to complete this action, or Cancel to cancel the request. If you click
OK, the message flow is renamed.

After you have renamed the message flow, any references that you have to this
message flow (for example, if it is embedded in another message flow) are no
longer valid.

5. You must open the affected message flows and correct the references if you are
not sure where you have embedded this message flow.

a. Click File » Save All The save action saves and validates all resources.
Unresolved references are displayed in the Tasks view, and you can click
each error listed.

This opens the message flow that makes a non-valid reference in the editor
view

b. Right click the subflow icon and click Locate Subflow. The Locate Subflow
dialog is displayed, listing the available message flow projects.

c. Expand the list and explore the resources available to locate the required
subflow.

d. Select the correct subflow and click OK. All references in the current
message flow are updated for you and the errors removed from the Tasks
view.

Moving a message flow

You can move a message flow from one broker schema to another within the same
project or to a broker schema in another project. You might want to do this, for
example, if you are reorganizing the resources in your projects.

Before you start

To complete this task, you must have completed the following task:

“Creating a message flow” on page 32|

To move a message flow:
1. Switch to the Broker Application Development perspective.

2. Drag and drop the message flow that you want to move from its current
location to a broker schema within the same or another message flow project. If
the target location that you have chosen is not valid, a black no-entry icon
appears over the target, an error dialog is displayed, and the message flow is
not moved.

You can move a message flow to another schema in the same project or to a
schema in another message flow project.

3. If you prefer, you can:
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a. Right-click the message flow that you want to move
(<message_flow_name>.msgflow) in the Navigator view and click Move, or
File » Move The Move dialog is displayed. This contains a list of all valid
projects to which you can move this message flow.

b. Select the project and the broker schema within the project to which you
want to move the message flow. You can move a message flow to another
schema in the same project or to a schema in another message flow project.

c. Click OK to complete the move, or Cancel to cancel the move. If you click
OK, the message flow is moved to its new location.

4. Check the Tasks view for any errors (indicated by the error iconﬁ ) or

warnings (indicated by the warning icon {£ ) generated by the move. The
errors in the Tasks view include those caused by broker references. When the
move is done, all references to this message flow (for example, if this is a
reusable error message flow that you have embedded in another message flow)
are checked.

If you have moved the message flow within the same broker schema (in the
same or another project), all references are still valid.

However, if you move the message flow from one broker schema to another (in
the same or a different project), the references are broken.

This is because the resources are linked by a fully-qualified name of which the
broker schema is a part. Information about any broken references is written to
the Tasks view, for example, Linked or nested flow mflowl cannot be
Tocated.

5. Double-click each error or warning to correct it. This opens the message flow
that has the error in the editor view and highlights the node in error.

Deleting a message flow

36 Message Flows

You can delete a message flow that you have created in a message flow project if
you no longer need it.

Deleting a message flow in the workbench deletes the project and its resources,
and the Configuration Manager does not hold a copy. If you are using a shared
repository, the repository might retain a copy of a deleted resource.

In previous releases you could remove resources from the Control Center, which
removed the reference in your workspace, but retained the resource in the
Configuration Manager repository.

Before you start

To complete this task, you must have completed the following task:

“Creating a message flow” on page 32|

To delete a message flow:
1. Switch to the Broker Application Development perspective.

2. Select the message flow in the Navigator view
(<message_flow_name>.msgflow) and press the Delete key. A confirmation
dialog is displayed.

You can also right-click the message flow in the Navigator view and click
Delete, or click Edit » Delete. The same dialog is displayed.



3. Click Yes to delete the message flow definition file or No to cancel the delete
request. When you click Yes, the requested objects are deleted.

If you maintain resources in a shared repository, a copy is retained in that
repository. You can follow the instructions provided by the repository supplier
to retrieve the resource if required.

If you are using the local file system or a shared file system to store your
resources, no copy of the resource is retained. Be very careful to select the
correct resource when you complete this task.

4. Check the Tasks view for any errors that are caused by the deletion. Errors are
generated if you delete a message flow that is embedded within another flow
because the reference is no longer valid.

a. Click the error in the Tasks view This opens the message flow that now has
a non-valid reference.

b. Either remove the node that represents the deleted message flow from the
parent message flow, or create a new message flow with the same name to
provide whatever processing is required.

Deleting a broker schema

You can delete a broker schema that you have created in a message flow project if
you no longer need it.

Before you start

To complete this task, you must have completed the following task:

+ |“Creating a broker schema” on page 32|

To delete a broker schema:
1. Switch to the Broker Application Development perspective.

2. Select the broker schema in the Navigator view and press the Delete key. A
confirmation dialog is displayed.

You can also right-click the broker schema in the Navigator view and click
Delete, or click Edit » Delete. The same dialog is displayed.

If the broker schema contains resources, the Delete menu option is disabled,
and the Delete key has no effect. You must delete all resources within the
schema before you can delete the schema.

3. Click Yes to delete the broker schema directory or No to cancel the delete
request. When you click Yes, the requested objects are deleted.

If you maintain resources in a shared repository, a copy is retained in that
repository. You can follow the instructions provided by the repository supplier
to retrieve the resource if required.

If you are using the local file system or a shared file system to store your
resources, no copy of the resource is retained. Be very careful to select the
correct resource when you complete this task.

Message flow version and keywords

When you are developing a message flow, you can define the version of the
message flow as well as any other key information that you need to be associated
to it. After the message flow has been deployed, the Configuration Manager can be
used to display the properties of the message flow. This includes the deployment
and modification dates and times (the default information that is displayed) as
well as any additional version or keyword information that you have set.
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You can define information to give details on the message flow that has been
deployed, therefore you can check that it is the message flow that you expect.

Version

You can set the version of the message flow in the Version property. This is in the
Properties dialog.

You can also define a default message flow version in the Default version tag of
the message flow preferences. All new message flows that are created after this has
been set have this default applied to the Version property at the message flow
level.

Keywords

Keywords are extracted from the compiled message flow (the .cmf file) rather than
the message flow source (the .msgflow file). Not all of the source properties are
added to the compiled file. Therefore, add message flow keywords in only these
places:

* The label property of a passthrough node

e ESQL comments or string literals

* The Long Description property of the message flow

Any keywords that you define need to follow certain rules to ensure that the
information can be parsed. The following is an example of what you can define in
the Long Description property:

$MQSI Author=John Smith MQSI$
$MQSI Subflow 1 Version=v1.3.2 MQSI$

The information the Configuration Manager will show is:

Message flow name

Deployment Time

28-Aug-2004 15:04

Modification Time

28-Aug-2004 14:27

Version v1.0
Author John Smith
Subflow 1 Version v1.3.2

In this display the version information has also been defined using the Version
property of the object. If the version information has not been defined using the

property, it is omitted from this display.

If message flows contain subflows, you can embed keywords in each subflow.

Saving a message flow

You might want to save your message flow when you want to:

* Close the workbench.
¢ Work with another resource.

* Validate the contents of the message flow.

Before you start:
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To complete this task, you must have completed the following task:
* |"Creating a message flow” on page 32|

To save a message flow:

1.
2.

Switch to the Broker Application Development perspective.

Select the editor view that contains the open message flow that you want to
save.

If you want to save the message flow without closing it in the editor view,
press Ctrl+S or click File » Save name on the taskbar menu (where name is the
name of this message flow). You can also choose to save everything by clicking
File » Save AlL

The message flow is saved and the message flow validator is invoked to
validate its contents. The validator provides a report of any errors that it finds
in the Tasks view. The message flow remains open in the editor view.

For example, if you save a message flow and have not set a mandatory
property, an error message appears in the Tasks view and the editor marks the

node with the error icon X . The message flow in the Navigator view is also
marked with the error icon. This can occur if you have not edited the
properties of an MQInput node to define the queue from which the input node
retrieves its input messages.

(If you edit the properties of a node, you cannot click OK unless you have set
all mandatory properties. Therefore this situation can arise only if you have
never set any properties.)

You might also get warnings when you save a message flow. These are

indicated by the warning icon < . This informs you that, although there is not
an explicit error in the configuration of the message flow, there is a situation
that might result in unexpected results when the message flow completes. For
example, if you have included an input node in your message flow that you
have not connected to any other node, you get a warning. In this situation, the
editor marks the node with the warning icon. The message flow in the
Navigator view is also marked with a warning icon.

If you save a message flow that includes a subflow, and the subflow is no
longer available, three error messages are added to the Tasks view that indicate
that the input and output terminals and the subflow itself cannot be located.
This can occur if the subflow has been moved or renamed.

To resolve this situation, right-click the subflow node in error and click Locate
Subflow. The Locate Subflow dialog is displayed, listing the available message
flow projects. Expand the list and explore the resources available to locate the
required subflow. Select the correct subflow and click OK. All references in the
current message flow are updated for you and the errors removed from the
Tasks view.

If you want to save the message flow when you close it, click the close view
icon & on the editor view tab for this message flow or click File > Close on

the taskbar menu. The editor view is closed and the file saved. The same
validation occurs and any errors and warnings are written to the Tasks view.

For information about using the File » Save As option to take a copy of the
current message flow, see [‘Copying a message flow using save” on page 40

See [“Correcting errors from the save action” on page 4(| for information about
handling errors from the save action.
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Copying a message flow using save

You can copy a message flow by using the File > Save As option.

1.
2.

Click File » Save name As.

Specify the message flow project in which you want to save a copy of the
message flow. The project name defaults to the current project. You can accept
this name, or choose another name from the valid options that are displayed in
the File Save dialog.

Specify the name for the new copy of the message flow. If you want to save
this message flow in the same project, you must either give it another name, or
confirm that you want to overwrite the current copy (that is, copy the flow to
itself).

If you want to save this message flow in another project, the project must
already exist (you can only select from the list of existing projects). You can
save the flow with the same or another name in another project.

Click OK. The message flow is saved and the message flow editor validates its
contents. The editor provides a report of any errors that it finds in the Tasks
view. See [“Correcting errors from the save action”] for information about
handling errors from the save action.

Correcting errors from the save action

Correct the errors that are reported when you save a message flow.

To correct errors from the save or save as action:

1.

Examine the list of errors and warnings that the validator has generated in the
Tasks view.

Double-click each entry in turn. The message flow is displayed in the editor
view (if it is not already there), and the editor selects the node in which the
error was detected. If the error has been generated because you have not set a
mandatory property, the editor also opens the properties dialog for that node.

If you have included a user-defined node in your message flow, and have one
or more of its properties have been defined as configurable, you might get a
warning about a custom property editor. If a property has been defined as
configurable, and you have specified that it uses a custom property editor, the
bar editor cannot handle the custom property editor and handles the property
as if it is type String. This restricts your ability to make changes to this
property at deploy time.

Correct the error indicated by the message. For example, provide a value for
the mandatory property.

When you have corrected all the errors, you can save again. The editor
validates all the resources that you have changed, removes any corrected errors
from the Tasks view, and removes the corresponding graphical indication from
the nodes that you have modified successfully.

You do not have to correct every error to save your work. The editor saves your
resources even if it detects errors or warnings, so that you can continue to work
with them at a later date. However, you cannot deploy any resource that has a
validation error. You must correct every error before you deploy a resource.
Warnings do not prevent successful deployment.



Defining message flow content

When you create a new message flow, the editor view is initially empty. You must
create the contents of the message flow by:

“Adding a node’]

“Adding a subflow” on page 42|

“Renaming a node” on page 43

“Configuring a node” on page 43|

“Connecting nodes” on page 46

“Adding a bend point” on page 4§|

“Aligning and arranging nodes” on page 50|

When you finalize the content of the message flow, you might also need to
perform the following tasks:

* [“Removing a node” on page 45

+ [“Removing a connection” on page 48|

+ [“Removing a bend point” on page 49|

Adding a node

When you create a new message flow, the first action to take to define its function
is to add nodes.

Before you start

To complete this task, you must have completed one of the following tasks:

“Creating a message flow” on page 32|

“Opening an existing message flow” on page 33|

To add a node to a message flow:

1.

Switch to the Broker Application Development perspective.

2. Open the message flow that you want to work with.
3.
4. Decide which node you want to add. This might be a built-in node or a

Click Selection above the palette of nodes.

user-defined node. You can select any of the nodes that appear in the node
palette to the left of the editor view. You can only add one node at a time.

In Message Brokers Toolkit , drag-and-drop the node that you want to include
in the flow from the node palette into the editor view.

When you add a node into the editor view, the editor automatically assigns a
name to the node. The name is equal to the type of node for the first instance.

Repeat steps El and El to add further nodes.
You can also add nodes from other flows into this flow. To do this:

a. Open the other flow, select the node or nodes that you want to copy from
the editor or outline views, and press Ctrl+C or click Edit > Copy.

b. Return to the flow that you are currently working with, and press Ctrl+V or
click Edit » Paste. This action copies the node or nodes into your current
flow. The node names and properties are preserved in the new copy.

Developing message flows 41



When you have added the nodes that you want in this message flow, you can
connect them to specify the flow of control through the message flow, and you can
configure their properties.

Adding a node using the keyboard

Before you start

To complete this task, you must have completed the following task:
+ |“Creating a message flow” on page 32|

You can use the Message Flow editor to perform tasks using the keyboard, such as
adding a node to a message flow.

Complete the following steps to add a node to the canvas:

1. Open the message flow you want to add a node to by double-clicking the
message flow in the Navigator view. You can also open the message flow by
right-clicking it in the Navigator view and clicking Open. The message flow
contents are displayed in the editor view.

2. Open the Palette view or the Palette bar.

3. Select a node in the Palette view or Palette bar using the up and down arrows
to highlight the node you want to add to the canvas.

4. Add the Node to the canvas using one of the following methods:

* Select Palette > Add Node to Canvas by pressing Alt + L and then pressing
N.

* Press Shift + F10 to open the context-sensitive menu for the Palette, and
Press N.

The node that you selected in the Palette bar or Palette view is placed on the
canvas in the Editor view.

You can move the node that you have placed on the canvas using the keyboard
controls described in|Message Brokers Toolkit keyboard shortcuts|

Adding a subflow
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Within a message flow, you might want to include an embedded message flow,
also known as a subflow.

Before you start
To_complete this task, you must have completed one of the following tasks:

« |“Creating a message flow” on page 32|
» [“Opening an existing message flow” on page 33|

When you add a subflow, it appears in the editor view as a single node.

You can embed subflows into your message flow if either of the following
statements is true:

* The flow that you want to embed is defined in the same message flow project.

* The flow is defined in a different message flow project, and you have specified
the dependency of the current message flow project on that other project.

To add a subflow to a message flow:



1. Switch to the Broker Application Development perspective.

2. Open the message flow that you want to work with.

3. Drag and drop the message flow from the Navigator view into the editor view.
Alternatively, highlight the embedding message flow and click Edit » Add
subflow, which displays a list of valid flows that you can add to the current
flow.

4. Select the flow that you want to add from the list. The subflow icon is
displayed with the terminals that represent the Input and Output nodes that
you have included in the subflow.

5. Click OK.

6. Repeat steps El El and El to add further subflow nodes.

7. Select and open (double-click) the flow by name in the Navigator view, or

right-click the embedded flow icon and select Open Subflow to work with the
contents of the embedded flow

When you have added the nodes that you want in this message flow, you can

connect them to specify the flow of control through the message flow, and you can
modify their properties.

Renaming a node

You can change the name of a node. Its current name might be the default name
that the editor assigns to it when you add the node to the editor view. Change the
current name to reflect the purpose of the node. The node can be a built-in node, a
user-defined node, or a subflow node.

Before you start

To complete this task, you must have completed the following task:

+ |“Creating a message flow” on page 32|

When you rename a node, use only the supported characters for this entity. The
editor prevents you from entering unsupported characters.

To rename a node:
1. Switch to the Broker Application Development perspective.
2. Open the message flow that you want to work with.

3. Right-click the node that you want to rename in the editor view and click
Rename. The Rename Node dialog is displayed.

4. Modify the existing name in the text entry field, or press the Delete key to
erase the current name and enter a new one. The name that you enter must be
unique within the message flow; you are prevented from entering a duplicate
name.

5. Click OK to apply the new node name, or Cancel to end the dialog without
changing the name.

Configuring a node

When you have included an instance of a node in your message flow, you can
configure it to customize its function. The node can be a built-in node, a
user-defined node, or a subflow node.
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Before you start

To complete this task, you must have completed the following task:

¢ |”Adding a node” on page 41|

To configure a node:

1.

2.
3.
4.

Switch to the Broker Application Development perspective.
Open the message flow that you want to work with.
Click Selection above the palette of nodes.

Right-click the node in the editor view, and click Properties. The node’s
properties dialog is displayed.

You can select each group, displayed on the left as a tree navigation, in turn to
view and modify the properties of the node. Every node has at least one group,
Description. This contains two text entry fields, in which you can enter a short
description, or a long description, or both. These are used only for
documentation purposes, and are optional.

If the node only has Description properties (for example, the FlowOrder node),
these are initially displayed when you open the properties dialog.

For most other nodes, the Basic properties are initially displayed. A few nodes
do not have Basic properties; for these, the first group is displayed.

On the right are the properties of the currently-selected group. There can be
one or more properties in this display. If the property is required, that is, one
for which you must enter a value, the property name is marked with an
asterisk.

For example, the Basic properties of the MQInput node include just one
property, Queue Name. This identifies the queue from which input messages are
retrieved by the node, and is a required property. On the properties dialog, it
appears like this:

Queue Name=*
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a. Make the changes that you want to make to the properties. In most cases,
you cannot click OK to dismiss the properties dialog unless you have
completed all mandatory properties.

When you have updated the properties of the node, click OK to save the
changes, or Cancel to leave the dialog without saving your changes.

For details of how to configure each individual built-in node, see the node
description. You can find a list of the nodes, with links to the individual topics, in

[“Built-in nodes” on page 107

In the Message flow editor you can display node and connection metadata by
hovering the mouse over a node or subflow in a message flow. To view metadata
information for a node, subflow or connection:

1.
2.
3.

Open the Broker Application Development Perspective
Open a message flow

In the Editor view, hover the mouse over a node, a subflow, or a node
connection in the open message flow by placing the mouse over the element.



Promoted properties

You can promote node properties to their containing message flow. Use this
technique to set some values at the message flow level, without having to change
individual nodes. This can be useful, for example, when you embed a message
flow in another flow, and want to override some property such as output queue
with a value that is correct in this context.

Overriding properties at deploy time

A small number of node property values can be overridden when a message flow
is deployed. These are known as configurable properties, and you can use these to
modify some characteristics of a deployed message flow without changing the
message flow definitions. For example, you can update queue manager
information.

Even though you can set values for configurable properties at deploy time, you
must set values for these properties within the message flow if they are mandatory.

Removing a node

When you have created and populated a message flow, you might need to remove
a node to change the function of the flow, or to replace it with another more
appropriate node. The node can be a built-in node, a user-defined node, or a
subflow node.

Before you start

To complete this task, you must have completed one of the following tasks:

+ |”Adding a node” on page 41|

+ |“Adding a subflow” on page 42|

To remove a node:

1. Switch to the Broker Application Development perspective.
2. Open the message flow that you want to work with.

3. Select the node in the editor view and press the Delete key.
4. Highlight the node and click Edit » Delete

You can also right-click the node in the editor view and click Delete, or
right-click the node in the Outline view and click Delete. The editor removes
the node. If you have created any connections between that node and any other
node, those connections are also deleted when you delete the node.

5. If you delete a node in error, you can restore it by right-clicking in the editor
view and clicking Undo Delete. The node and its connections, if any, are
restored.

You can also click Edit » Undo Delete or press Ctrl+Z.

7. If you undo the delete, but decide it is the correct delete action, you can
right-click in the editor view and click Redo Delete.

You can also click Edit » Redo Delete.
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Connecting nodes

46 Message Flows

When you include more than one node in your message flow, you must connect
the nodes to indicate how the flow of control passes from input to output. The
nodes can be built-in nodes, user-defined nodes, or subflow nodes.

Before you start

To complete this task, you must have completed one of the following tasks:

+ [“Adding a node” on page 41|

» [“Adding a subflow” on page 42

Your message flow might contain just one MQInput node, and one MQOutput
node. Or it might involve a large number of nodes, and perhaps embedded
message flows, that provide a number of paths that a message can travel through
depending on its content.

When you have completed a connection, it is displayed as a black line, and is
drawn as close as possible to a straight line between the connected terminals. This
might result in the connection passing across other nodes. To avoid this, you can
add bend points to the connection.

In the Message flow editor you can display node and connection metadata by
hovering the mouse over a node or subflow in a message flow. To view metadata
information for a node, subflow or connection:

1. Open the Broker Application Development Perspective

2. Open a message flow

3. In the Editor view, hover the mouse over a node, a subflow, or a node
connection in the open message flow by placing the mouse over the element.

If you define a complex message flow, you might have to create a large number of
connections. The principle is the same for every connection. You create connections
either by using the mouse, or by using the Terminal Selection dialog. See |”Creatina

connections with the mouse”| and [“Creating connections with the Terminall

Selection dialog” on page 47| for more information.

Creating connections with the mouse

To connect one node to another using the mouse:

1. Switch to the Broker Application Development perspective.
2. Open the message flow that you want to work with.

3. Click Connection above the node palette.
4

. Click the terminal from which the connection is to be made, that is, the
terminal from which the message is propagated from the current node. For
example, you can click the failure terminal of the MQInput node. You do not
need to keep the mouse button pressed. If you are unsure which terminal is
which, hover your mouse over each one; the terminal is highlighted in blue
and a pop-up displays the name of the terminal.

5. Move your mouse and click again when the mouse pointer is above the in
terminal of the next node in the message flow (to which the message now
passes for further processing). The terminal is highlighted in blue and a popup
displays the name of the terminal so that you can check that you have the



correct terminal. The connection is made when you click on a valid in terminal.
The connection appears as a black line between the two terminals.

In the Message flow editor you can display node and connection metadata by
hovering the mouse over a node or subflow in a message flow. To view metadata
information for a node, subflow or connection:

1. Open the Broker Application Development Perspective
2. Open a message flow

3. In the Editor view, hover the mouse over a node, a subflow, or a node
connection in the open message flow by placing the mouse over the element.

Creating connections with the Terminal Selection dialog

You can use the Terminal Selection dialog to connect nodes. To connect one node

to another in this way:

1. Switch to the Broker Application Development perspective.

2. Open the message flow that you want to work with.

3. Click Connection above the node palette.

4. Click the node from which you want the connection to be made. The Terminal
Selection dialog is displayed.

5. Select the terminal from the list of valid terminals on this node. Click OK. The
dialog ends.

6. Click the node to which to make the connection. If there is only one in terminal
on this node, the connection is made immediately. If there is more than one in
terminal on this node, the Terminal Selection dialog is displayed again, this
time listing the in terminals of the selected node. Select the correct terminal by
clicking it, and click OK.

You can also make a connection as follows:
1. Click Selection above the node palette.

2. Right-click the node from which you want to make the connection and click
Create Connection. The Terminal Selection dialog is displayed.

3. Select the terminal from the list of valid terminals on this node. Click OK. The
dialog ends.

4. Click the node to which to make the connection. If there is only one in terminal
on this node, the connection is made immediately. If there is more than one in
terminal on this node, the Terminal Selection dialog is displayed again, this

time listing the in terminals of the selected node. Highlight the correct terminal
and click OK.

In the Message flow editor you can display node and connection metadata by
hovering the mouse over a node or subflow in a message flow. To view metadata
information for a node, subflow or connection:

1. Open the Broker Application Development Perspective
2. Open a message flow

3. In the Editor view, hover the mouse over a node, a subflow, or a node
connection in the open message flow by placing the mouse over the element.
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Removing a connection

The message flow editor displays the nodes and connections in the editor view.
You can remove connections to change the way in which the message flow
processes messages.

Before you start

To complete this task, you must have completed the following task:
* [“Connecting nodes” on page 46

If you want to remove a connection that you have created between two nodes:
1. Switch to the Broker Application Development perspective.

2. Open the message flow that you want to work with.

3. Click Selection above the node palette.
4

Select the connection that you want to delete. When you hover your mouse
pointer over the connection, the editor highlights the connection that you have
selected by thickening its line, adding an arrowhead at the target terminal end,
and annotating the connection with the name of the two terminals connected,
for example Out->In.

When you select the connection, the editor appends a small black square at
each end and at every bend point of the connection, and a small arrowhead at
the target terminal end. The annotation disappears when you select the
connection.

5. Check that the selected connection is the one that you want to delete.

6. Right-click the connection and click Delete, press the Delete key, or click Edit »
Delete. If you want to delete further connections, repeat these actions from step

7. If you delete a connection in error, you can restore it by right-clicking in the
editor view and clicking Undo Delete. The connection is restored.

8. If you undo the delete, but decide that it is the correct delete action, you can
right-click in the editor view and click Redo Delete. You can also delete a
connection by selecting it in the Outline view and pressing the Delete key.

If you delete a node, its connections are automatically removed; you do not have
to do this as a separate task.

Adding a bend point
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When you are working with a message flow, and connecting your chosen nodes
together to determine the flow of control, you might find that a connection that
you have made crosses over an intervening node and makes the flow of control
difficult to follow.

To help you to display the message flow nodes and their connections in a clear
way, you can add bend points to the connections that you have made to improve
the organization of the display. The addition of bend points has no effect on the
execution of the nodes or the operation of the message flow.

Before you start

To complete this task, you must have completed the following task:
+ |[“Connecting nodes” on page 46




To add a bend point:

1.

2
3.
4

Switch to the Broker Application Development perspective.

. Open the message flow that you want to work with.

Click Selection above the node palette.

. Select the connection to which you want to add a bend point. The editor

appends a small black square to each end of the connection to highlight it.

a. Check that this is the correct connection. The editor also adds a small point
(a handle) in the connection halfway between the in and out terminals that
are joined by this connection.

Hover your mouse pointer over this point until the editor displays a black
cross to indicate that you now have control of this bend point.

a. Hold down the left mouse button and move your mouse to move the black
cross and bend point across the editor view.

As you drag your mouse, the connection is updated, retaining its start and end
points with a bend point at the drag point. You can move this anywhere within
the editor view to improve the layout of your message flow.

Release the mouse button when the connection is in the correct place. The
editor now displays the bend point that you have created with a small square
(like those at the ends of the connection), and displays another two small
points within the connection, one between your newly-created bend point and
the out terminal, the other between the new bend point and the in terminal.

If you want to add more than one bend point to the same connection, repeat these
actions from step @ using the additional small points inserted into the connection.

Removing a bend point

When you are working with a message flow in the editor view, you might want to
simplify the display of the message flow by removing a bend point that you
previously added to a connection between two nodes.

Before you start

To complete this task, you must have completed the following task:
* |”Adding a bend point” on page 48|

To remove a bend point:

1.

2.
3.
4.

Switch to the Broker Application Development perspective.
Open the message flow that you want to work with.
Click Selection above the node palette.

Select the connection from which you want to remove the bend point. The
editor highlights the connection and its current bend points by thickening its
line and appending a small black square to each end of the connection, and by
indicating each bend point with a small black square. Check that this is the
correct connection.

Right-click over the selected connection, if you added this bend point in the
current edit session.

a. Click Undo Create Bend Point.

The editor removes the selected bend point.
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If you right-click in the editor view without a connection being selected, you
can also click Undo Create Bend Point from the menu. However, this removes
the last bend point that you created in any connection, which might not be the
one that you want to remove.

6. Move the bend point to straighten the line if you added this bend point in a
previous edit session, because you cannot use the undo action. When the line is
straight, the bend point is removed automatically.

When the bend point has been removed, the connection remains highlighted.
Both ends of the connection, and any remaining bend points, remain displayed
as small black squares. The editor also inserts small points (handles) into the
connection between each bend point and between each terminal and its
adjacent bend point, which you can use to add more bend points if you choose.

7. If you want to remove another bend point from the same connection, repeat
these actions from step

Aligning and arranging nodes
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When you are working in the Message Flow editor, you can decide how your
nodes are aligned within the editor view.

This option is closely linked to the way in which your nodes are arranged. Again,
the default for this is left to right, which means that the in terminal of a node
appears on its left edge, and its out terminals appear on its right edge. You can
also change this characteristic of a node by rotating the icon display to right to left,
top to bottom, and bottom to top.

Before you start

To complete this task, you must have completed the following task:

* |”Adding a node” on page 41|

To modify the way in which nodes and connections are displayed in the editor:
1. Switch to the Broker Application Development perspective.

2. Open the message flow that you want to work with.

3. Click Selection above the node palette.
4

. Right-click in the editor window and select Manhattan Layout if you want the
connections between the nodes to be displayed in Manhattan style; that is with
horizontal and vertical lines joined at right angles.

5. If you want to change the layout of the complete message flow:

a. Right-click in the editor view and click Layout. The default for the
alignment is left to right, such that your message flow starts (with an input
node) on the left and control passes to the right.

b. From the four further options displayed, Left to Right, Right to Left, Top
to Bottom, and Bottom to Top, click the option that you want for this
message flow. The message flow display is updated to reflect your choice.
As a result of the change in alignment, all the nodes within the message
flow are also realigned.

For example, if you have changed from a left to right display (the default)
to a right to left display, each node in the flow has now also changed to
right to left (that is, the in terminal now appears on the right edge, the out
terminals appear on the left edge).



6. You might want to arrange an individual node in a different direction from that
in which the remaining nodes are arranged within the message flow, To do this:

a. Right-click the node that you want to change and click Rotate. This gives
you four further options: Left to Right, Right to Left, Top to Bottom, and
Bottom to Top.

b. Click the option that you want for this node. The option that represents the
current arrangement of the node is not available for selection.

If you change the alignment of the message flow, or the arrangement of an
individual node, or both, these settings are saved when you save the message flow.
They are applied when another user accesses this same message flow, either
through a shared repository or through shared files or import and export. When
you reopen the message flow, you see these changed characteristics. The alignment
and arrangement that you have selected for this message flow have no impact on
the alighment and arrangement of any other message flow.

In the Message Brokers Toolkit Version 5.1 you can adjust the zoom by
right-clicking in the editor view and clicking Zoom in or Zoom out. Alternatively,
you can use the drop-down list on the editor toolbar to specify a zoom percentage.

You can also access the editor toolbar to select other options related to the display
and arrangement of nodes, for example, snap to grid. These are defined in
Message Flow editor]

Defining promoted properties

When you create a message flow, you can promote properties from individual
nodes within that message flow to the message flow level. Properties promoted in
this way override the property values that you have set for the individual nodes.
You can perform the following tasks related to promoting properties:

+ |[“Promoting a property”|

+ |“Renaming a promoted property” on page 53

+ |“Removing a promoted property” on page 56|

+ |["Converging multiple properties” on page 57

Some of the properties that you can promote to the message flow are also
configurable; you can modify them when you deploy the broker archive file in
which you have stored the message flow to each broker. If you set values for
configurable properties when you deploy a broker archive file, the values that you
set override values set in the individual nodes, and those that you have promoted.

Promoting a property
You can promote a node property to the message flow level to simplify the
maintenance of the message flow and its nodes, and to provide common values for
multiple nodes within the flow by converging promoted properties.

Before you start

To_complete this task, you must have completed the following task:
+ |“Creating a message flow” on page 32|

To promote message flow node properties to the message flow level:
1. Switch to the Broker Application Development perspective.
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2. Open the message flow for which you want to promote properties by

double-clicking the message flow in the Navigator view. You can also open the
message flow by right-clicking it in the Navigator view and clicking Open The
message flow contents are displayed in the editor view.

If this is the first message flow that you have opened, the message flow control
window and the list of available built-in message flow nodes are also
displayed, to the left of the editor view.

In the editor view, right-click the symbol of the message flow node whose
properties you want to promote.

Select Promote Property.

The Promote Property dialog is displayed.
e
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The left side of the dialog lists all available properties for all the nodes within
the message flow. The properties for the node that you highlighted are
expanded. You can access the properties for all the nodes in the open message
flow from this dialog, regardless of the node that you selected when you first
opened the dialog, by expanding the properties for all the other nodes in the
flow (these are initially collapsed).

The right side of the dialog lists the name of the open message flow and all the
properties that are currently promoted to the message flow. If you have not yet
promoted any properties, only the message flow name as the root of the
promoted property tree is displayed on the right. In the image shown the
message flow contains no promoted properties so only the name of the
message flow is displayed.

The majority of message flow node properties are available for promotion, but
you cannot promote the following properties:

* A property group, but you can promote an individual property.

* A property that you cannot edit (for example, the Fix property in the
Validate group of properties for the MQInput node).

* The description properties (Short Description and Long Description).

Select the property that you want to promote to the message flow. The list on
the left initially shows the expanded list of all available properties for the
selected node. If you have already promoted properties from this node, they do
not appear on the left, but on the right.

The list on the left also includes the other nodes in the open message flow. You
can expand the properties listed under each node and work with all these
properties at the same time. You do not have to close the dialog and select
another node from the editor view to continue promoting properties.



You can select multiple properties to promote by selecting a property, holding
down Ctrl, and selecting one or more other properties.

If you have you selected multiple properties to promote, all the properties you
have selected must be available for promotion. If one or more of the selected
properties is not available for promotion, the entire selection becomes
unavailable for promotion, and the Promote button in the right-hand pane is
grayed out.

6. Click the Promote button to promote the property or properties
Clicking the Promote button invokes the Target Selection dialog:

4P Target Selection x|
Choose destination group or property:
=B T 2 ger} Mews Group |
[ew Broperty |
REname: |
0K I Cancel |

The Target Selection dialog displays only the valid targets for the promotion of
the previously selected property or properties and allows you to create a new
target for the promotion, such as to a new group or to a new property.

7. In the Target Selection dialog, select the destination group or property for the
property or properties you want to promote. You can group together related
properties from the same or different nodes in the message flow by dropping
the selected property or properties onto a group or property that already exists.
Alternatively, you can click New Group or New Property to create a new
target for the promotion. You can rename groups and properties by selecting
them and clicking Rename, or by double-clicking on the group or property.

8. Click OK to confirm your selections.

Note: If you create a new group or property using the Target Selection dialog,
the changes persist even if you select Cancel in the dialog. When the
dialog closes, groups or properties that you have created using the
Target Selection dialog will appear in the Promote properties dialog.

9. When you have selected the properties that you want to promote to the
message flow, click OK Your updates are committed, and the Promoted
Property dialog is closed. If you click Apply, this commits the changes but
leaves the dialog open.

When you have promoted a property, you can no longer make any changes to
that property through the node properties dialog. You can only update its value
at the message flow level.

Note: You can also promote properties from the Promote property dialog by
dragging the selected property or properties from the left-hand pane of the
Promote Property dialog to the right-hand pane:

1. Select the property you want to promote. You can select multiple
properties to promote by selecting a property, holding down Ctrl, and
selecting one or more other properties.
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2. You can drop the selected property or properties into the right-hand
pane using the following methods:

a. Drop the selected property or properties in an empty space.

A new group is automatically created for the message flow, and the
property is placed within it, with the original name of the property
and the name of the message flow node from which it came
displayed beneath the property entry.

The name of the first group created defaults to Groupl. If a group
called Groupl already exists, the group is given the name Group2,
and so on. You can rename the group by double-clicking it and
entering new text or by selecting the group in the Promoted
properties pane and clicking Rename.

Note:

When you create a new promoted property, the name that you
enter is the name by which the property is known within the
system, and must meet certain Java and XML naming
restrictions. These are enforced by the dialog, and a message is
displayed if you enter a name that includes a non-valid
character. For example, you cannot include a space or the
double quote symbol.

b. Drop the selected property or properties onto a group that already
exists, to group together related properties from the same or different
nodes in the message flow.

For example, you might want to group all promoted properties that
relate to database interactions. You can change the groups that
promoted properties belong to at any time, by selecting a property in
the Promoted properties pane and dragging it onto a different group.

c. Drop the selected property or properties onto a property that already
exists, to converge related properties from the same or different nodes
in the message flow.

For example, you might want to create a single promoted property
that overrides the property on each node that defines a data source.

For more information on converging properties, see|“Converging

[multiple properties” on page 57,

The message flow node properties are now promoted to the message flow. To
confirm this, right-click the message flow in the Navigator view, or right-click the
editor view, and select Properties.

The Properties dialog of the message flow is displayed, showing the message flow
node properties that you have promoted, organized in the groups that you have
created. If you now set a value for one of these properties, that value appears as
the default value for the property whenever the message flow is itself included in
other message flows.

When you have promoted a property, you can no longer make any changes to that
property through the node properties dialog. You can only update its value at the
message flow level.

When you select an embedded message flow within another message flow (a
subflow) and view its properties, you see the promoted property values. If you
look inside the embedded flow (that is, if you select Open Subflow), you see the



original values for the properties. The value of a promoted property does not
replace the original property, but it takes precedence when you deploy the message
flow.

Promoting mandatory properties

If you promote a property that is mandatory (that is, an asterisk appears beside the
name in the properties dialog of the message flow node), the mandatory
characteristic of the property is preserved. When a mandatory property is
promoted, its value does not need to be set at the node-level. If the flow containing
the mandatory promoted property is included as a subflow within another flow,
then the property has to be filled in for the subflow node.

Promoting properties through a hierarchy of message flows

You can repeat the process of promoting message flow node properties through
several levels of message flow. You can promote properties from any level in the
hierarchy to the next level above, and so on through the hierarchy to the top level.
The value of a property is propagated from the highest point in the hierarchy at
which it is set down to the original message flow node when the message flow is
deployed to a broker. The value of that property on the original message flow
node is overridden.

Renaming a promoted property

If you have promoted a property from the node to the message flow level, it is
initially assigned the same name that it has at the node level. You can rename the
property to have a more meaningful name in the context of the message flow.

Before you start

To complete this task, you must have completed the following task:
* [“Promoting a property” on page 51|

To rename a promoted property :
1. Switch to the Broker Application Development perspective.

2. Open the message flow for which you want to promote properties by
double-clicking the message flow in the Navigator view. You can also open the
message flow by right-clicking it in the Navigator view and clicking Open The
message flow contents are displayed in the editor view.

If this is the first message flow that you have opened, the message flow control
window and the list of available built-in message flow nodes are also
displayed, to the left of the editor view.

3. In the editor view, right-click the symbol of the message flow node whose
properties you want to promote.

4. Select Promote Property.
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The Promote Property dialog is displayed.
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5. Promoted properties are shown in the Promoted properties pane on the right of
the Promote property dialog. Double-click the promoted property in the list of
properties that are currently promoted to the message flow level, or select the
property you want to rename and click Rename. The name is highlighted, and
you can edit it. Modify the existing text or enter new text to give the property a
new name, and press Enter.

6. Click Apply to commit this change without closing the Property Promotion
dialog. Click OK to complete your updates and close the dialog.

Removing a promoted property

56  Message Flows

If you have promoted a property from the node to the message flow level, you can
remove (delete) it if you no longer want to specify its value at the message flow
level. The property reverts to the value that you specified at the node level. If you
remove a promoted property that is a mandatory property, ensure that you have
set a value at the node level. If you have not, you cannot successfully deploy a
broker archive file that includes this message flow.

Before you start

To complete this task, you must have completed the following task:
* [“Promoting a property” on page 51|

If you have promoted one or more message flow node properties, and want to
delete them:

1. Switch to the Broker Application Development perspective.

2. Open the message flow for which you want to promote properties by
double-clicking the message flow in the Navigator view. You can also open the
message flow by right-clicking it in the Navigator view and clicking Open The
message flow contents are displayed in the editor view.

If this is the first message flow that you have opened, the message flow control
window and the list of available built-in message flow nodes are also
displayed, to the left of the editor view.

3. In the Editor view, right-click the symbol of the message flow node whose
properties you want to promote.

4. Select Promote Property.



The Promote Property dialog is displayed.
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5. Select the promoted property that you want to remove in the list of properties
on the right of the dialog, and click Remove. The property is removed from the
list on the right. It is restored to the list on the left, in its appropriate place in
the tree of properties for the node from which you promoted it. You can
promote this property again if you choose.

6. If you want to delete all the promoted properties within a single group, select
the group in the list on the right and click Remove. The group and all the
properties it contains are deleted from this list: the individual properties that
you promoted are restored to the nodes from which you promoted them.

7. Click Apply to commit this change without closing the Property Promotion
dialog. Click OK to complete your updates and close the dialog.

If you have included this message flow in a higher-level message flow, and have
set a value for a promoted property that you have now deleted, the embedding
flow is not automatically updated to reflect the deletion. However, when you
deploy that embedding message flow in the broker domain, the deleted property is
ignored.

Converging multiple properties
You can promote properties from several nodes in a message flow to define a
single promoted property that provides a single value to be for that property in all
those nodes.

Before you start

To complete this task, you must have completed the following task:

“Creating a message flow” on page 32|

To converge multiple node properties to a single promoted property:

1. Switch to the Broker Application Development perspective.

2. Open the message flow for which you want to promote properties by
double-clicking the message flow in the Navigator view. You can also open
the message flow by right-clicking it in the Navigator view and clicking Open
The message flow contents are displayed in the editor view.

If this is the first message flow that you have opened, the message flow
control window and the list of available built-in message flow nodes are also
displayed, to the left of the editor view.
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3. In the editor view, right-click the symbol of the message flow node whose
properties you want to promote.

4. Select Promote Property.
The Promote Property dialog is displayed.
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5. Select the property that you want to converge. The list on the left initially
shows the expanded list of all available properties for the selected node. If
you have already promoted properties from this node, they do not appear on
the left, but on the right.

The list on the left also includes the other nodes in the open message flow.
You can expand the properties listed under each node and work with all these
properties at the same time. You do not have to close the dialog and select
another node from the editor view to continue promoting properties.

You can select multiple properties to promote by selecting a property, holding
down Ctrl, and selecting one or more other properties.

If you have you selected multiple properties to converge, all the properties
you have selected must be available for promotion. If one or more of the
selected properties is not available for promotion, the entire selection becomes
unavailable for promotion, and the Promote button in the right-hand pane is
grayed out.

6. Click the Promote button to promote the property or properties

Clicking the Promote button invokes the Target Selection dialog:
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The Target Selection dialog displays only the valid targets for the promotion
of the previously selected property or properties and allows you to create a
new target for the promotion, such as to a new group or to a new property.
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7. To converge properties from the same or different nodes in the message flow,
expand the tree and click on a property that already exists. You can rename
the properties by selecting them and clicking Rename, or by double-clicking
on the group or property.

8. Click OK to confirm your selections.

Note: If you create a new group or property using the Target Selection dialog,
the changes persist even if you select Cancel in the dialog. When the
dialog closes, groups or properties that you have created using the
Target Selection dialog will appear in the Promote properties dialog.

9. Expand the property trees for all the nodes for which you want to promote
properties.

a. Drag the first instance of the property that you want to converge from the
list on the left, and drop it on the appropriate group in the list on the
right. If the group already contains one or more promoted properties, the
new property is added at the end of the group. Rename the new property
if you want to by double-clicking the property, or by selecting the property
and clicking Rename.

If you want the promoted property to appear in a new group, you can
drag and drop the property into an empty space below the existing
groups, which forces a new group to be created. You can also place the
promoted property in a new group by selecting the property you want to
promote, and clicking Promote, which opens the Target Selection dialog.
Click New Group, and enter the name of the new group. Click OK to
confirm your changes.

If you drag the property onto an existing promoted property of a different
type, a no-entry icon is displayed and you cannot drop the property. You
must create this as a new promoted property, or drop it onto a compatible
existing promoted property. Properties must be associated with the same
property editor to be compatible. For example, if you are using built-in
nodes, you can only converge like properties (string with string, boolean
with boolean).

10. Drag all remaining instances of the property from each of the nodes in the list
on the left onto the existing promoted property. The new property is added
under the existing promoted property, and is not created as a new promoted
property.

11. Click Apply to commit this change without closing the Property Promotion
dialog. Click OK to complete your updates and close the dialog.

Note: You can also converge properties from the Promote property dialog by
dragging the selected property or properties from the left-hand pane of the
Promote Property dialog to the right-hand pane:

1. Select the property you want to promote. You can select multiple
properties to promote by selecting a property, holding down Ctrl, and
selecting one or more other properties.

2. Drop the selected property or properties onto a property in the
right-hand pane to converge related properties from the same or
different nodes in the message flow.

For example, you might want to create a single promoted property that
overrides the property on each node that defines a data source.

For more information on converging properties, see [“Converging

[multiple properties” on page 57.
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Collecting message flow accounting and statistics data

You can collect statistics on message flow behavior.

The following topics describe the tasks that you can complete to control collection
of message flow accounting and statistics data:

« [“Starting to collect message flow accounting and statistics data”|

» |“Stopping message flow accounting and statistics data collection” on page 61|

* [“Viewing message flow accounting and statistics data collection parameters” on|
page 62|

+ [“Modifying message flow accounting and statistics data collection parameters”|
on page 63|

* |“Resetting message flow accounting and statistics archive data” on page 63|

The topics listed above show examples of how to issue the accounting and
statistics commands. The examples for z/OS are shown for SDSF; if you are using
another interface, you must modify the example shown according to the
requirements of that interface. For details of other z/OS options, see
fcommands to the z/0OS console

Starting to collect message flow accounting and statistics

data

60 Message Flows

You can start collecting message flow accounting and statistics data for an active
broker at any time.

Before you start:
To complete this task, you must have completed the following tasks:

+ |“Creating a message flow” on page 32|
* [“Deploying a broker archive file” on page 80|

You can select the granularity of the data that you want to be collected by
specifying the appropriate parameters on the mgsichangeflowstats command. You
must request statistics collection on a broker basis. If you want to collect
information for more than one broker, you must issue the corresponding number
of commands.

To start collecting message flow accounting and statistics data:
1. Identify the broker for which you want to collect statistics .

2. Decide the resource for which you want to collect statistics. You can collect
statistics for a specific execution group, or for all execution groups for the
specified broker. If you indicate a specific execution group, you can request that
data is recorded for a specific message flow or all message flows in that group.
If you specify all execution groups, you must specify all message flows.

3. Decide if you want to collect thread related statistics.

4. Decide if you want to collect node related statistics. If you do, you can also
collect information about terminals for the nodes.

5. Decide if you want to associate data collection with a particular accounting
origin. This option is valid for snapshot and archive data, and for message
flows and execution groups. However, when active, you must set its origin
value in each message flow to which it refers. If you do not configure the



participating message flows to set the appropriate origin identifier, the data
collected for that message flow is collected with the origin set to Anonymous.

See [‘Setting message flow accounting and statistics accounting origin”| for
further details.

6. Decide the target destination:
 User trace log
¢ XML format publication message
¢ SMF (on z/OS only)
7. Decide the type of data collection that you want:
* Snapshot
* Archive

8. Issue the mgsichangeflowstats command with the appropriate parameters to
reflect the decisions that you have made.

For example, to turn on snapshot data for all message flows in the default
execution group for BrokerA, and include node data with the basic message
flow statistics, enter:

mgsichangeflowstats BrokerA -s -e default -j -c active -n basic
Using SDSF on z/0OS, enter:
/F BrokerA,cs s=yes,e=default,j=yes,c=active,n=basic

Refer to the|mgsichangeflowstats command| for further examples.

When the command completes successfully, data collection for the specified
resources is started:

* If you have requested snapshot data, information is collected for approximately
20 seconds, and the results are written to the specified output.

 If you have requested archive data, information is collected for the interval
defined for the broker (on the mgqsicreatebroker or mqsichangebroker command,
or by the external timer facility ENF). The results are written to the specified
output, the interval is reset, and data collection starts again.

Setting message flow accounting and statistics accounting
origin

All message flow accounting and statistics data is collected with an accounting
origin set to Anonymous. You cannot change this value.

Stopping message flow accounting and statistics data
collection

You can stop collecting data for message flow accounting and statistics at any time.
You do not have to stop the message flow, execution group, or broker to make this
change, nor do you have to redeploy the message flow.

Before you start:

To complete this task, you must have completed the following task:
» [“Starting to collect message flow accounting and statistics data” on page 60|

You can modify the parameters that are currently in force for collecting message
flow accounting and statistics data without stopping data collection. See
“Modifying message flow accounting and statistics data collection parameters” on|

page 6§| for further details.
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To stop collecting data:
1. Check the resources for which you want to stop collecting data.

You do not have to stop all active data collection. If you choose, you can stop a
subset of data collection. For example, if you started collecting statistics for all
message flows in a particular execution group, you can stop doing so for a
specific message flow in that execution group. Data collection for all other
message flows in that execution group continues.

2. Issue the mgsichangeflowstats command with the appropriate parameters to
stop collecting data for some or all resources.

For example, to switch off snapshot data for all message flows in all execution
groups for BrokerA, enter:

mgsichangeflowstats BrokerA -s -g -j -c inactive
Using SDSF on z/0S, enter:
/F BrokerA,cs s=yes g=yes j=yes c=inactive

Refer to the|mgsichangeflowstats command| for further examples.

When the command completes successfully, data collection for the specified
resources is stopped. Any outstanding data that has been collected is written to the
output destination when you issue this command, to ensure the integrity of data
collection.

Viewing message flow accounting and statistics data
collection parameters

62 Message Flows

You can review and check the parameters that are currently in effect for message
flow accounting and statistics data collection.

Before you start:

To complete this task, you must have completed the following task:
« [“Starting to collect message flow accounting and statistics data” on page 60|

To view message flow accounting and statistics data collection parameters:

Issue the mgsireportflowstats command with the appropriate parameters to view
the parameters that are currently being used by the broker to control archive data
collection or snapshot data collection.

You can view the parameters in force for a broker, an execution group, or an
individual message flow.

For example, to view parameters for snapshot data for all message flows in all
execution groups for BrokerA, enter:

mgsireportflowstats BrokerA -s -g -j

Using SDSF on z/0S, enter:
/F BrokerA,rs s=yes,g=yes,j=yes

Refer to the [mgsireportflowstats command| for further examples.

The command displays the current status, for example:



BIP81871: Statistics Snapshot settings for flow MyFlowl in execution
group default - On?: inactive,

ThreadDatalLevel: basic, NodeDatalevel: basic,

QutputFormat: usertrace, AccountingOrigin: basic

Modifying message flow accounting and statistics data
collection parameters

You can modify the parameters that you have set for message flow accounting and
statistics data collection. For example, you can start collecting data for a new
message flow that you have deployed to an execution group for which you are
already collecting data.

You can modify parameters while data collection is active; you do not have to stop
data collection and restart it.

Before you start:

To complete this task, you must have completed the following task:
+ |“Starting to collect message flow accounting and statistics data” on page 60|

To modify message flow accounting and statistics parameters:

1. Decide which data collection parameters you want to change. You can modify
the parameters that are in force for a broker, an execution group, or an
individual message flow.

2. Issue the mgsichangeflowstats command with the appropriate parameters to
modify the parameters that are currently being used by the broker to control
archive data collection or snapshot data collection.

For example, to modify parameters to extend snapshot data collection to a new
message flow MFlow2 in execution group EG2 for BrokerA, enter:

mgsichangeflowstats BrokerA -s -e EG2 -f MFlow2 -c active
Using SDSF on z/0S, enter:
/F BrokerA,cs s=yes,e=EG2,f=MFlow2,c=active

If you want to specify an accounting origin for archive data for a particular
message flow in an execution group, enter:

mgsichangeflowstats BrokerA -a -e EG4 -f MFlowX -b basic

Using SDSF on z/0S, enter:

/F BrokerA,cs a=yes,e=EG4,f=MFlowX,b=basic

Refer to the [mgsichangeflowstats command| for further examples.

When the command completes successfully, the new parameters that you have
specified for data collection are in force. These parameters remain in force until
you stop data collection or make further modifications.

Resetting message flow accounting and statistics archive data

You can reset message flow accounting and statistics archive data to force the
current interval to complete. You can request this at any time; you do not have to
stop data collection and restart it to perform reset.

You cannot reset snapshot data.

Before you start:
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To complete this task, you must have completed the following task:
« |“Starting to collect message flow accounting and statistics data” on page 60|

To reset message flow accounting and statistics archive data:

1. Identify the broker, and optionally the execution group, for which you want to
reset archive data. You cannot reset archive data on a message flow basis.

2. Issue the mgsichangeflowstats command with the appropriate parameters to
reset archive data.

For example, to reset archive data for BrokerA, enter:
mgsichangeflowstats BrokerA -a -g -j -r

Using SDSF on z/0S, enter:

/F BrokerA,cs a=yes,g=yes,j=yes,r=yes

When this command completes, all accounting and statistics data accumulated so
far for this interval are recorded and made available according to the output option
currently in effect. The information recorded might therefore represent an
incomplete interval. Data collection is restarted from this point. All archive data for
all flows (indicated by -j or j=yes) in all execution groups (indicated by -g or
g=yes) is reset.

This command has no effect on snapshot data. It does not effect the settings for
archive data collection that are currently in force. When the command has
completed, data collection resumes according to the current settings.

You can change any other options that are currently in effect when you reset
archive data, for example accounting origin settings or output type.
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Deploying

This section provides information about deploying to execution groups on brokers.

It starts with an [overview of deployment] which includes descriptions of the
different mechanisms you can use to deploy. The section also contains separate
topics describing the different types of deployment:

Message flow application deployment|

— |Broker archive file

- [Configurable properties|
* [Broker configuration deployment]

* [Publish/subscribe topology deployment|
+ [Publish/subscribe topics hierarchy deployment|
+ |Cancel deployment]

It then describes in detail the steps needed to [deploy message flow applications}
* |Creating a server project|

* |Creating a broker archive]|

+ |Adding files to a broker archive]
- |[Editing a broker archive file manually]
- [Editing configurable properties|

* [Deploying a broker archivel

It also explains how to perform other types of deployment:
« |Deploying a broker configuration|

+ |Deploying a publish/subscribe topology]|

« |Deploying a publish/subscribe topics hierarchy]

It finally deals with a number of other deployment-related tasks:
¢ |Checking the results of deployment|

« |Canceling a deployment]

* |Renaming a deployed object|

* [Removing a deployed object

Deployment overview

Deployment is the process of transferring data to an execution group on a broker
so that it can take effect in the broker domain. For deploying message flows and
associated resources, the data is packaged in a broker archive (bar) file before
being sent to the Configuration Manager, from where it is unpackaged and
distributed appopriately.

This topic describes the three environments from which you can perform a

deployment, and then introduces a number of different types of deployment that
you might need to use:

* |"Deployment environments” on page 68|
* [“Types of deployment” on page 69
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You will also find that most types of deployment can, typically, be configured to
perform in one of two ways:

complete deployment; in which everything is deployed (or re-deployed) to the
whole domain

delta or incremental deployment; made either to just update information or to
deploy to selected brokers within the domain, depending on the type of
deployment

After reading this conceptual overview, find detailed instructions for particular
tasks in the subsequent topics.

Deployment environments

Depending on the environment in which you are working, you can generally
choose one of three different ways to initiate a deployment:
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Using the Message Brokers Toolkit

In the [Broker Administration perspective| of the the Domain
Navigator view displays all the objects associated with a specific domain.
For example, if you expand the Topology view, all the brokers in the
domain are displayed; if you expand a Broker view, all the execution
groups within that broker are displayed. From the Domain Navigator view
you can deploy a topology to all the brokers in the domain, or you can
deploy all the execution groups to a particular broker. You can also drag a
broker archive (bar) file from the Resource Navigator view onto an

execution group within the Domain Navigator view to deploy the contents
of the bar.

You might typically use the workbench if you are working in a
development environment or if you are new to WebSphere Event Broker.

Using the mqsideploy command

You can deploy from the command line using the command.
On the command line, you must typically specify the connection details as

well as parameters specific to the type of deployment you want to
perform. Details are given in each topic describing the types of
deployment.

You might typically use the mgsideploy command in a script when you are
more familiar with WebSphere Event Broker.

WebSphere Event Broker provides two files to help you when writing your
own scripts for managing broker deployment outside the workbench.
These are:

* Initialization file mqsicfgutil.ini. This is a plain text file in the
command’s working directory that contains configurable
variables needed to connect to the Configuration Manager. For example:
hostname = Tocalhost
queueManager = QMNAME
port = 1414
securityExit = test.myExit

If you do not explicitly specify any of this information as parameters on
the command (as has been done in the examples in
subsequent topics), the information is taken from the mgsicfgutil.ini file.
Alternatively, use the -n parameter on the command to specify an

XML-format .configmgr file that describes the connection parameters to
the Configuration Manager.



* Batch file mgsideploy.bat. The parameters used with the
command in WebSphere Event Broker Version 6.0 are not the same as
those used in earlier versions of the command. On Windows platforms,
use mgqsideploy.bat if you want to use the same parameters as in
previous versions.

Using the Configuration Manager Proxy API

You can control deployment from any Java program using the
|Configuration Manager Proxy APII You can also interrogate the responses
from the broker and take appropriate action.

The Configuration Manager Proxy API also allows Java applications to
control other objects in the domain, such as brokers, execution groups,
publish/subscribe topologies, topics, subscriptions and the Configuration
Manager and its event log. Because of this, you can use the Configuration
Manager Proxy API to create and manipulate an entire domain
programmatically.

Types of deployment

The other topics within this section describe what each type of deployment does,
the situation in which each type should and should not be used.

* |Broker configuration deployment|

To deploy message flows, message sets and other deployable objects to an
execution group, use:

* [Message flow application deployment]

This uses a proker archivd file for deployment. You can set
[propertied for objects in the message flow.

In publish/subscribe scenarios, you can deploy topics and topologies:

* [Topics hierarchy deployment|

+ [Topology configuration deployment]

You can also [cancel a deployment]

This table lists appropriate ways of deploying for a number of common scenarios.

Scenario Suggested deployment

Adding a broker to the domain (when not None required.
using publish/subscribe)

Connecting publish/subscribe brokers using |Delta topology deployment
connections or a collective

Modifying the publish/subscribe topic Delta deployment of the topics hierarchy
hierarchy (The changed elements in the topic hierarchy
are deployed to all brokers in the domain.
Modifying the publish/subscribe topic Complete topics deployment (The entire
hierarchy, after adding a new broker to the |topic hierarchy is deployed to all brokers in
domain the domain. The new broker also receives

the complete topic hierarchy.)

Tidying up a broker’s resources after If the broker is part of a publish/subscribe
removing it from the topology network, or if you are using the Message
Brokers Toolkit, initiate a delta
publish/subscribe topology deployment.
Otherwise, no deployment is required.
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Scenario Suggested deployment

Creating an execution group Message flow application deployment using
an incremental bar file deployment.

Deleting an execution group None required.

If a broker is not responding to a deploy Ensure that the broker is running. If the

request broker is not running, cancel the broker

deployment. You should only cancel a
broker deployment if you are sure that the
broker will never respond to the deploy
request.

Message flow application deployment
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You do not deploy a message flow application directly to an execution group.
Instead, you package all the relevant resources into a|broker archive| (bar), which
you then deploy. When you [add files to the broker archive] they are automatically
compiled as part of the process. JAR files that are required by [avaCompute nodes|
within message flows are added automatically from your Java project.

The broker archive itself is a compressed file which is sent to the Configuration
Manager where its contents are extracted and distributed to execution groups. If an
execution group has not been initialized on the broker (that is, if the broker has
only just been created), then the execution group is created as part of the
deployment.

There are two ways of deploying a bar file:

* [Incremental deployment} in which deployed files are added to the execution
group. Files which already exist in the execution group are replaced with the
new version.

* [Complete deployment} in which files already deployed to the execution group
are removed before the complete contents of the bar file is deployed. Thus,
nothing is left in the execution group from any previous deployment.

Incremental bar file deployment
Incrementally deploying a bar file tells the Configuration Manager to extract the
contents of the bar file and send it to an execution group.

* If a file in the bar file has the same name as an object that is already deployed to
the execution group, the version that is already deployed is replaced with the
version in the bar file.

* If a file in the bar file is of zero length and a file of that name has already been
deployed to the execution group, then the deployed file is removed from the
execution group.

When to use it
* If you want to incrementally deploy message flows, message sets or
other deployable objects to an execution group.
When not to use it

 If you want to completely clear the contents of the execution group
before the bar file is deployed. In this case, use a complete bar file
deployment instead.



Complete bar file deployment
Completely deploying a bar file tells the Configuration Manager to extract the
deployable content of the bar file and send it to an execution group, first removing
any existing deployed contents of the execution group.
When to use it

* If you want to deploy message flows, message sets or other deployable

objects to an execution group.

When not to use it

* If you want to merge the existing contents of the execution group with
the contents of the bar file. In this case, use an incremental bar file
deployment instead.

Related concepts

[‘Deployment overview” on page 67
Related tasks
[‘Deploying a message flow application” on page 76|

[Using the Configuration Manager Proxy API to deploy]

Related reference

[Broker Administration perspectivel

imgsideploy command]

Broker archive
The unit of deployment to the broker is the broker archive or bar file.

The bar file is a zip-format file which can contain a number of different files:

* A .cmf file for each message flow. This is a compiled version of the message
flow. You can have any number of these files within your bar file.

e A .dictionary file for each message set dictionary. You can have any number of
these files within your bar file.

* A broker.xml file. This file is called the broker deployment descriptor. You can
have only one of these files within your bar file. This file, in XML format, resides
in the META-INF folder of the zip file and can be modified using a text editor or
shell script.

* Any number of XML files(.xml) and style sheets (.xsl files) for use with the
[XMLTransformation| node.

* Any number of JAR files for use with the node.

* As a zip-format archive, the broker archive file can also contain any additional
files you need. For example, you might want to include Java source files for
future reference.

To deploy XML, XSL, and JAR files inside a broker archive, the connected
Configuration Manager and target broker must be Version 6.0 or later.

Broker archive - configurable properties

System objects defined in message flows can have configurable properties that you
can update within the broker archive (bar) file before deployment. Configurable
properties allow an administrator to update target-dependent attributes, such as
queue names, queue manager names, and database connections, so that they can
be customized for a new domain, for example to a test system, without needing to
edit and rebuild the message flows, message mappings, or ESQL transformation
programs. Any such properties that you define are contained within the
deployment descriptor, META-INF /broker.xml.
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Edit the configurable properties using the Broker Archive editor, or by manually
editing the deployment descriptor using an external text editor or shell script. The
deployment descriptor is parsed when the bar file is deployed.

Broker configuration deployment

A broker configuration deployment informs a broker of various configuration
settings, including the list of execution groups, multicast and inter-broker settings.

When to use it

* If you have modified multicast or inter-broker settings in the Message
Brokers Toolkit or in a Configuration Manager Proxy application.

When not to use it
« If you have used the [mgsichangeproperties| command to change
publish/subscribe settings directly on the broker component. In this
case, a broker configuration deployment overwrites any changes you
have made to the settings.

* If you are adding execution groups. In this case, the first time you
deploy a broker archive (bar) file, the execution group is automatically
initialized.

Related concepts

[‘Deployment overview” on page 67]
Related tasks
[‘Deploying a broker configuration” on page 83

[Developing applications that use the Configuration Manager Proxy Java API]|
[Using the Configuration Manager Proxy API to deploy]

Related reference

[Broker Administration perspective|

[mgsichangeproperties command|

Publish/subscribe topology deployment
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Topology deployment is primarily only required when using publish/subscribe. It
informs each broker in the domain of the brokers with which it can share
publications and subscriptions.

There are two ways of deploying a topology configuration:

* |Complete topology deployment, in which all brokers are told of their
neighboring publish/subscribe brokers.

Delta topology deployment] in which only changes to the publish/subscribe
topology are deployed. Such changes are deployed only to those brokers whose
neighbor lists have changed since the last successful topology deployment.

Complete topology deployment

Deploying a complete topology:

e Tells each broker in the domain the set of brokers with which it can share
publish/subscribe information.

* Forces the Configuration Manager to re-subscribe to the broker’s status topics,
such as start and stop messages.



Note: Whatever type of deployment you perform, the Configuration Manager
attempts to subscribe to the broker’s status messages if it is the first
deployment to the broker. But only deploying the complete topology
initiates a re-subscription.

When to use it
* If the Configuration Manager is not correctly reporting whether it is in a
stopped or started state.
 If you have moved a Configuration Manager from one queue manager
to another.
* If a broker’s publish/subscribe function has become inconsistent. An

example of inconsistency would be, for example, if one broker is able to
share publications with a second broker, but not the other way round.

When not to use it

* If you are adding brokers to the domain and you are not using
publish/subscribe. That is, if you are not connecting brokers together so
that they can share publications and subscriptions.

* If you are adding execution groups to a broker.

* If you have changed the publish/subscribe network. In this case, deploy
a delta topology, if possible, so that you only deploy to those brokers
affected by the changes you have made.

* If you have removed a broker from the domain.

Delta topology deployment

Deploying a delta topology sends updated publish/subscribe network information
to any broker with a publish/subscribe configuration that the Configuration
Manager determines not to be current.

When to use it
* If you have modified a publish/subscribe network.

* If you are using the workbench to remove a broker from the domain, the
Configuration Manager automatically requests the broker component to
stop message flows that are running and to tidy up any resources being
used. If this operation fails for any reason, you can again request the
broker to tidy up. Deploying a delta topology is the most convenient
way.

When not to use it

* If you are adding brokers to the domain and you are not using
publish/subscribe. That is, if you are not connecting brokers together so
that they can share publications and subscriptions.

* If you are adding or removing execution groups.

Related concepts

‘Deployment overview” on page 67|
Publish /Subscribe
Publish /subscribe topologies|

Related tasks

[‘Deploying a publish/subscribe topology” on page 8§|
Using the Configuration Manager Proxy API to deploy]
Adding a broker to a broker domain|

Related reference

[Configuring a publish/subscribe topologyl
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[Broker Administration perspective|

hanging Broker Administration preferences
ging p

imgsideploy command|

Publish/subscribe topics hierarchy deployment
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If you are using publish/subscribe, deploy the topics hierarchy in these situations:

* If you have modified the hierarchy of topics. The deployment communicates the
new hierarchy to each broker.

 If you have added a broker to the domain and you want it to use the existing
topics hierarchy. The deployment communicates the hierarchy to the new broker.

There are two ways of deploying a publish/subscribe topics hierarchy:

Complete deployment), in which the complete topics hierarchy is sent to all the
brokers in a domain.

+ |Delta deployment} in which changes to the topics hierarchy (made since the last
topics deployment) are sent to all the brokers in a domain.

Complete topics deployment

A complete topics deployment sends the publish/subscribe topics hierarchy to all
the brokers in a domain.

When to use it

* If you have made changes to the topics hierarchy and one of the brokers
has an inconsistent view of the expected topics hierarchy.

* If you have added a new broker to the domain that uses the topics
hierarchy.
When not to use it

 If you have changed the topics hierarchy. In this case, a delta topics
deployment is usually sufficient.

Delta topics deployment
A delta topics deployment sends the publish/subscribe topics hierarchy to all the
brokers in a domain.
When to use it
* If you have made changes to the topics hierarchy.

When not to use it
e If the topics hierarchy has not changed.
Related concepts

[‘Deployment overview” on page 67]

Publish /Subscribe]

[Topics|

Related tasks

[‘Deploying a publish/subscribe topics hierarchy” on page 86

Using the Configuration Manager Proxy API to deployl]

Developing publish /subscribe applications|

Related reference

[Broker Administration perspective]

imgsideploy command]




Cancel deployment

The Configuration Manager allows only one deployment to be in progress to each
broker at any one time. If for some reason a broker does not respond to a
deployment request, subsequent requests cannot reach the broker, because, to the
Configuration Manager, a deployment is still in progress.

Canceling deployment tells the Configuration Manager to assume that a broker
will never respond to an outstanding deploy. In most cases, the action does not
remove any deployment messages that have been sent to the broker, nor does it
alter the running configuration of the broker. (Thus, for any brokers that have
successfully deployed a configuration, the deployed information remains on the
broker.)

If a broker subsequently does provide a response to an outstanding deployment
that has been canceled, the response is ignored by the Configuration Manager and
there is then an inconsistency between what is running on the broker and the
information that is provided by the Configuration Manager.

Because of this risk of inconsistency, only cancel a deployment as a last resort, and
only if you are sure that a broker will never be able to process a previous
deployment request. However, before canceling deployment, you can manually
remove any outstanding deployment messages to ensure that they are not
processed.

When canceling deployment across the domain, the locks for all outstanding
deploys in the domain are removed. When canceling deployment for a specific

broker, only the lock for that broker is removed.

Canceling deployment is the equivalent of the force deploy” action in previous
versions, except that cancel does not redeploy domain information.

You can cancel a deployment:

+ [To all the brokers in a domain|

« [To a single broker]

Cancel deployment to a domain

Canceling the deployment to a domain tells the Configuration Manager to assume
that all brokers in the domain that have outstanding deployments will not
respond. If a broker then does provide a response to an outstanding deploy that
has been canceled, it will be ignored and there will be an inconsistency between
what is running on the broker and the information that is provided by the
Configuration Manager.

When applied to a domain, canceling deployment does not remove deployment
messages that have been sent to the brokers, and does not change the brokers’
running configuration.

When to use it
Cancel a domain deployment only if these two conditions are both met:
* You attempt a deployment and you receive error message BIP1510.
* Any of the brokers that have outstanding deployments are not
responding.

When not to use it
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* If a broker is simply taking a long time to respond to a deployment
request. The broker might have been temporarily stopped, for example.

* If other users might be deploying to the domain at the same time.

* If only one broker is not responding, or a small number of brokers are
not responding. In this case, cancel the broker deployment instead.

Cancel deployment to a broker

Canceling the deployment to a single broker tells the Configuration Manager to
assume that a specific broker in the domain that has an outstanding deployment
will not respond. If the broker then does provide a response to an outstanding
deploy that has been canceled, it will be ignored and there will be an inconsistency
between what is running on the broker and the information that is provided by the
Configuration Manager.

When applied to an individual broker, canceling deployment causes the
Configuration Manager to attempt to remove from the broker, deployment
messages that have not yet been processed. This only succeeds if the broker and
the Configuration Manager share the same queue manager and if the message has
not already been processed by the broker.

When to use it
Cancel a domain deployment only if these two conditions are both met:
* You attempt a deployment and you receive error message BIP1510.

* The broker is not responding.

When not to use it

* If the broker is simply taking a long time to respond to a deployment
request. The broker might have been temporarily stopped, for example.

¢ If the version of the connected Configuration Manager is earlier than
Version 6.0. In this case, canceling deployment to a specific broker has
no effect; you must cancel the entire domain deployment instead.

Related concepts

[‘Deployment overview” on page 67|
Related tasks
[‘Canceling a deployment that is in progress” on page 90|

[Using the Configuration Manager Proxy API to deploy|

Related reference

[Broker Administration perspective|

[mgsideploy command]|

Deploying a message flow application

Before you start:

Before you can deploy a message flow application, you must have created, and
started, a Configuration Manager. The broker added to the domain is actually a
reference, so you must also create and start the physical broker on the target
system. A WebSphere MQ listener must be running and you must also have
created a domain, added a broker to that domain, and created an execution group
within the broker. See the links to related tasks below for help with these.

Message flow applications are deployed to execution groups by adding required
resources, optionally with their source files, to a broker archive (bar) file. The bar
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file is then sent to the appropriate Configuration Manager where it is unpacked
and the individual files deployed to execution groups on individual brokers. The
[Message flow application deployment] topic gives more details.

The tasks in this section describe the process:

1. |Creating a server project|

2. [Creating a broker archive file]
3. |Adding files to a broker archive]

Editing a broker archive file manually|

Editing configurable properties|

N

. [Deploying a broker archive file|

(9]

. [Checking the results of deployment
g ploy:

[“Displaying version and keyword information” on page 82| describes how to view
version and keyword information about deployed objects.

The .1l file for a plugin node must also be deployed to every broker computer that
uses that node in a message flow. For more details, see the section about
ldeveloping user-defined extensions,.

Creating a server project

Before you start:
Save your message flow projects.

You do not need to explicitly create a server project before you deploy a message
flow application. One can be created for you when you create the broker archive

file. (It can also be created automatically when you create a .configmgr connection
file.)

However, if you do want to create a server project, follow these steps:
Switch to the Broker Administration perspective.

Click File » New ~» Other.

In the list of wizards, expand Server and click Server Project.
Click Next.

Enter the name of your new server project.

Click Finish.

o0k own =

The folder that is created appears twice in the Navigator view (if Show empty
projects in Navigators has been selected in the Broker Administration Preferences

page):
e in the Domain Connections folder

e in the Broker Archives folder

Next:

Continue by |creating a broker archive (bar)|and [adding files to if,
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Creating a broker archive

Create a separate (bar) file for each configuration that you want to
deploy.

There are two ways of creating a bar file:

+ |Using the Message Brokers Toolkif]

+ |Using the mgsicreatebar command|

Using the Message Brokers Toolkit

Follow these steps to create a bar file using the workbench:

1. From the Broker Administration perspective, click File > New » Message
Broker Archive.

2. Enter the name of your server project, or select one from the displayed list. If
the server project does not already exist, it is created when the bar file is
created.

3. Enter a name for the bar file that you are creating.
4. Click Finish.

A file with a .bar extension is created and is displayed in the Broker
Administration Navigator view, under the Broker Archives folder. The Content
editor for the bar file opens.

Next:

Continue by [adding files to your broker archive|and then

Using the mqsicreatebar command

Follow these steps to create a bar file using the command:

1. Open a command window that is configured for your environment.

2. Enter the command, typed on a single line, using this as an example:
mqgsicreatebar -b barName -p projectNames -o filePath
A file with a .bar extension is created.

The -b (bar file name), and -o (path for included files) parameters must be

specified. The -p (project names) parameter is optional. The topic

gives more details.

Next:

Continue by [adding files to your broker archive|and then

Adding files to a broker archive
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To deploy files to an execution group, you first include them in a broker archive
(bar). The bar file is deployed by sending it to the Configuration Manager and
from there, its contents are sent to the execution group on a broker.

You can only add message flows at the project level. However, after you have
added the project to the bar file, you can use the Remove icon to remove
individual message flows or message definitions, if required. Likewise, if you



check the Include message flow sourcebox, the source for all the message flows in
the project are included but you can manually remove the source files for the
message flows that you do not want.

To deploy XML, XSL, and JAR files inside a broker archive, the connected
Configuration Manager and target broker must be Version 6.0 or later.

If there is a parent flow and subflow displayed in the Add dialogue, subflows are
added automatically, so you only have to add the parent flow.

You can manually add XML, XSL and JAR files by following these steps. But JAR
files that are required by [JavaCompute nodes| within message flows are added
automatically from your Java project when you add the message flow. Similarly,
XML and XSL files are automatically added if required by the flow.

It is not possible to read deployed files back from broker execution groups.
Therefore, keep a copy of the deployed bar file, or of the individual files within it.

Follow these steps to add files to a broker archive (bar) file using the Message

Brokers Toolkit:

1. Switch to the Broker Administration perspective.

2. Double-click your bar file in the Broker Administration Navigator view to open
it. The contents of the bar file are shown in the Content editor. (If the bar file is
new, this view is empty.)

3. Click the Add icon.

4. Check the boxes for the message flows and other files that you want to include.
(Duplicates within a bar file are automatically removed.)

5. Optional: If you want to include your message flow source files, check the
Include message flow source box.

6. Click OK.
A list of the files that are now in your bar file is displayed in the Content editor.
You can choose not to display your message flow source files by clearing the Show

source files box at the bottom of the Content editor pane.

Next:

The next step is to |[deploy your broker archive (bar) file] but you might first want
to fedit configurable properties} You can also ledit the contents of your bar fil¢

Imanuallxl

Editing a broker archive file manually

Before you start:
This task explains how to manually edit a broker archive (bar) file that already
exists. If you have not already created a bar file, before continuing.
Follow these steps to edit a bar file manually using the Message Brokers Toolkit:
1. Export the bar file.

a. From the workbench, click File » Export. The Export window appears.

b. Select the export destination, such as a .zip file, and click Next.

c. Select the resources that you want to export and click Next.
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d. Complete the destination information and click Finish. The file appears at
the destination you specified as a .zip file.

Unzip the bar file.

Edit the properties that you want to change in an editor of your choice.
Save the file.

Import the bar file back into the workbench to deploy it.

Al A

a. From the workbench, click File » Import. The Import window appears.
b. Select Zip file from the list.

c. Click Next.

d. Specify the name and location of your bar file.

e. Select the server project that you want to contain the bar file.

f. Click Finish.

Next:

Continue by [deploying your broker archive (bar) filel.

Editing configurable properties
Before you start:

This task explains how to edit the configurable properties of your broker archive
bar) file deployment descriptor. If you have not already created a bar file,

before continuing.

Follow these steps to edit properties using the Message Brokers Toolkit:
1. Switch to the Broker Administration perspective.

2. Select the Configure tab at the bottom of the Content editor pane. The
properties that you can configure are listed.

3. Click the property for which you want to edit the value. The values that can be
edited are displayed.

4. Replace the current value with the new value.

5. Save your bar file.

You can also edit this XML-format file manually using an external text editor or
shell script.

Next:

Continue by [deploying your broker archive (bar) file,

Deploying a broker archive file

80 Message Flows

Before you start:
This task explains how to deploy your broker archive (bar). If you have not
already created a bar file, before continuing.

There are three ways of deploying a broker archive (bar) file:

Using the Message Brokers Toolkit]

« |Using the mgsideploy command|




+ |Using the Configuration Manager Proxy API|

You need to have access rights if the execution group to which you want to deploy
is restricted by an ACL.

Using the Message Brokers Toolkit

Follow these steps to deploy a bar file using the workbench:

1.
2.

Switch to the Broker Administration perspective.

Optional. Normally, an incremental bar file deployment is performed. If you
want to perform a complete bar file deployment: right-click the target execution
group in the Domains view and select Remove Deployed Children. Wait for
the operation to complete before continuing.

It is not necessary to remove deployed children if you only want to refresh one
or more of them with the contents of the bar file. The difference between a
complete and an incremental bar file deployment is explained in the
[flow application deployment| topic.

Click the bar file shown in the Navigator view to highlight it.
Drag the file onto your target execution group shown in the Domains view.

If the bar file has not been saved since it was last editied, you are asked
whether you want to save it before deploying. If you click Cancel, the bar file
is not saved and deployment does not take place. The bar file is transferred to
the Configuration Manager from where its contents (message flows, for
example) are deployed to the execution group. In the Domains view, the
assigned message flows are added to the appropriate execution group.

Next:

Continue by [checking the resultd of the deployment.

Using the mqgsideploy command

Follow these steps to deploy a bar file using the command:

1.

Open a command window that is configured for your environment.

2. Using these as examples, enter the appropriate command, typed on a single
line:
On z/0S:
/f MQO1CMGR,dp b=broker e=exngp a=barfile
This performs an incremental deployment. Add the m=yes parameter to perform
a complete bar file deployment.
On other platforms:
mgsideploy -i ipAddress -p port -q gmgr -b broker -e exngp -a barfile
This performs an incremental deployment. Add the -m parameter to perform a
complete bar file deployment.
The -i (IP address), -p (port), and -q (queue manager) parameters represent the
connection details of the queue manager workstation, and on the z/OS console,
MQO1CMGR is the name of the Configuration Manager component.
The -b (broker name), -e (execution group name), and -a (bar file name)
parameters (or z/OS equivalent) must also be specified.

Next:

Continue by [checking the resultd of the deployment.
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Using the Configuration Manager Proxy API

Use the deploy method of the ExecutionGroupProxy class. By default, the deploy
method performs an incremental deployment. To perform a complete deployment,
use a variant of the method that includes the boolean isIncremental parameter;
setting this to false indicates a complete deployment. (Setting it to true indicates an
incremental deployment.)

For example:
import com.ibm.broker.config.proxy.x*;

public class DeployTopology {
public static void main(String[] args) {
ConfigManagerConnectionParameters cmcp =
new MQConfigManagerConnectionParameters
("localhost", 1414, "QM1");
try {
ConfigManagerProxy cmp =
ConfigManagerProxy.getInstance(cmcp);
TopologyProxy t = cmp.getTopology();
BrokerProxy b = t.getBrokerByName("BROKER1");
ExecutionGroupProxy e = b.getExecutionGroupByName("default");
e.deploy(false);
1
catch (ConfigManagerProxyException e) {
e.printStackTrace();
1
}
1

Next:

Continue by [checking the resultg of the deployment.

Displaying version and keyword information

This topic contains information about how to view the version and keyword
information of deployable objects.

* |“Displaying object version in the bar file editor”]

« |"Displaying version, deploy time, and keywords of deployed objects”]

Displaying object version in the bar file editor

A column in the bar editor called Version displays the version tag for all objects
that have a defined version. These are:

e .cmf files

You can not edit the Version column.

You can use the |mqsireadbar commandl to list the keywords defined for each
deployable file within a deployable archive file.

Displaying version, deploy time, and keywords of deployed
objects

The Eclipse Properties View displays, for any deployed object:
* Version
* Deploy Time
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 All defined keywords

For example, a message flow can be deployed with the deployed with the
following literal strings:

. $MQSI_VERSION=V1.0 MQSI$
e $MQSI Author=fred MQSI$
e $MQSI Subflow 1 Version=v1.3.2 MQSI$

For the previous example, the Properties View displays:

Deployment Time Date and time of deployment
Modification Time Date and time of modification
Version vl.0
Author fred
Subflow 1 Version vl.3.2

You are given a reason if the keyword information is not available. For example, if
keyword resolution has not been enabled at deploy time, the Properties View
displays the message Deployed with keyword search disabled. Also, if you deploy
to a Configuration Manager that is an earlier version than Version 6.0, the
properties view displays Keywords not available on this Configuration Manager.

Deploying a broker configuration

The proker configuration deployment overview explains when you might want to
deploy a broker configuration.

There are three ways to deploy a broker configuration:
+ |Using the Message Brokers Toolkit]
« |Using the mgsideploy command]

+ |Using the Configuration Manager Proxy AP]|

Using the Message Brokers Toolkit

If you modify any multicast or interbroker settings with the workbench, a broker
configuration deployment is automatically initiated when the changes are applied.

Using the mqgsideploy command

Follow these steps to deploy a broker configuration using the

command:
1. Open a command window that is configured for your environment.

2. Using these as examples, enter the appropriate command, typed on a single
line, specifying the broker to which you want to deploy:

On z/0S:

/f MQO1CMGR,dp b=broker

On other platforms:

mqsideploy -i ipAddress -p port -q gqmgr -b broker
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The -i (IP address), -p (port), and -q (queue manager) parameters represent the
connection details of the queue manager workstation, and on the z/OS console,
MQO1CMGR is the name of the Configuration Manager component.

By specifying the broker to which you want to deploy (b= or -b), without
indicating a bar file (-a), the broker configuration is deployed rather than a
message flow application.

Next:

Continue by |checking the results of the deployment.

Using the Configuration Manager Proxy API

Use the deploy method of the BrokerProxy class.

For example:

import com.ibm.broker.config.proxy.=*;

public class DeployBrokerConfig f{
public static void main(String[] args) {
ConfigManagerConnectionParameters cmcp =
new MQConfigManagerConnectionParameters
("1ocalhost", 1414, "QM1");
try {
ConfigManagerProxy cmp = ConfigManagerProxy.getInstance(cmcp);
TopologyProxy t = cmp.getTopology();
BrokerProxy b = t.getBrokerByName("BROKER1");
if (b !'= null) {
b.deploy();

1
catch (ConfigManagerProxyException e)
e.printStackTrace();
1
}
1

Next:

Continue by [checking the resultg of the deployment.
Related concepts

[‘Deployment overview” on page 67|

[‘Broker configuration deployment” on page 72|

[Configuration Manager Proxy]

Related tasks

[‘“Deploying” on page 67|

‘Checking the results of deployment” on page 8§

Developing applications that use the Configuration Manager Proxy Java API|
Using the Configuration Manager Proxy API to deployl]

Resolving problems when using the workbench|

Resolving problems when deploying message flows|
Resolving problems when developing Configuration Manager Proxy]|
applications|

Related reference

[Changing Broker Administration preferences|
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[Broker Administration perspectivel

[mgsideploy command|

Deploying a publish/subscribe topology

Before you start:

Make sure that you have [configured your broker domain|

The [publish/subscribe topology deployment] overview explains when you might
want to deploy a topology and the difference between a complete and delta
deployment.

There are three ways to deploy topology information:
+ |Using the Message Brokers Toolkit]
+ [Using the mgsideploy command]

+ [Using the Configuration Manager Proxy AP]|

You can the workbench preferences so that topology information is
automatically deployed after a change.

Using the Message Brokers Toolkit

Follow these steps to deploy a topology configuration using the workbench:
1. Switch to the Broker Administration perspective.

2. In the Domains view, expand the Domains from where you want to perform
the deploy.

3. Right-click Broker Topology hierarchy.
4. Click Deploy Topology Configuration.

5. Click Delta to deploy only the changed items, or click Complete to deploy the
entire configuration.
Alternatively, you can make a change to the Topology document in the Broker
Administration perspective, save the changes and then select Delta. This
behavior can be modified in the workbench preferences dialog.

The topology is deployed, and the Configuration Manager distributes it to the
brokers in the domain.

Next:

Continue by [checking the results of the deployment.

Using the mqgsideploy command

Follow these steps to deploy a topology configuration using the

command:
1. Open a command window that is configured for your environment.

2. Using these as examples, enter the appropriate command, typed on a single
line:
On z/0S:
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/f MQO1CMGR,dp 1=yes

This performs a delta deployment. Add the m=yes parameter to deploy the
entire configuration.

On other platforms:

mgsideploy —i ipAddress —p port —q gmgr -1

This performs a delta deployment. Add the -m parameter to deploy the entire
configuration. The -i (IP address), -p (port), and -q (queue manager) parameters
represent the connection details of the queue manager workstation, and on the
z/0S console, MQO1CMGR is the name of the Configuration Manager
component.

Next:

Continue by [checking the resultd of the deployment.

Using the Configuration Manager Proxy API

Use the deploy method of the TopologyProxy class. By default, the deploy method
performs a delta deployment. To deploy the complete hierarchy, use a variant of
the method that includes the boolean isDelta parameter; setting this to false
indicates a complete deployment. (Setting it to true indicates a delta deployment.)

For example:
import com.ibm.broker.config.proxy.x*;

public class DeployTopology {
public static void main(String[] args) {
ConfigManagerConnectionParameters cmcp =
new MQConfigManagerConnectionParameters
("lTocalhost", 1414, "QM1");
try {
ConfigManagerProxy cmp =
ConfigManagerProxy.getInstance(cmecp);
TopologyProxy t = cmp.getTopology();
t.deploy(false);

catch (ConfigManagerProxyException e)
e.printStackTrace();
1
}
1

Next:

Continue by |checking the results of the deployment.

Deploying a publish/subscribe topics hierarchy
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Before you start:

Make sure that you have |configured your broker domain|

The ftopic deployment overview| explains when you might want to deploy a topic
hierarchy and the difference between a complete and delta deployment.

There are three ways to deploy a topics hierarchy:
+ |Using the Message Brokers Toolkit]




+ |Using the mqsideploy command|

* |Using the Configuration Manager Proxy AP]|

You can the workbench preferences so that a topics hierarchy is
automatically deployed after a change.

Using the Message Brokers Toolkit

Follow these steps to deploy a topics hierarchy using the workbench:
1. Switch to the Broker Administration perspective.

2. In the Domains view, expand the Domains from where you want to perform
the deploy.

3. Right-click Topics hierarchy.
4. Click Deploy Topics Configuration.

5. Click Delta to deploy only the changed items, or click Complete to deploy the
entire configuration.

The topics hierarchy is deployed, and the Configuration Manager distributes the
topics to brokers in the domain.

Next:

Continue by [checking the resultg of the deployment.

Using the mqgsideploy command

Follow these steps to deploy a topics hierarchy using the command:

1. Open a command window that is configured for your environment.

2. Using these as examples, enter the appropriate command, typed on a single
line:
On z/0S:
/f MQO1CMGR,dp t=yes
This performs a delta deployment. Add the m=yes parameter to deploy the
entire configuration.
On other platforms:
mgsideploy -i ipAddress -p port -q gmgr -t
This performs a delta deployment. Add the -m parameter to deploy the entire
configuration. The -i (IP address), -p (port), and -q (queue manager) parameters
represent the connection details of the queue manager workstation, and on the

z/0S console, MQO1CMGR is the name of the Configuration Manager
component.

Next:

Continue by [checking the resulty of the deployment.

Using the Configuration Manager Proxy API

Use the deploy method of the TopicRootProxy class. By default, the deploy method
performs a delta deployment. To deploy the complete hierarchy, use a variant of
the method that includes the boolean isDelta parameter; setting this to false
indicates a complete deployment. (Setting it to true indicates a delta deployment.)
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For example:
import com.ibm.broker.config.proxy.x*;

public class DeployTopics {
public static void main(String[] args) {
ConfigManagerConnectionParameters cmcp =
new MQConfigManagerConnectionParameters
("Tocalhost", 1414, "QM1");
try {
ConfigManagerProxy cmp =
ConfigManagerProxy.getInstance(cmcp);
TopicRootProxy t = cmp.getTopicRoot();
t.deploy(false);

catch (ConfigManagerProxyException e) {
e.printStackTrace();
1
}
1

Next:

Continue by [checking the result of the deployment.

Checking the results of deployment

After you have made a deployment, check that the operation has completed
successfully. There are three ways of checking the results of a deployment:

+ |Using the Message Brokers Toolkit]
+ |Using the mqsideploy command|

* [Using the Configuration Manager Proxy AP]|

Also, check the system log on the target system where the broker was deployed to
make sure that the broker has not reported any errors.

Using the Message Brokers Toolkit

Follow these steps to check a deployment using the workbench:
1. Switch to the Broker Administration perspective.

2. Expand the Domains view.

3. Double-click the Event Log.

When the deployment is initiated, an information message is displayed, confirming
that the request was received by the Configuration Manager:

* BIP0892I

If the deployment completes successfully, you might also see one or more of these
additional messages:

* BIP40401
* BIP40451
* BIP20561
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Using the mqgsideploy command

The command returns numerical values from the Configuration Manager and any
brokers affected by the deployment to indicate the outcome of the deployment. If it
completes successfully, it returns 0. Refer to the topic for details of
other values that you might see.

Using the Configuration Manager Proxy API

If you are using a Configuration Manager Proxy application, you can find out the
result of a publish/subscribe topology deployment operation, for example, by
using code similar to this:

TopologyProxy t = cmp.getTopology();

boolean isDelta = true;
long timeToWaitMs = 10000;
DeployResult dr = topology.deploy(isDelta, timeToWaitMs);

System.out.printIn("Overall result = "+dr.getCompletionCode());

// Display overall log messages

Enumeration logEntries = dr.getLogEntries();

while (logEntries.hasMoreElements()) {
LogEntry le = (LogEntry)logEntries.nextElement();
System.out.printin("General message: " + le.getDetail());

}

// Display broker specific information
Enumeration e = dr.getDeployedBrokers();
while (e.hasMoreETements()) {

// Discover the broker
BrokerProxy b = (BrokerProxy)e.nextElement();

// Completion code for broker
System.out.printin("Result for broker "+b+" = " +
dr.getCompletionCodeForBroker(b));

// Log entries for broker
Enumeration e2 = dr.getLotEntriesForBroker(b);
while (e2.hasMoreElements()) {
LogEntry Te = (LogEntry)e2.nextElement();
System.out.printin("Log message for broker " + b +
le.getDetail()));
}

}

The deploy() method blocks until all affected brokers have responded to the
deployment request.

When the method returns, the DeployResult represents the outcome of the
deployment at the time when the method returned; the object is not updated by
the Configuration Manager Proxy.

If the deployment message could not be sent to the Configuration Manager, a
ConfigManagerProxylLoggedException is thrown at the time of deployment. If the
Configuration Manager receives the deployment message, then log messages for
the overall deployment are displayed, followed by completion codes specific to
each broker affected by the deployment. The completion code is one of the
following static instances from the
com.ibm.broker.config.proxy.CompletionCodeType class:
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Completion Description

code

pending The deploy is held in a batch and will not be sent until you issue
ConfigManagerProxy.sendUpdates().

submitted The deploy message was sent to the Configuration Manager but no
response was received before the timeout occurred.

initiated The Configuration Manager replied stating that deployment has started,
but no broker responses were received before the timeout occurred.

successSoFar The Configuration Manager issued the deployment request and some,
but not all, brokers responded with a success message before the
timeout period expired. No brokers responded negatively.

success The Configuration Manager issued the deployment request and all
relevant brokers responded successfully before the timeout period
expired.

failure The Configuration Manager issued the deployment request and at least
one broker responded negatively. You can use getLogEntriesForBroker for
more information on why the deployment failed.

notRequired A deployment request was submitted to the Configuration Manager
involved with the supplied broker, but the request was not sent to the
broker because its configuration is already up to date.

Canceling a deployment that is in progress

Before you start:

Canceling a deployment should only be a last resort if you are sure that a broker,
or several brokers in a domain, will never be able to process a previous
deployment request. For this reason, make sure that you understand the
implications of this action, described in the [Cancel deployment|overview topic.

It is possible to cancel all outstanding deployments in the domain, or just those to
a particular broker.

* When canceling deployment across the domain, you must have full access on
the Configuration Manager.

* When canceling deployment to a specific broker, you must have full access on
that broker.

If you want to ensure that previous deployment messages are not processed when
an affected broker is restarted, first remove any deployment messages:

1. Stop the broker

2. Check the broker’s SYSTEM.BROKER.ADMIN.QUEUE and
SYSTEM.BROKER.EXECUTIONGROUP.QUEUE, and manually remove any
deployment messages.

3. Proceed to cancel the deployment.

There are three ways to cancel a deployment:

* |Using the Message Brokers Toolkit]

. ‘Using the mgsideploy command

+ [Using the Configuration Manager Proxy AP]|
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Using the Message Brokers Toolkit

Follow these steps to cancel the deployment to a particular broker or all
outstanding deployments in a domain, using the workbench:

1. Switch to the Broker Administration perspective.

2. In the Domains view, right-click either a particular broker ora connected
domain.

3. Click Cancel Deployment.
Deployments to the broker or domain are canceled.

Next:

Continue by |checking the results (The Configuration Manager responds with a
BIP0892I information message in the event log as for other deployment requests.)

Using the mqgsideploy command

Follow these steps to cancel a deployment using the command:

1. Open a command window that is configured for your environment.

2. Using these as examples, enter the appropriate command, typed on a single
line:
On z/0S:
/f MQO1CMGR,dp t=yes b=B1
This cancels deployment to the broker called B1. Omit the b argument to cancel
all outstanding deployments in the domain.
On other platforms:
mgsideploy -i ipAddress -p port -q gmgr —c —b Bl
This cancels deployment to the broker called Bl. Omit the -b parameter to
cancel all outstanding deployments in the domain. The -i (IP address), -p (port),
and -q (queue manager) parameters represent the connection details of the
queue manager workstation, and on the z/OS console, MQO1CMGR is the
name of the Configuration Manager component.

Next:

Continue by [checking the resultg (The Configuration Manager responds with a
BIP0892I information message in the event log as for other deployment requests.)

Using the Configuration Manager Proxy API

To cancel all outstanding deployments in a domain, use the cancelDeployment
method of the ConfigManagerProxy class. For example:

public class CancelAl1Deploys {
public static void main(String[] args) {
ConfigManagerConnectionParameters cmcp =
new MQConfigManagerConnectionParameters
("Tocalhost", 1414, "QM1");
try {
ConfigManagerProxy cmp =
ConfigManagerProxy.getInstance(cmcp);
cmp.cancelDeployment () ;

catch (ConfigManagerProxyException e)
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e.printStackTrace();
}
}
}

To cancel deployment to a specific broker in a domain, use the cancelDeployment
method of the BrokerProxy class. For example, to cancel deployment to a broker
called BI:

import com.ibm.broker.config.proxy.x*;

public class CancelDeploy {
public static void main(String[] args) {
ConfigManagerConnectionParameters cmcp =
new MQConfigManagerConnectionParameters
("localhost", 1414, "QM1");
try {
ConfigManagerProxy cmp =
ConfigManagerProxy.getInstance(cmcp);
TopologyProxy t = cmp.getTopology();
BrokerProxy b = t.getBrokerByName("B1");
b.cancelDeployment();
1
catch (ConfigManagerProxyException e)
e.printStackTrace();
1
}
1

Next:

Continue by [checking the results (The Configuration Manager responds with a
BIP0892I information message in the event log as for other deployment requests.)

Renaming objects that are deployed to execution groups

You cannot rename an object while it is still deployed to an execution group.
Instead, first fremove the deployed object from the execution group} Then, having

renamed it, |degloz it againl

Removing a deployed object from an execution group

There are three ways of removing deployed objects from an execution group:
« |Using the Message Brokers Toolkit]

* |Using the mgsideploy command]

+ |Using the Configuration Manager Proxy API|

Using the Message Brokers Toolkit

Follow these steps to remove an object from an execution group using the
workbench:

1. Switch to the Broker Administration perspective.
2. From the Domains view, right-click the object that you want to remove.

3. Click Remove from the pop-up menu, and OK to confirm.
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An automatic deployment is performed for the updated broker and a BIP08921
information message is produced, confirming that the request was received by the
Configuration Manager.

Using the mqgsideploy command

Follow these steps to remove an object from an execution group using the
mgsideploy| command:

1. Open a command window that is configured for your environment.

2. Using these as examples, enter the appropriate command, typed on a single
line:
On z/0S:
/f MQOICMGR,dp t=yes b=broker e=execgp d=filel.cmf:file2.dictionary:file3.xml
On other platforms:
mgsideploy -i ipAddress -p port -q gmgr —b broker —e execgp

—d filel.cmf:file2.dictionary:file3.xml

Optionally, specify the -m option to clear the contents of the execution group.
This tells the execution group to completely clear any existing data before the
new bar file is deployed. The -i (IP address), -p (port), and -q (queue manager)
parameters represent the connection details of the queue manager workstation,
and on the z/OS console, MQO1ICMGR is the name of the Configuration
Manager component.

The -d argument (or d= argument on z/0S) is a colon separated list of files to be
removed from the named execution group. Invoking the command above causes

the deployed objects (filel.cmf, file2.dictionary and file3.xml) to be removed from
the specified execution group and broker.

The command displays feedback as responses are received from the Configuration
Manager and any brokers affected by the deployment. If the command completes
successfully, it returns 0.

Using the Configuration Manager Proxy API

One way of removing deployed objects using the Configuration Manager Proxy
API is to get a handle to the relevant ExecutionGroupProxy object and then invoke
its deleteDeployedObjectsByName() method. For example:

import com.ibm.broker.config.proxy.=*;

public class DeleteDeployedObjects {
public static void main(String[] args) {
ConfigManagerConnectionParameters cmcp =
new MQConfigManagerConnectionParameters
("Tocalhost", 1414, "QM1");
try {
ConfigManagerProxy cmp =
ConfigManagerProxy.getInstance(cmecp);
TopologyProxy t = cmp.getTopology();
BrokerProxy b = t.getBrokerByName("brokerl");
ExecutionGroupProxy e =
b.getExecutionGroupByName ("default");
e.deleteDeployedObjectsByName (
new String[] { "filel.cmf",
"file2.dictionary",
"file3.xm1" }, 0);

catch (ConfigManagerProxyException e)
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e.printStackTrace();

}
}
}
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Part 3. Exploiting user-defined extensions

User-definednodes . . . . . . . . . . .97

Installing a user-defined node on a broker
domain . . . . . . . . . . . . . . .9

Deleting a user-defined node . . . . . . . 101
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User-defined nodes

A user-defined node is a component that has been designed and implemented by
WebSphere Message Broker users or by third-party vendors to add to the function
of your implementation of WebSphere Event Broker.

With WebSphere Event Broker, you can deploy the following types of user-defined
extensions:

* User-defined input nodes
¢ User-defined message processing nodes
* User-defined output nodes

User-defined nodes can be used in conjunction with the nodes that are supplied
with the product, and with third-party supplied nodes. They can interact with the
other nodes in the message flow, and can have characteristics such as rollback,
commit, accessing external databases, and accessing WebSphere MQ queues.

You can configure the terminals and properties on your user-defined nodes,
according to your system setup. However, you cannot change any of the internals
of a user-defined node.

User-defined nodes can be written in the C or Java programming language.
User-defined nodes written in C are compiled into a loadable implementation
library, that is, a shared library on Linux and UNIX, or a Windows DLL.
User-defined nodes written in Java are packaged as a jar file.

For information on deploying or deleting user-defined nodes, see the relevant
topics in this section of the help.
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Installing a user-defined node on a broker domain

Before you start

User-defined nodes can be created by using WebSphere Message Broker C or Java
plug-in interface. They can also be supplied as support pacs or from third-party
vendors.

You must put a copy of your user-defined node file on every broker system from
which you intend to use it. You can save the user-defined node in a directory of
your choice. You must specify this directory by using the mqsichangebroker or
mgsicreatebroker command. If you do not specify a directory, the default location
is used, as shown in the following tables.

For C user-defined nodes, store a copy of the .lil file, and it is recommended that
you also store the .pdb file corresponding to the .lil file, in the following directory:

Platform Location
WBIMB_install_dir\bin
Windows
Linux install_dir/1il
install_dir /1il
UNIX
install_dir /1il
z/0OS

The .pdb file provides symbolic information that WebSphere Event Broker uses
when displaying stack diagnostic information in the event of access violations or
other software malfunctions. This is useful when debugging any problems with
your user-defined extensions and also of use to IBM service personnel.

For Java user-defined nodes, store a copy of the jar file in the following directory:

Platform Location
WBIMB_install_dir\jplugin

Windows

Linux install_dir /1il
install_dir /jplugin

UNIX PuE
install_dir/1il

z/0S

These directories are created during installation of WebSphere Event Broker.

You must stop and restart each broker so that it can detect the existence of the new
file.

On z/0S, also update the LILPATH variable in the mgsicompcif file with the name

of the library containing the new .lil files, otherwise the LILPATH value will be
reset next time you recustomize. The .1il file may require other executables, such as
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.dll files. These are loaded from the directory specified in the LIBPATH variable. If
the LIBPATH value needs to be updated, you must change it in mgsicompcif and
recustomize.

When you have installed a node, it is referred to by its schema and name, just like
a message flow.

Put a copy of your user-defined node on every broker system from which you
intend to use it.

Specify the directory in which to put the file, by using either the mqgsichangebroker
command or the mgsicreatebroker command. Do not save the .lil or jar file in the
WebSphere Event Broker install directory.

For C user-defined nodes, it is recommended that the .pdb file, which corresponds
to the .lil file, is also stored in the chosen directory. The .pdb file provides symbolic
information that is used by WebSphere Event Broker when displaying stack
diagnostic information in the event of access violations or other software
malfunctions.



Deleting a user-defined node

On all types of system, you can remove a user-defined node file from the broker

by completing the following steps:

1. Stop the broker, using the mqsistop command.

2. Delete the .lil or jar file from the appropriate directory.

For C user-defined nodes, the files are located in the following directories:

Platform Location
install_dir\bin
Windows
Linux install_dir /1il
install_dir/1il
UNIX
install_dir /1il
z/0S

For Java user-defined nodes, the files are located in the following directories:

Platform Location
install_dir\jplugin
Windows
Linux install_dir /jplugin
install_dir /jplugin
UNIX
install_dir/1il
z/0OS

3. Restart the broker using the mgsistart command.
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Message flows

Message flow reference information is available for:

« [“Message flow preferences’]

* |“Description properties for a message ﬂow”l

* [“Built-in nodes” on page 107

« [“User-defined nodes” on page 160|

« [“Supported code pages” on page 161|

+ [“Data integrity within message flows” on page 189

* [“Configurable message flow properties” on page 189|

* [“Message flow porting considerations” on page 190|

* ["Message flow accounting and statistics data” on page 191|

Message flow preferences

You can set Message flow preferences from Window - Preferences then click

Message Flow in the left pane.

Property

Type

Meaning

Default version
tag

String

flow Version property when you create a new message flow.

Provide the default version information you would like to be set in the message

Description properties for a message flow

Property Type Meaning

Version String You can enter a version for the message flow in this field. This allows the
version of the message flow to be displayed using the Eclipse properties view.
A default for this field can be set in the messages flow preferences.

Short String You can enter a short description of the message flow in this field.

Description

Long String You can add information to enhance the understanding of the message flow’s

Description function in this field.

It is a string field and any standard alphanumeric characters can be used.

You can also use this field to define a keyword and its value that will display for
the deployed message flow in the properties view of Eclipse. An example is:

$MQSI Author=Fred MQSI$

When the properties of the deployed message flow are displayed, this will add a
row to the display showing “Author” as the property name and “Fred” as its
value.

For information on keywords see [“Guidance for defining keywords” on page]
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This topic contains the rules to follow when defining keywords. Keywords and
their values are displayed in the properties view of a deployed object.

A number of objects in WebSphere Event Broker can have additional information
added to the object. This information can display information about an object after
the object has been deployed. The default information that is displayed is the time
the object was deployed and the last time the object was modified. Version
information can be specifically set using the Version property for message sets and
message flows.

You can define custom keywords and their values that the Configuration Manager
will interpret as additional information to be displayed in the properties view. For
example, you can define keywords for “Author” and “Subflow 1 Version”:

$MQSI Author=John Smith MQSI$
$MQSI Subflow 1 Version=v1.3.2 MQSI$

The information the Configuration Manager shows is:

Object name

Deployment Time 28-Aug-2004 15:04

Modification Time 28-Aug-2004 14:27

Version v1.0

Author John Smith

Subflow 1 Version v1.3.2

In this display the version information has also been defined using the Version
property of the object. If the version information had not been defined using the
property, it would be omitted from this display.

The syntax for defining a keyword and its associated value is:
$MQSI KeywordName = KeywordValue MQSI$

Where:

$MQSI
$MQSI opens the definition. It can be followed by an optional underscore
or white space character that is ignored.

KeywordName
The name of the keyword that you are setting the value for. It can be made
up of any sequence of alphanumeric characters apart from the equals (=)
sign. It can contain white space characters, but any leading or trailing
white space characters will be omitted.

= The equals (=) sign is the delimiter between the keyword and the value
that you are setting it to.

KeywordValue
The value that the keyword will be set to. It can be made up of any
sequence of alphanumeric characters. It can contain white space characters,
but any leading or trailing white space characters will be omitted.

MQSI$
MQSI$ closes the keyword definition.



Examples

Example definitions

Interpreted keyword and value

Comments

$MQSIAuthor=JohnMQSI$ or
$MQSI Author=John MQSI$ or
$MQSI Author = John MQSI$

Keyword = "Author”
Value = "John”

Each of these is a basic example of
what can be set and shows that the
leading and trailing white space
characters for the name and value
parameters is ignored.

$MQSI_Author = John MQSI$

Keyword = "Author”
Value = "John”

The first character after $MQSI can
be an underscore character. The
underscore character is omitted in the
interpreted keyword. If a second
underscore character appears, this
will form part of the keyword name.

$MQSI Flow designer = John Smith
MQSI$

d

Keyword = "Flow designer’
Value = "John Smith”

White space characters are accepted
for each parameter value.

$MQSI bar = MQSI$

Keyword = "bar”
Value = ""

The keyword value can be set to an
empty (") string.

$MQSI_mgsitag=$MQSI$MQSI$

Keyword = "mgsitag”
Value = "$"

This is a poorly formatted definition.
After defining the keyword name the
parser is looking to find the
delimiters that form the boundary of
the value to be set. In this case the
only character prior to the MQSI$
that closes the definition is a '$” and
that is set as the keyword value.

$MQSI=barMQSI$

This pattern is ignored because the
keyword name cannot be an empty
string.

$MQSItagbarMQSI$

This pattern is ignored because there
is not a separator (=) between the
keyword name and the keyword
value.

Built-in nodes

WebSphere Event Broker supplies built-in nodes that you can use to define your
message flows. For information about each of these nodes, follow the appropriate
link below. The nodes listed here are grouped according to the function that they

provide.

Input and output

. ”Mg )Input node” on page 134|
* IMQOptimizedFlow node

e "MQOutput node” on page 141
e |“Publication node” on page 148
“MQelnput node” on page 124

“SCADAInput node” on page 15

* |“SCADAOutput node” on page 15

“Real-timelnput node” on page 150]

“Real-timeOptimizedFlow node” on page 152]

“Input node” on page 108

“Qutput node” on page 146|
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* |["JMSInput node” on page 109|
* ["JMSOutput node” on page 118§

Message manipulation and transformation
* |”IMSMQTransform node” on page 117
* "MQJMSTransform node” on page 141

Input node

This topic contains the following sections:
. ”Purpose”|

* [“Configuring the Input node” on page 109|
* [“Terminals and properties” on page 109|

Purpose

The Input node provides an in terminal for an embedded message flow (a
subflow). You can use a subflow for a common task that can be represented by a
sequence of message flow nodes. For example, you can create a subflow to
increment or decrement a loop counter, or to provide error processing that is
common to a number of message flows.

You must use an Input node to provide the in terminal to a subflow; you cannot
use a standard input node (a built-in input node such as MQInput, or a
user-defined input node).

When you have started your subflow with an Input node, you can connect it to
any in terminal on any message flow node, including an Output node.

You can include one or more Input nodes in a subflow. Each one that you include
provides a terminal through which you can introduce messages to the subflow. If
you include more than one, the order in which the messages are processed through
the subflow cannot be predicted.

The Input node is represented in the workbench by the following icon:

P

When you select and include a subflow in a message flow, it is represented by the
icon:

| |

When you include the subflow in a message flow, this icon exhibits a terminal for
each Input node that you include in the subflow, and the name of the terminal
(which you can see when you hover over it) matches the name of that instance of
the Input node. Give your Input nodes meaningful names that you can easily

recognize when you use their corresponding terminal on the subflow node in your
message flow.
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Configuring the Input node

When you have put an instance of the Input node into a message flow, you can
configure it by giving it a name.

Right-click the node in the editor view and select Properties. The Description
properties of the node are displayed.

Enter a short description, a long description, or both.

Click Apply to make the changes to the Input node without closing the properties
dialog, or click OK to apply the changes and close the properties dialog.

Click Cancel to close the dialog and discard all the changes that you have made to
the properties.

Terminals and properties

The Input node terminals are described in the following table.

Terminal Description

Out The input terminal that delivers a message to the subflow.
The following table describes the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).
The Input node Description properties are described in the following table.

Property M C Default Description

Short Description No No A brief description of the node.

Long Description No No Text that describes the purpose of the node in the

message flow.

JMSInput node

This topic contains the following sections:
. ”Purpose”|

+ [“Using the JMSInput node in a message flow” on page 110|

» ["“Making the JMS Provider client available to the JMS Nodes” on page 110|
* [“Configuring the JMSInput node” on page 110|

¢ [“Terminals and properties” on page 116

Purpose

Use the JMSInput node to receive messages from JMS destinations. JMS
destinations are accessed through a connection to a JMS provider. The JMSInput
node acts as a J]MS message consumer and can receive all six message types that
are defined in the [Java Message Service Specification, version 1.1] Messages are
received by using method calls, which are described in the JMS specification.

The JMSInput node is represented in the workbench by the following icon:
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Using the JMSInput node in a message flow

The JMS Nodes|sample contains a message flow in which the JMSInput node is

used. Refer to this sample for an example of how to use the JMSInput node.

Message flows, which handle messages that are received from connections to JMS
providers, must always start with a JMSInput node. If you include an output node
in a message flow that starts with an JMSInput node, it can be any of the
supported output nodes (including user-defined output nodes); you do not have to
include an JMSOutput node. However, if you do not include a JMSOutput node,
you must include the JMSMQTransform node to transform the message to the
format that is expected by the output node.

If you are propagating JMS messages and creating a message flow to use as a
subflow, you cannot use a standard input node; you must use an instance of the
JMSInput node as the first node in order to create an In terminal for the subflow.

Restriction: There is currently a restriction when using the J]MSInput node to
receive publication topics. The node internally restricts the message
flow property Additional Instances to zero to prevent the receipt of
duplicate publications.

Making the JMS Provider client available to the JMS Nodes

For distributed platforms, copy the java .jar files and any native libraries for the
JMS provider client into a the broker shared-classes directory. For example, on
Windows C:\Documents and Settings\A11 Users\Application
Data\IBM\MQSI\shared-classes. This ensures that the java class path for the J]MS
nodes is set correctly.

For z/0S, there is no shared-classes directory. Instead you must specify each JMS
provider java jar file in the class path in the BIPPROF member of the broker’s PDS
(Partitioned Data Set). Then update the LIBPATH with any native libraries, and
submit the BIPGEN JCL job to update the broker ENVFILE.

Configuring the JMSInput node

When you have put an instance of the JMSInput node into a message flow, you
can configure it. Right-click the node in the editor view and click Properties. The
basic properties of the node are displayed in the properties dialog.

All mandatory properties that do not have a default value defined are marked
with an asterisk on the properties dialog.

Configure the JMSInput node as follows:
1. Select Basic in the properties dialog navigator and complete the following
properties:

* Enter an Initial Context Factory value. A JMS application uses the initial
context to obtain and look up the JNDI administered objects for the JMS
provider. The default value is

com.sun.jndi.fscontext.RefFSContextFactory, which defines the file-based
initial context factory for the WebSphere MQ JMS provider.
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To identify the name of the Initial Context Factory for the JMS provider, refer
to the JMS provider documentation.

Enter a value for the Location [NDI Bindings. This value specifies either the
file system path or the LDAP location for the bindings file. The bindings file
contains definitions for the JNDI administered objects that are used by the
JMSInput node.

When you enter a value for Location [NDI Bindings, ensure that it is
compliant with the following instructions:

— Construct the bindings file before you deploy a message flow that
contains a JMSInput node.

— Do not include the filename of the bindings file in this field.

— If you have specified an LDAP location that requires authentication, you
must configure separately both the LDAP principal (userid) and LDAP
credentials (password). These values are configured at broker level. For
information on configuring these values, refer to the mqsicreatebroker and
mgsichangebroker commands.

— The string value should include the leading keyword, which is one of the
following: file:/ , iiop:/, or 1dap:/.

For information about constructing the JNDI administered objects bindings

file, refer to the documentation that is supplied with the JMS provider.

Enter a Connection Factory Name. The connection factory name is used by the
JMSInput node to create a connection to the JMS provider. This name must
already exist in the bindings file.

Enter a Backout Destination name. Input messages are sent to this destination
when errors prevent the message flow from processing the message, and the
message must be removed from the input destination. The backout
destination name must exist in the bindings file.

Enter a value for the Backout Threshold. This value determines when an input
message is put to the Backout Destination. For example, if the value is 3, the
JMS provider attempts to deliver the message to the input destination three
times. After the third attempted delivery, the message is removed from the
input destination and is sent to the backout destination. The default value is
0.

2. Select Default in the properties dialog navigator and set values for the
properties that describe the message domain, message set, message type, and
message format.

If you are using the MRM or IDOC parser, select the correct message set
from the drop-down list in Message Set. This list is populated with available
message sets when you select MRM or IDOC as the domain.

Leave Message Set blank for XML, XMLNS, JMS,, and BLOB parsers.

If you are using the MRM parser, select the correct message from the
drop-down list in Message Type. This list is populated with messages that are
defined in the message set that you have selected..

Leave Message Type blank for XML, XMLNS, JMS,, BLOB, and parsers.

If you are using the MRM or IDOC parser, select the format of the message
from the drop-down list in Message Format. This list includes all the physical
formats that you have defined for this message set.

Leave Message Format blank for XML, XMLNS, JMSMap, JMSStream, , and
BLOB parsers.

3. If the JMSInput node is to be used to subscribe to a topic, select Pub/Sub in the
properties dialog navigator.
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* Enter the name of the Subscription Topic.

— If this property is configured, the node operates in the publish/subscribe
message domain only.

— This property is mutually exclusive with Source Queue in the Point to Point
properties section.

— The Subscription Topic name must conform to the standards of the J]MS
provider that is being used by the node.
* If the node is to receive publications from a durable subscription topic, enter
a Durable Subscription ID.

— Removing a durable subscription is a separate administration task. For
information on removing a durable subscription, refer to the JMS provider
documentation.

— This property is valid only when a Subscription Topic string has been
specified.

. If the JMSInput node is to be used to receive point to point messages, select

Point to Point in the properties dialog navigator.

 Enter the Source Queue name, where the Source Queue is the JMS queue that is
listed in the bindings file.

. If filtering of messages is required, select Message Selectors in the properties

dialog navigator.

e If the JMS provider is required to filter messages based on message
properties that are set by the originating JMS client application, enter a value
for Application Property, specifying both the property name and the selection
conditions; for example, OrderValue > 200.

Leave this property blank if you do not want the input node to select based
upon application property. Refer to [MS message selectors| for a description
of how to construct the message selector.

e If the JMS provider is required to filter messages that have been generated at
specific times, enter a value for Timestamp, where the value is an unqualified
Java millisecond time; for example, 105757642321. Qualify the selector with
operators such as BETWEEN or AND.

Leave this property blank if you do not want the input node to select based
on JMSTimeStamp.

e If the JMS provider is required to filter messages based on the
JMSDeliveryMode header value in the J]MS messages, select an option for
Delivery Mode from the drop-down list. You can choose from:

— Non Persistent to receive messages marked as non persistent by the
originating JMS client application.

— Persistent to receive messages marked as persistent by the originating JMS
client application.

Leave this property blank if you do not want the input node to select based
on JMSDeliveryMode.

e If the JMS provider is required to filter messages based upon the JMSPriority
header value in the JMS message, enter a value forPriority.

Valid values for message priority are from 0 (lowest) to 9 (highest). For
example, you can enter 5 to receive messages of priority 5. You can also
qualify the selector; for example > 4 to receive messages with a priority
greater than 4, or BETWEEN 4 AND 8 to receive messages with a priority in the
range 4 to 8.

Leave this property blank if you do not want the input node to select based
on JMSPriority.



¢ If the JMS provider is required to filter messages based upon the
JMSMessagelD header, enter a value for Message ID.

Enter a specific Message ID, or enter a conditional selector; for example,
enter> WMBRK123456 to return messages where the Message ID is greater than
the WMBRK123456.

Leave this property blank if you do not want the input node to make a
selection based on JMSMessagelD.

¢ If the JMS provider is required to filter messages based upon the
JMSRedelivered header, enter a value for Redelivered.

Enter FALSE if the input node accepts only messages that have not been
redelivered by the JMS Provider.

Enter TRUE if the input node accepts only messages that have been
redelivered by the JMS Provider.

Leave this property blank if you do not want the input node to select based
on JMSRedelivered.

e If the JMS provider is required to filter messages based upon the
JMSCorrelationID header, enter a value for Correlation ID.

Enter a specific Correlation ID or enter a conditional string; for example,
WMBRKABCDEFG returns messages whose Correlation ID matches this value.

Leave this property blank if you do not want the input node to select based
on JMSCorrelationID.

6. Select Advanced in the properties dialog navigator.

* To define the transactional characteristics of how the message is handled,
select from the Transaction Mode drop-down list. You can choose one of the
following options:

— Select none if the incoming message is to be treated as non persistent. In
this case the message will be received using a non transacted JMS Session
that is created using the Session.AUTO_ACKNOWLEDGE flag.

— Select local if the J]MSInput node should coordinate the commit or roll back
of JMS messages received by the node, along with any other resources
such as DB2 or WebSphere MQ that perform work within the message
flow. In this case the node will use a transacted JMS Session.

— Select global if the JMSInput node should participate in a global message
flow transaction that will be managed by the broker’s external syncpoint
coordinator. The syncpoint coordinator is the broker’s Queue Manager on
distributed platforms and RRS (Resource Recovery Services) on z/0OS. In
this case, any messages received by the node will be globally coordinated
using an XA JMS Session.

7. Select XMLNSC Parser Options in the properties dialog navigator.

If you want to Use XMLNSC Compact Parser for XMLNS Domain select the check
box.

For Mixed Content Retain Mode, Comments Retain Mode, and Processing
Instructions Retain Mode , the drop-down boxes offer the following choices:

* None
o« All

8. Select Description in the properties dialog navigator to enter a short description,
a long description, or both.

9. Click Apply to make the changes to the JMSInput node without closing the
properties dialog. Click OK to apply the changes and close the properties
dialog.
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Click Cancel to close the dialog and discard all the changes that you have
made to the properties.

Connecting the terminals:

For each message that is received successfully, the JMSInput node routes the
message to the out terminal. If this fails, the message is retried. If the retry
threshold is reached, where the threshold is defined by the BackoutThreshold
attribute of the node, the message is routed to the failure terminal.

You can connect nodes to the failure terminal to handle this condition. If you have
not connected nodes to the failure terminal, the message is written to the backout
destination. If a backout destination has not been provided, an error message is
issued and the node stops processing further input. The error message is bip4669.

If the message is caught by the JMSInput node after an exception has been thrown
elsewhere in the message flow, the message is routed to the catch terminal. If you
have not connected nodes to the catch terminal, the node will backout message for
re-delivery until the problem is resolved or the backout threshold is reached.

You must define a backout destination. If you do not define a backout destination,
the node issues a bip4669 error message and stops processing further input.

Configuring for coordinated transactions:

When you include a JMSInput node in a message flow, the value that you set for
Transaction Mode defines whether messages are received under syncpoint.

 If you set it to global, the message is received under external syncpoint
coordination, that is, within a WebSphere MQ unit of work. Any messages
subsequently sent by an output node in the same instance of the message flow
are put under syncpoint, unless the output node has explicitly overridden this.

 If you set it to Tocal, the message is received under the local syncpoint control
of the JMSInput node. Any messages subsequently sent by an output node in
the flow are not put under local syncpoint, unless an individual output node has
specified that the message must be put under local syncpoint.

 If you set it to none, the message is not received under syncpoint. Any messages
subsequently sent by an output node in the flow are not put under syncpoint,
unless an individual output node has specified that the message must be put
under syncpoint.

The JMS provider can supply additional jar files that are required for transactional
support. Refer to the JMS provider documentation. For instance, on Distributed
(non z/0S) platforms, the WebSphere MQ JMS provider supplies an extra jar file
com.ibm,mgetclient.jar. This jar must also be added to the broker shared_classes
directory. Refer to [Making the JMS Provider client available to the J]MS Nodes|in
this topic.

When messages are to be received under external syncpoint, additional

configuration steps are required. These steps need only be applied the first time

that a JMSOutput or JMSInput is deployed to the Broker for a particular JMS

provider:

¢ On distributed platforms, the external syncpoint coordinator for the broker is
WebSphere MQ. Before you deploy a message flow where the Transaction
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Coordination is set to Yes, modify the queue manager .ini file to include extra
definitions for each JMS provider Resource Manager that participates in globally
coordinated transactions.

— On Windows, values are configured under the WebSphere MQ Services
Resource properties tab. Refer to the WebSphere MQ System Administration
Guide for more information.

Set the SwitchFile property to the following value:

<Broker Installation Path>/bin/ JMSSwitch.d11
XAOpenString=<Initial Context >,<location JNDI>, <Optional>
ThreadOfControl=THREAD

— On distributed platforms (not Windows) add a Stanza to the queue manager
“ini” file for each JMS provider. Refer to the WebSphere MQ System
Administration Guide for more information.

For example,

XAResourceManager:

Name=<Jms_Provider_Name>

SwitchFile=/<Broker Installation Path>/bin/ JMSSwitch.so
XAOpenString=<Initial Context >,<location JNDI>, <Optional>
ThreadOfControl=THREAD

Where

name is an installation defined name that identifies a JMS provider Resource

Manager.

SwitchFile is the file system path to the J]MSSwitch library that is supplied in

the bin directory of the broker.

The values for XAOpenString are as follows:

- Initial Context is the value that is set in the JMSInput node basic property
Initial Context Factory.

- location [NDI is the value that is set in the JMSInput node basic property
Location of [NDI. This value should include the leading keyword file:/,
iiop:/ or 1dap:/

The following parameters are optional:

- LDAP Principal which matches the value that is set for the broker by using
the mgsicreatebroker or mgsichangebroker commands.

- LDAP Credentials which matches the value that is set for the broker by
using the mgsicreatebroker or mqgsichangebroker commands.

- Recovery Connection Factory Name which is the JNDI administered
connection factory that is defined in the bindings file. If a value is not
specified, a default value for recoverXAQCF must be added to the bindings
file. In either case, the Recovery Connection Factory should be defined as
an XA Queue Connection Factory for the JMS provider that is associated
with the Initial Context Factor

The optional parameters are comma separated and are positional. Therefore,

any parameters that are missing must be represented by a comma.
1. Update the Java CLASSPATH environment variable for the broker’s Queue
Manager to include a reference to xarecovery.jar. For example,
<Broker Installation Path>/classes/xarecovery.jar

2. Update the Java PATH environment variable for the broker’s Queue
Manager to point to the bin directory, which is where the Switch File is
located. For example,
<Broker Installation Path>/bin
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XA cannot use the same Queue Manager for both the broker and the provider
until WebSphere MQ Version 5.3, CSD12 and WebSphere MQ Version 6
FixPack 1.

— On z/0S, the external syncpoint manager is Resource Recovery Services
(RRS). The only JMS provider that is supported on z/OS is WebSphere MQ
JMS. The only Transport option that is supported for WebSphere MQ JMS on
z/0S is the Bind option.

Syncpoint control for the J]MS provider is managed with RRS syncpoint
coordination of the queue manager of the broker. You do not need to modify
the .ini file.

Terminals and properties

The terminals of the JMSInput node are described in the following table.

Terminal Description

Failure The output terminal to which the message is routed if an error occurs. Even if the
Validation property is set, messages propagated to this terminal are not validated.

Out The output terminal to which the message is routed if it is successfully retrieved from
the WebSphere MQ queue.

Catch The output terminal to which the message is routed if an exception is thrown
downstream and caught by this node.

The following tables describe the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).

The Basic properties of the JMSInput node are described in the following table.

Property M C Default Description

Initial Context Factory | Yes com.sun.jndi| Thisnisetkie. RefifthitgnieicttrmtarfNDI name space. A
JMS application uses the initial context to obtain and
look up the connection factory and queue or topic
objects for the JMS provider.

The default value is that which is used when
WebSphere MQ Java is used as the JMS provider.

Location JNDI Bindings | No The system path or the LDAP location for the bindings
file.

Connection Factory No The name of the connection factory that is used by the

Name JMSInput node to create a connection to the JMS
provider.

Backout Destination No The destination that is used by the JMSInput node

when a message cannot be processed by the message
flow because of errors in the message.

Backout Threshold No 0 The value that controls when a re-delivered message is
put to the backout destination.

The Advanced properties of the JMSInput node are described in the following
table.
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Property

M C Default Description

Transaction Mode

Yes No none This property is used to determine whether the
incoming message is received under external syncpoint,
local syncpoint, or out of syncpoint. Valid values are
none, local, and global.

The Description properties of the JMSInput node are described in the following
table.

Property M C Default Description

Short Description No No A brief description of the node.

Long Description No No Text that describes the purpose of the node in the
message flow.

JMSMQTransform node

This topic contains the following sections:
. ”Purpose”|

+ |[“Using the JMSMQTransform node in a message flow”|
* [“Terminals and properties”]

Purpose

Use the JMSMQTransform node to transform a message with a JMS message tree
into a message that has a message tree structure compatible with the format of
messages that are produced by the WebSphere MQ JMS provider.

The JMSMQTransform node can be used to send messages to legacy message flows
and to interoperate with WebSphere MQ JMS and WebSphere Event Broker publish

subscribe.

The JMSMQTransform node is represented in the workbench by the following icon:
L

Using the JMSMQTransform node in a message flow

The [MS Nodes|sample contains a message flow in which the JMSMQTransform
node is used. Refer to this sample for an example of how to use the
JMSMQTransform node.

Terminals and properties

The terminals of the JMSMQTransform node are described in the following table:

Terminal Description

Failure The output terminal to which the message is routed if an error occurs. Even if the
Validation property is set, messages propagated to this terminal are not validated.

Out The output terminal to which the message is routed if it is successfully retrieved from
the JMS destination.

In The input terminal that accepts a message for processing by the node.
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There are no configurable attributes for this node.

JMSOutput node
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This topic contains the following sections:
. ”Purpose"l

« [“Using the J]MSOuput node in a message flow”]

* [“Making the JMS Provider client available to the JMS Nodes”|
* [“Configuring the JMSOutput node” on page 119

* [“Terminals and properties” on page 123

Purpose

Use the JMSOutput node to send messages to JMS destinations. The JMSOutput
node acts as a JMS message producer and can publish all six message types that
are defined in the [Java Message Service Specification, version 1.1] Messages are
published by using method calls, which are described in the JMS specification.

The JMSOutput node is represented in the workbench by the following icon:

2

Using the JMSOuput node in a message flow

The [MS Nodes|sample contains a message flow in which the J]MSOutput node is
used. Refer to this sample for an example of how to use the JMSOutput node.

Message flows, which handle messages that are received from connections to JMS
providers, must always start with a JMSInput node. If you include the J]MSOutput
node in a message flow, you do not have to include an JMSInput node. However,
if you do not include a JMSInput node, you must include the MQJMSTransform
node to transform the message to the format that is expected by the J]MSOutput
node.

If you are propagating JMS messages and creating a message flow to use as a
subflow, you must use an instance of the JMSOutput node as the last node in order
to create an out terminal for the subflow.

Making the JMS Provider client available to the JMS Nodes

For distributed platforms, copy the java jar files and any native libraries for the
JMS provider client into a the broker shared-classes directory. For example, on
Windows C:\Documents and Settings\A11 Users\Application
Data\IBM\MQSI\shared-classes. This ensures that the java class path for the J]MS
nodes is set correctly.

For z/0S, there is no shared-classes directory. Instead you must specify each JMS
provider java jar file in the class path in the BIPPROF member of the broker’s PDS
(Partitioned Data Set). Then update the LIBPATH with any native libraries, and
submit the BIPGEN JCL job to update the broker ENVFILE.


http://java.sun.com/products/jms/docs.html
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Configuring the JMSOutput node

When you have put an instance of the J]MSOutput node into a message flow, you
can configure it. Right-click the node in the editor view and click Properties. The
node’s basic properties are displayed in the properties dialog.

All mandatory properties that do not have a default value defined are marked
with an asterisk on the properties dialog.

Configure the J]MSOutput node as follows:

1. Select Basic in the properties dialog navigator and complete the following
properties:
 Enter an Initial Context Factory value. A JMS application uses the initial
context to obtain and look up the JNDI administered objects for the J]MS
provider. The default value is

com.sun.jndi.fscontext.RefFSContextFactory, which defines the file-based
initial context factory for the WebSphere MQ JMS provider.

To identify the name of the Initial Context Factory for the J]MS provider, refer
to the JMS provider documentation.

 Enter a value for the Location [NDI Bindings. This value specifies either the
file system path or the LDAP location for the bindings file. The bindings file
contains definitions for the JNDI administered objects that are used by the

JMSInput node.

When you enter a value for Location JNDI Bindings, ensure that it is

compliant with the following instructions:

— Construct the bindings file before you deploy a message flow that
contains a JMSInput node.

— Do not include the filename of the bindings file in this field.

— If you have specified an LDAP location that requires authentication, you
must configure separately both the LDAP principal (userid) and LDAP
credentials (password). These values are configured at broker level. For
information on configuring these values, refer to the mqsicreatebroker and
mgsichangebroker commands.

— The string value should include the leading keyword, which is one of the
following: file:/ , iiop:/, or 1dap:/.

For information about constructing the JNDI administered objects bindings

file, refer to the documentation that is supplied with the JMS provider.

* Enter a Connection Factory Name. The connection factory name is used by the
JMSInput node to create a connection to the JMS provider. This name must
already exist in the bindings file.

2. If the J]MSOuput node is to be used to subscribe to a topic, select Pub/Sub in the
properties dialog navigator.

* Enter the name of the Publisher Topic.

— If this property is configured, the node operates only in the
publish/subscribe message domain.

— This property is mutually exclusive with Destination Queue in the Point to
Point properties section.

— The Publisher Topic name must conform to the standards of the JMS
provider that is being used by the node.

3. If the JMSOutput node is to be used to receive point to point messages then
select Point to Point in the properties dialog navigator.
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 Enter the Destination Queue name for the JMS queue name that is listed in the

bindings file.

4. Select Request in the properties dialog navigator and complete the following
properties:

* Select an option from the Destination Mode drop-down list.

— The default value is Destination Name. It this is selected, the message is
treated as a request of a datagram and it targets either the Publication Topic
or the Destination Queue .

— If the message is to be treated as a reply, select Reply Destination Name.
The JMS provider is supplied with the JMSReplyTo value from the
JMSTransport_Header_values section of the message tree.

* Enter a value for Reply To Destination. You can enter a JMS destination, which

can be either a subscription queue or a destination topic. The Reply To
Destination is the name of the JMS destination to which the receiving
application should send a reply message. For a reply message to be returned
to this JMS destination, the JMS destination name must be known to the
domain of the JMS provider that is used by the receiving client.

The default value is blank, in which case the JMS output message can be
regarded as a datagram. If the field is blank, the JMSOutput node does not
expect a reply from the receiving JMS client.

5. Select Advanced in the properties dialog navigator.
* If a New Correlation ID is required, select the check box.

* To define the transactional characteristics of how the message is handled,

select from the Transaction Mode drop-down list. You can choose one of the
following options:

— Select none if the outgoing message is to be treated as non persistent. In
this case the message will be sent using a non transacted JMS Session that
is created using the Session.AUTO_ACKNOWLEDGE flag.

— Select local if the Input node that received the message should coordinate
the commit or roll back of J]MS messages that have been sent by the
JMSOutput node, along with any other resources such as DB2 or
WebSphere MQ that perform work within the message flow. In this case
the node will use a transacted JMS Session.

— Select global if the JMSOutput node should participate in a global message
flow transaction that will be managed by the broker’s external syncpoint
coordinator. The syncpoint coordinator is the broker’s Queue Manager on
distributed platforms and RRS (Resource Recovery Services) on z/OS. In
this case, any messages received by the node will be globally coordinated
using an XA JMS Session.

You can set the persistence of the outgoing JMS message by using the
Delivery Mode property. Select and option from the drop-down list. You can
choose from:

— Non Persistent to indicate to the JMS provider that the message should be
treated as non persistent.

— Persistent to mark messages as persistent to the JMS provider and that
they should be preserved until successfully delivered to a receiving JMS
client application.

Enter a value for Message Expiration to request that the J]MS provider keeps

the output JMS message for a specified time.

Enter a value in milliseconds to specify how long the message will be kept

by the JMS provider. The default value 0 is used to indicate that the message
should not expire.



* To assign a relative importance to the message, select an option from the
Message Priority drop-down list. This value can be used for message selection
by a receiving JMS client application or a JMSOutput node.

Enter a value, where valid values for message priority are from 0 (lowest) to
9 (highest). The default value is 4, which indicates medium priority. Priorities
in the range 0 to 4 relate to normal delivery. Priorities in the range 5 to 9
relate to graduations of expedited delivery.

6. Select Validation in the properties dialog navigator to set the node properties
that relate to output message validation.

* Select an option from the Validate drop-down list. You can choose from:
- None
Content and Value

Content
Inherit

If you select Content and Value or Content,select aFailure Action from the
drop-down list. You can choose from:

— User Trace

Local Error Log

Exception (default value)

Exception List

For more details refer to [Validating messages| and [Validation properties for
[messages in the MRM domain|

7. Select Description in the properties dialog navigator to enter a short description,
a long description, or both.

8. Click Apply to make the changes to the JMSOutput node without closing the
properties dialog. Click OK to apply the changes and close the properties
dialog.

Click Cancel to close the dialog and discard all the changes that you have
made to the properties.

Connecting the terminals:

Connect the in terminal of the J]MSOutput node to the node from which outbound
messages are routed.

Connect the out terminal of this node to another node in the message flow if you
want to process the message further, to process errors, or to send the message to
an additional destination.

Configuring for coordinated transactions:

When you include a JMSOutput node in a message flow, the value that you set for
Transaction Mode defines whether messages are received under syncpoint.

* If you set it to global, the message is received under external syncpoint
coordination, that is, within a WebSphere MQ unit of work. Any messages
subsequently sent by an output node in the same instance of the message flow
are put under syncpoint, unless the output node has explicitly overridden this.

» If you set it to Tocal, the message is sent under the local syncpoint control of the
JMSOutput node. Any messages subsequently sent by an output node in the
flow are not put under local syncpoint, unless an individual output node has
specified that the message must be put under local syncpoint.
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* If you set it to none, the message is not sent under syncpoint. Any messages
subsequently sent by an output node in the flow are not put under syncpoint,
unless an individual output node has specified that the message must be put
under syncpoint.

The JMS provider can supply additional jar files that are required for transactional
support. Refer to the JMS provider documentation. For instance, on Distributed
(non z/0S) platforms, the WebSphere MQ JMS provider supplies an extra jar file
com.ibm,mgetclient.jar. This jar must also be added to the broker shared_classes
directory. Refer to|Making the JMS Provider client available to the JMS Nodes| in
this topic.

When messages are to be received under external syncpoint, additional
configuration steps are required. These steps need only be applied the first time
that a JMSOutput or JMSInput is deployed to the Broker for a particular J]MS
provider:

e On distributed platforms, the external syncpoint coordinator for the broker is
WebSphere MQ. Before you deploy a message flow where the Transaction
Coordination is set to Yes, modify the queue manager .ini file to include extra
definitions for each JMS provider Resource Manager that participates in globally
coordinated transactions.

— On Windows, values are configured under the WebSphere MQ Services
Resource properties tab. Refer to the WebSphere MQ System Administration
Guide for more information.

Set the SwitchFile property to the following value:

<Broker Installation Path>/bin/ JMSSwitch.d11
XAOpenString=<Initial Context >,<location JNDI>, <Optional>
ThreadO0fControl=THREAD

— On distributed platforms (not Windows) add a Stanza to the queue manager
“ini” file for each JMS provider. Refer to the WebSphere MQ System
Administration Guide for more information.

For example,

XAResourceManager:

Name=<Jms_Provider_Name>

SwitchFile=/<Broker Installation Path>/bin/ JMSSwitch.so
XAOpenString=<Initial Context >,<location JNDI>, <Optional>
ThreadOfControl=THREAD

Where

name is an installation defined name that identifies a JMS provider Resource

Manager.

SwitchFile is the file system path to the JMSSwitch library that is supplied in

the bin directory of the broker.

The values for XAOpenString are as follows:

- Initial Context is the value that is set in the JMSInput node basic property
Initial Context Factory.

- location INDI is the value that is set in the JMSInput node basic property
Location of [NDI. This value should include the leading keyword file:/,
iiop:/ or 1dap:/

The following parameters are optional:

- LDAP Principal which matches the value that is set for the broker by using
the mgsicreatebroker or mqgsichangebroker commands.

- LDAP Credentials which matches the value that is set for the broker by
using the mgsicreatebroker or mgsichangebroker commands.



- Recovery Connection Factory Name which is the JNDI administered
connection factory that is defined in the bindings file. If a value is not
specified, a default value for recoverXAQCF must be added to the bindings
file. In either case, the Recovery Connection Factory should be defined as
an XA Queue Connection Factory for the JMS provider that is associated
with the Initial Context Factory.

The optional parameters are comma separated and are positional. Therefore,

any parameters that are missing must be represented by a comma.

1. Update the Java CLASSPATH environment variable for the broker’s Queue
Manager to include a reference to xarecovery.jar. For example,
<Broker Installation Path>/classes/xarecovery.jar

2. Update the Java PATH environment variable for the broker’s Queue
Manager to point to the bin directory, which is where the Switch File is
located. For example,
<Broker Installation Path>/bin

XA cannot use the same Queue Manager for both the broker and the provider

until WebSphere MQ Version 5.3, CSD12 and WebSphere MQ Version 6
FixPack 1.

— On z/0S, the external syncpoint manager is Resource Recovery Services
(RRS). The only JMS provider that is supported on z/OS is WebSphere MQ
JMS. The only Transport option that is supported for WebSphere MQ JMS on
z/0S is the Bind option.

Syncpoint control for the JMS provider is managed with RRS syncpoint
coordination of the queue manager of the broker. You do not need to modify
the .ini file.

Terminals and properties

The terminals of the J]MSOutput node are described in the following table.

Terminal Description

Failure The output terminal to which the message is routed if an error occurs. Even if the
Validation property is set, messages propagated to this terminal are not validated.

Out The output terminal to which the message is routed if it is successfully retrieved from
the WebSphere MQ queue.

Catch The output terminal to which the message is routed if an exception is thrown

downstream and caught by this node.

The following tables describe the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).

The Basic properties of the JMSOutput node are described in the following table.
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Property

Default

Description

Initial Context Factory

Yes

com.sun.jndi

Thdisris ethie. Refiftitg et fmtarfNDI name space. A
JMS application uses the initial context to obtain and
look up the connection factory and queue or topic
objects for the JMS provider.

The default value is that which is used when
WebSphere MQ Java is used as the JMS provider.

Location JNDI Bindings

No

The system path or the LDAP location for the bindings
file.

Connection Factory
Name

The name of the connection factory that is used by the
JMSOutput node to create a connection to the JMS
provider.

The Advanced properties of the JMSOutput node are described in the following

table.

Property M C Default Description

New Correlation ID No This property is selected if a New Correlation ID is
required.

Transaction Mode Yes No Automatic This property is to determine whether the incoming
message is received under syncpoint. Valid values are
Automatic, Yes, and No.

Delivery Mode No Non Message selector that will filter messages according to

Persistent |the message delivery mode.

Message Expiration No 0 This property value is to request that the J]MS provider
keeps the output JMS message for a specified time.
Values are in milliseconds and the default value 0 is
used to indicate that the message should not expire.

Message Priority No 4 This property value assigns relative importance to the

message. This value can be used for message selection
by a receiving JMS client application or a JMSOutput
node.

The Description properties of the JMSOutput node are described in the following

table.
Property M C Default Description
Short Description No No A brief description of the node.
Long Description No No Text that describes the purpose of the node in the
message flow.

MQelnput node
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Attention: The use of flows containing MQelnput and MQeOutput nodes in
WebSphere Message Broker Version 6.0 is deprecated. The behavior described here
is intended only for when you are deploying from Version 6.0 to a previous
version, and to provide a route for migration. Redesign your flows to remove the
MQe nodes and replace them with MQ nodes configured to your own
specifications and coordinated with your MQe Gateway configuration. For more
details see [Migrating a flow containing WebSphere MQ Everyplace nodes|




This topic contains the following sections:
. ”Purpose”|

* [“Using the MQelnput node in a message flow” on page 126
* [“WebSphere MQ Everyplace documentation” on page 126|

* |“Configuring the MQelnput node” on page 126]

* [“Terminals and properties” on page 129

Purpose

Use the MQelnput node to receive messages from clients that connect to the broker
using the WebSphere MQ Mobile Transport protocol.

The MQelnput node receives messages put to a message flow from a specified
bridge queue on the broker’s WebSphere MQ Everyplace queue manager. The node
also establishes the processing environment for the messages. You must create and
configure the WebSphere MQ Everyplace queue manager before you deploy a
message flow containing this node.

Message flows that handle messages received across WebSphere MQ Everyplace
connections must always start with an MQelnput node. You can set the MQelnput
node’s properties to control the way that messages are received. For example, you
can indicate that a message is to be processed under transaction control.

When you deploy message flows containing WebSphere MQ Everyplace nodes to a
broker, you must deploy them to a single execution group, regardless of the
number of message flows. The WebSphere MQ Everyplace nodes in the flows must
all specify the same WebSphere MQ Everyplace queue manager name. You get an
error on deploy if you do not meet this restriction.

If you include an output node in a message flow that starts with an MQelnput
node, it can be any of the supported output nodes, including user-defined output
nodes; you do not have to include an MQeOutput node. You can create a message
flow that receives messages from WebSphere MQ Everyplace clients and generates
messages for clients that use any of the supported transports to connect to the
broker, because you can configure the message flow to request the broker to
provide any conversion that is necessary.

WebSphere MQ Everyplace Version 1.2.6 is used by WebSphere Event Broker. This
is compatible with later versions of WebSphere MQ Everyplace. Clients using later
versions of WebSphere MQ Everyplace, for example Version 2.0, work correctly
when connected to this node, although additional functionality not supported in
Version 1.2.6 (for example JMS support) does not work.

Queue managers are not interchangeable between different versions of WebSphere
MQ Everyplace. Nodes must use a queue manager created using Version 1.2.6.
Similarly, the client must use its level of the code when creating a queue manager.

You cannot use MQelnput nodes in message flows that you deploy to z/OS
systems.

If you create a message flow to use as a subflow, you cannot use a standard input
node: you must use an instance of the Input node as the first node to create an in

terminal for the subflow.

If your message flow does not receive messages across WebSphere MQ
connections, you can choose one of these other input nodes.
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The MQelnput node is represented in the workbench by the following icon:

B

Using the MQelnput node in a message flow

For an example of how this node can be used, consider a farmer who checks his
fields to see how well they are irrigated. He is carrying a PDA device with
WebSphere MQ Everyplace installed. He sees an area of field requiring water, so,
using his PDA and a Global Satellite Navigation link, he sends a message to an
MQelnput node. A message is published by a Publication node so that a remote
SCADA device can pick up the message and trigger the irrigation sprinklers. The
farmer can see the water delivered to the field minutes after sending his message.

WebSphere MQ Everyplace documentation

You can find further information about WebSphere MQ Everyplace, and the
properties of the node, in the WebSphere MQ Everyplace documentation on the
[WebSphere MQ Web pagel

Configuring the MQelnput node

When you have put an instance of the MQelnput node into a message flow, you
can configure it. Right-click the node in the editor view and click Properties. The
node’s default properties are displayed in the properties dialog.

All mandatory properties for which you must enter a value (those that do not have
a default value defined) are marked with an asterisk on the properties dialog.

Configure the MQelnput node as follows:

1. Select General in the properties dialog navigator and complete the following
properties:
a. Enter the Queue Name of the WebSphere MQ Everyplace bridge queue from
which this input node retrieves messages. If the queue does not exist, it is
created for you when the message flow is deployed to the broker.

b. Set the level of Trace that you want for this node. If trace is active, the trace
information is recorded into the file identified by Trace Filename (described
below). Choose one of:

* None. This is the default setting. No trace output is produced, unless a
fatal error occurs.

¢ Standard. Minimal trace output is generated to reflect the overall
operations of the node.

* Debug. Trace information is recorded at a level that helps you to debug
WebSphere MQ Everyplace programs.

* Full. All available debug information is recorded to provide a full record
of the node activities.

If you set the trace level to Debug or Full, you will impact the performance
of WebSphere MQ Everyplace, and significant trace files can be generated.
Use these options for short periods only.

c. In Trace Filename, specify the name of the file to which the trace information
is to be written. The directory structure in which the file is specified must
already exist: it cannot be created during operation.
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d. Select the Transaction Mode to define the transactional characteristics of how
this message is handled:

¢ If you select Automatic, the incoming message is received under
syncpoint if it is marked persistent; otherwise it is not. The
transactionality of any derived messages subsequently sent by an output
node is determined by the incoming persistence property, unless the
output node has explicitly overridden transactionality.

* If you select Yes, the incoming message is received under syncpoint. Any
derived messages subsequently sent by an output node in the same
instance of the message flow are sent transactionally, unless the output
node has explicitly overridden transactionality.

* If you select No, the incoming message is not received under syncpoint.
Any derived messages subsequently sent by an output node in the flow
are sent non-transactionally, unless the output node has specified that the
message must be put under syncpoint.

e. The Use Config File check box is not selected by default: values for all
properties for the MQelnput node are taken from the properties dialog.

If you select the check box, the definition of all properties is extracted from
the file identified by Config Filename (described below) with the exception of
the following:

* The Queue Name and Config Filename general properties
 All default properties

Use a configuration file only to specify additional properties for the node. If
the properties on the properties dialog are sufficient for your needs, do not
select the Use Config File check box.

f. If you have selected the Use Config File check box, enter the full path and
name of the configuration file for WebSphere MQ Everyplace in Config
Filename. This file must be installed on the system that supports every
broker to which this message flow is deployed. If the file does not exist, an
error is detected when you deploy the message flow. The default file name
is MQeConfig.ini.

9. In Queue Manager Name, specify the name of the WebSphere MQ Everyplace
queue manager. This is not related to the queue manager of the broker to
which you deploy the message flow containing this node.

Only one WebSphere MQ Everyplace queue manager can be supported.
Only one execution group can contain MQelnput or MQeOutput nodes.
This property must therefore be set to the same value in every MQelnput
node included in every message flow that you deploy to the same broker.

2. Select Channel in the properties dialog navigator and set the maximum number
of channels supported by WebSphere MQ Everyplace in Max Channels. The
default is zero, which means that there is no limit.

3. Select Registry in the properties dialog navigator and complete the following
properties:
a. Select the type of registry from the drop down list in the Registry Type
property. You can choose one of the following;:
* File Registry. Registry and security information is provided in the
Directory specified below.
e Private Registry. You create the queue manager manually within
WebSphere MQ Everyplace, specifying the security parameters that you
require.
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In Directory, specify the directory in which the registry file is located. This is
valid only if you have selected a Registry Type of File Registry.

If you have selected a Registry Type of Private Registry, complete the
following properties:

* Specify a PIN for the associated queue manager. For further details, refer
to the WebSphere MQ Everyplace documentation.

* Specify a Certificate Request PIN for authentication requests. For further
details, refer to the WebSphere MQ Everyplace documentation.

* Provide a Keyring Password to be used as a seed for the generation of
crypto keys. For further details, refer to the WebSphere MQ Everyplace
documentation.

* In Certificate Host, specify the name of the certificate server that
WebSphere MQ Everyplace uses for authentication. For further details,
refer to the WebSphere MQ Everyplace documentation.

* In Certificate Port, specify the number of the port for the certificate server

that WebSphere MQ Everyplace uses for authentication. For further
details, refer to the WebSphere MQ Everyplace documentation.

4. Select Listener in the properties dialog navigator and complete the following
properties that define the connection type for WebSphere MQ Everyplace:

a.

In Listener Type, select the adapter type that you want to use from the drop
down list. The default is Http; you can also select Length or History. For
further details, refer to the WebSphere MQ Everyplace documentation.

In Hostname, specify the hostname of the server. Set this to the special value
Tocalhost or to the TCP/IP address 127.0.0.1 (the default value), both of
which resolve correctly to the hostname of the server to which the message
flow is deployed. You can also use any valid hostname or TCP/IP address
in your network, but you must use a different message flow for each broker
to which you deploy it, or configure this property at deploy time.

In Port, specify the port number on which WebSphere MQ Everyplace is
listening. If more than one MQelnput node is included in a message flow
deployed to a single broker, each MQelnput node must specify a different
number for this property. You must also ensure that the number that you
specify does not conflict with other listeners on the broker system, for
example, with WebSphere MQ. The default value is 8081.

In Time Interval, specify the timeout value in seconds before idle channels
are timed out. The default value is 300 seconds.

Because channels are persistent logical entities that last longer than a single
queue manager request, and can survive network breakages, it might be
necessary to time out channels that have been inactive for a period of time.

5. Select Description in the properties dialog navigator to enter a short
description, a long description, or both.

6. Click Apply to make the changes to the MQelnput node without closing the
properties dialog. Click OK to apply the changes and close the properties
dialog.

Click Cancel to close the dialog and discard all the changes that you have
made to the properties.

Connecting the terminals:

MQelnput routes each message that it retrieves successfully to the out terminal. If
this fails, the message is retried. If the retry timeout expires (as defined by the
BackoutThreshold attribute of the input queue), the message is routed to the failure



terminal; you can connect nodes to this terminal to handle this condition. If you
have not connected the failure terminal, the message is written to the backout
queue.

If the message is caught by this node after an exception has been thrown further
on in the message flow, the message is routed to the catch terminal. If you have
not connected the catch terminal, the message loops continually through the node
until the problem is resolved. You must define a backout queue or a dead-letter
queue (DLQ) to prevent the message looping continuously through the node.

Configuring for coordinated transactions:

When you include an MQelnput node in a message flow, the value that you set for
the Transaction Mode property defines whether messages are received under
syncpoint:

* If you set it to Yes (the default), the message is received under syncpoint (that is,
within a WebSphere MQ unit of work). Any messages subsequently sent by an
output node in the same instance of the message flow are put under syncpoint,
unless the output node has explicitly overridden this.

* If you set it to Automatic, the message is received under syncpoint if the
incoming message is marked persistent. Otherwise, it is not. Any message
subsequently sent by an output node is put under syncpoint, as determined by
the incoming persistence property, unless the output node has explicitly
overridden this.

 If you set it to No, the message is not received under syncpoint. Any messages
subsequently sent by an output node in the flow are not put under syncpoint,
unless an individual output node has specified that the message should be put
under syncpoint.

(The MQOutput node is the only output node that you can configure to override
this option.)

Terminals and properties

The MQelnput node terminals are described in the following table.

Terminal Description

Failure The output terminal to which the message is routed if an error occurs.

Out The output terminal to which the message is routed if it is successfully retrieved from
the WebSphere MQ Everyplace queue.

Catch The output terminal to which the message is routed if an exception is thrown

downstream and caught by this node.

The following tables describe the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).

The MQelnput node General properties are described in the following table.

Message flows 129



Property M C Default Description

Queue Name Yes Yes The name of the WebSphere MQ Everyplace bridge
queue from which this node retrieves messages for
processing by this message flow.

Trace Yes No None The level of trace required for this node. Valid values
are None, Standard, Debug, and Full.

Trace Filename Yes Yes \MQeTraceFile.trc The name of the file to which trace records are
written.

Transaction Mode | Yes No Yes Whether the incoming message is received under
syncpoint. Valid values are Automatic, Yes, and No.

Use Config File Yes No Cleared Use a configuration file for this node. If you select
the check box, this action is performed.

Config Filename | Yes Yes \MQeconfig.ini The name of the configuration file to be used if the
Use Config File check box is selected.

Queue Manager | Yes Yes ServerQM1 The name of the WebSphere MQ Everyplace queue

Name manager.

The MQelnput node Channel properties are described in the following table.

Property

C

Default

Description

Max Channels

Yes

No

0

The maximum number of channels supported by the
WebSphere MQ Everyplace queue manager.

The MQelnput node Registry properties are described in the following table.

Property M C Default Description

Type Yes Yes File Registry The type of registry information to be used. Valid
values are File Registry and Private Registry.

Directory Yes Yes \ServerQMl\registry |The directory in which the registry file exists (valid
only if File Registry is selected).

PIN Yes Yes The PIN associated with the WebSphere MQ
Everyplace queue manager (valid only if Private
Registry is selected).

Certificate Yes Yes The PIN used to request authentication (valid only if

Request PIN Private Registry is selected).

Keyring Password | Yes Yes The password used to see crypto keys (valid only if
Private Registry is selected).

Certificate Host | Yes Yes The name of the certificate server (valid only if
Private Registry is selected).

Certificate Port Yes Yes The port of the certificate server (valid only if
Private Registry is selected).

The MQelnput node Listener properties are described in the following table.

Property M C Default Description

Listener Type Yes Yes Http The adapter type for the listener. Valid values are
Http, Length, and History.

Hostname Yes Yes 127.0.0.1 The hostname of the server.
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Property M C Default Description

Port Yes Yes 8081 The port on which WebSphere MQ Everyplace
listens.

Time Interval Yes Yes 300 The WebSphere MQ Everyplace polling interval,

specified in seconds.

The MQelnput node Description properties are described in the following table.

Property M C Default Description

Short Description No No A brief description of the node.

Long Description No No Text that describes the purpose of the node in the
message flow.

MQeOutput node

Attention: The use of flows containing MQelnput and MQeOutput nodes in
WebSphere Message Broker Version 6.0 is deprecated. The behavior described here
is intended only for when you are deploying from Version 6.0 to a previous
version, and to provide a route for migration. Redesign your flows to remove the
MQe nodes and replace them with MQ nodes configured to your own
specifications and coordinated with your MQe Gateway configuration. For more
details see [Migrating a flow containing WebSphere MQ Everyplace nodes|

This topic contains the following sections:
. ”Purpose”|

* [“Using this node in a message flow” on page 132|
* [“WebSphere MQ Everyplace documentation” on page 132
* [“Configuring the MQeOutput node” on page 132
+ |“Terminals and properties” on page 133

Purpose

Use the MQeOutput node to send messages to clients that connect to the broker
using the WebSphere MQ Mobile Transport protocol.

The MQeOutput node forwards messages to WebSphere MQ Everyplace queue
managers. If you specify a non-local destination queue manager, ensure that there
is either a route to the queue manager, or store-and-forward queue servicing for
the queue manager if it exists.

You cannot use the MQeOutput node to change the transactional characteristics of
the message flow. The transactional characteristics set by the message flow’s input
node determine the transactional behavior of the flow.

You cannot use MQeOutput nodes in message flows that you deploy to z/OS
systems.

If you create a message flow to use as a subflow, you cannot use a standard output
node, you must use an instance of the Output node to create an out terminal for

the subflow through to propagate which the message.

If you do not want your message flow to send messages to a WebSphere MQ
Everyplace queue, you can choose another supported output node.

Message flows 131



132 Message Flows

The MQeOutput node is represented in the workbench by the following icon:

Using this node in a message flow

N

For an example of how this node can be used, consider a farmer who checks his
fields to see how well they are irrigated. He is carrying a PDA device with
WebSphere MQ Everyplace installed. He sees that his fields are not being irrigated,
so he uses his PDA and a Global Satellite Navigation link to check the water flow
valve, and finds that it is faulty. This information is available because the remote
SCADA device responsible for controlling the valve has published a diagnostic
message, which was retrieved by the broker and forwarded to an MQeOutput
node and on to the WebSphere MQ Everyplace client on his PDA.

WebSphere MQ Everyplace documentation

You can find further information about WebSphere MQ Everyplace, and the
properties of the node, in the WebSphere MQ Everyplace documentation on the
[WebSphere MQ Web pagel

Configuring the MQeOutput node

When you have put an instance of the MQeOutput node into a message flow you
can configure it. Right-click the node in the editor view and click Properties. The
node’s basic properties are displayed.

All mandatory properties for which you must enter a value (those that do not have
a default value defined) are marked with an asterisk on the properties dialog.

Configure the MQeOutput node as follows:

1. Enter the Queue Manager Name and Queue Name that specify the destination for
the output message if you select Queue Name in Destination Mode (described
below). If you select another option for Destination Mode, you do not have to set
these properties.

2. Select Advanced in the properties dialog navigator and select the Destination
Mode from the drop-down list. This identifies the queues to which to deliver
the output message.

* Queue Name. The message is sent to the queue named in the Queue Name
property. The properties Queue Manager Name and Queue Name (on the Basic
tab) are mandatory if you select this option. This is the default.

* Reply To Queue. The message is sent to the queue named in the ReplyToQ
field in the MQMD.

* Destination List. The message is sent to the list of queues named in the
LocalEnvironment (also known as DestinationList) associated with the
message.

3. Select Request in the properties dialog navigator and set properties to define
the characteristics of each output message generated.

a. Select the Request check box to indicate that each output message is marked
in the MQMD as a request message (MQMD_REQUEST), and the message
identifier field cleared (set to MOQMI_NONE) to ensure that WebSphere MQ
generates a new identifier. Clear the check box to indicate that each output
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message is not marked as a request message. You cannot select this check
box if you have selected a Destination Mode of Reply To Queue.

b. Enter a WebSphere MQ Everyplace queue manager name in Reply-to queue
manager. This is inserted into the MQMD of each output message as the
reply-to queue manager. This new value overrides the current value in the
MQMD.

c. Enter a WebSphere MQ Everyplace queue name in Reply-to queue. This is
inserted into the MQMD of each output message as the reply-to queue. This
new value overrides the current value in the MQMD.

4. Select Description in the properties dialog navigator to enter a short
description, a long description, or both.

5. Click Apply to make the changes to the MQeOutput node without closing the
properties dialog. Click OK to apply the changes and close the properties
dialog.

Click Cancel to close the dialog and discard all the changes that you have

made to the properties.

Connecting the terminals:

Connect the in terminal to the node from which outbound messages bound are
routed.

Connect the out or failure terminal of this node to another node in this message
flow if you want to send the message to an additional destination.

Terminals and properties

The MQeOutput node terminals are described in the following table.

Terminal Description
In The input terminal that accepts a message for processing by the node.
Failure The output terminal to which the message is routed if a failure is detected when the
message is put to the output queue.
Out The output terminal to which the message is routed if it has been successfully put to
the output queue, and if further processing is required within this message flow.
The following tables describe the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).
The MQeOutput node Basic properties are described in the following table.
Property M C Default Description
Queue Manager No Yes The name of the WebSphere MQ Everyplace queue

Name

manager to which the output queue, specified in Queue
Name, is defined.

Queue Name

No Yes The name of the WebSphere MQ Everyplace output
queue to which this node puts messages.

The MQeOutput node Advanced property is described in the following table.
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Property M C Default Description
Destination Mode Yes No Destination |The queues to which the output message is sent. Valid
List values are Queue Name, Reply To Queue, and

Destination List.

The MQeOutput node Request properties are described in the following table.

Property M C Default Description

Request Yes No Cleared Whether each output message is to be generated as a
request message. If you select the check box, the action
is performed.

Reply-to queue No Yes The name of the queue manager to which the output

manager queue, specified in Reply-to queue, is defined.

Reply-to queue No Yes The name of the reply-to queue to which to put a reply
to this request.

The MQeOutput node Description properties are described in the following table.

Property M C Default Description

Short Description No No A brief description of the node.

Long Description No No Text that describes the purpose of the node in the
message flow.

MQInput node
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This topic contains the following sections:

. ”Purpose”|

+ |[“Using the MQInput node in a message flow” on page 135

+ |“Configuring the MQInput node” on page 135|

+ |“Terminals and properties” on page 139

Purpose

Use the MQInput node to receive messages from clients that connect to the broker
using the WebSphere MQ Enterprise Transport, and that use the MQI and AMI
application programming interfaces.

The MQInput node receives message input to a message flow from a WebSphere
MQ message queue defined on the broker’s queue manager. The node uses
MQGET to read a message from a specified queue, and establishes the processing
environment for the message. If appropriate, you can define the input queue as a
WebSphere MQ clustered queue or shared queue.

Message flows that handle messages that are received across WebSphere MQ
connections must always start with an MQInput node. You can set the properties
of the MQInput node to control the way that messages are received, by causing
appropriate MQGET options to be set. For example, you can indicate that a
message is to be processed under transaction control. You can also request that
data conversion is performed on receipt of every input message.

If you include an output node in a message flow that starts with an MQInput
node, it can be any of the supported output nodes, including user-defined output




nodes; you do not have to include an MQOutput node. You can create a message
flow that receives messages from WebSphere MQ clients and generates messages
for clients that use any of the supported transports to connect to the broker,
because you can configure the message flow to request that the broker provides
any conversion that is necessary.

If you create a message flow to use as a subflow, you cannot use a standard input
node; you must use an instance of the Input node as the first node to create an in
terminal for the subflow.

If your message flow does not receive messages across WebSphere MQ
connections, you can choose one of the supported input nodes.

The MQInput node is represented in the workbench by the following icon:

H

Using the MQInput node in a message flow
Configuring the MQInput node

When you have put an instance of the MQInput node into a message flow, you can
configure it. Right-click the node in the editor view and click Properties. The
node’s basic properties are displayed in the properties dialog.

All mandatory properties that do not have a default value defined are marked
with an asterisk on the properties dialog.

Configure the MQInput node as follows:

1. Enter the name of the queue from which the message flow receives messages.
You must predefine this WebSphere MQ queue to the queue manager that hosts
the broker to which the message flow is deployed.

2. Select Advanced in the properties dialog navigator to set properties that
determine how the message is processed, for example its transactional
characteristics. Many of these properties map to options on the MQGET call.

* Select Transaction Mode from the drop-down list to define the transactional
characteristics of how this message is handled:

— If you select Automatic, the incoming message is received under syncpoint
if it is marked persistent, otherwise it is not. The transactionality of any
derived messages subsequently sent by an output node is determined by
the incoming persistence property, unless the output node has explicitly
overridden transactionality.

— If you select Yes, the incoming message is received under syncpoint. Any
derived messages subsequently sent by an output node in the same
instance of the message flow are sent transactionally, unless the output
node has explicitly overridden transactionality.

— If you select No, the incoming message is not received under syncpoint.
Any derived messages subsequently sent by an output node in the flow
are sent non-transactionally, unless the output node has specified that the
messages must be put under syncpoint.

* Select Order Mode from the drop-down list to determine the order in which
messages are retrieved from the input queue. This property has an effect
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only if the message flow property Additional Instances is set to greater than 0,
that is, if multiple threads read the input queue. Valid values are:

— Default. Messages are retrieved in the order defined by the queue
attributes, but this order is not guaranteed as the messages are processed
by the message flow.

— By User ID. Messages that have the same Userldentifier in the MQMD are
retrieved and processed in the order defined by the queue attributes; this
order is guaranteed to be preserved when the messages are processed. A
message associated with a particular Userldentifier that is being processed
by one thread is completely processed before the same thread, or another
thread, can start to process another message with the same Userldentifier.
No other ordering is guaranteed to be preserved.

— By Queue Order. Messages are retrieved and processed by this node in the
order defined by the queue attributes; this order is guaranteed to be
preserved when the messages are processed. This behavior is identical to
the behavior exhibited if the message flow property Additional Instances is
set to 0.

See [“Configuring the node to handle message groups” on page 139 for more
details about this option.

Select the Logical Order check box if you want to ensure that messages that
are part of a message group are received in the order that has been assigned
by the sending application. This option maps to the
MQGMO_LOGICAL_ORDER option of the MQGMO of the MQL

If you clear the check box, messages sent as part of a group are not received
in a predetermined order. If a broker expects to receive messages in groups
and this check box is not selected, either the order of the input messages is
not significant, or the message flow must be designed to process them
appropriately.

You must also select the Commit by Message Group check box if you want
message processing to be committed only after the final message of a group
has been received and processed.

More information about the options to which this property maps is available
in the WebSphere MQ Application Programming Reference.

See[“Configuring the node to handle message groups” on page 139 for more
details about this option.

Select the All Messages Available check box if you want message retrieval and

processing to be done only when all messages in a single group are available.
This maps to the MQGMO_ALL_MSGS_AVAILABLE option of the MQGMO

of the MQI. Clear this check box if message retrieval does not depend on all

messages in a group being available before processing starts.

More information about the options to which this property maps is available
in the WebSphere MQ Application Programming Reference.

Enter a message identifier in Match Message ID if you want the input node to
receive only messages that contain a matching message identifier value in the
Msgld field of the MQMD.

Enter an even number of hexadecimal digits (characters 0 to 9, A to F, and
a to f are valid) up to a maximum of 48 digits. If the ID that you enter is
shorter than the size of the Msgld field, it is padded on the right with X'00'
characters. This maps to the MOQMO_MATCH_MSG_ID option of the
MQGMO of the MQI.

Leave this property blank if you do not want the input node to check that
the message ID matches.



More information about the options to which this property maps is available
in the WebSphere MQ Application Programming Reference.

Enter a message identifier in Match Correlation ID if you want the input node
to receive only messages that contain a matching correlation identifier value
in the Correlld field of the MQMD.

Enter an even number of hexadecimal digits (characters 0 to 9, A to F, and
a to f are valid) up to a maximum of 48 digits. If the ID that you enter is
shorter than the size of the Correlld field, it is padded on the right with
X'00' characters. This maps to the MOQMO_MATCH_CORREL_ID option of
the MQGMO of the MQI.

Leave this property blank if you do not want the input node to check that
the message ID matches.

More information about the options to which this property maps is available
in the WebSphere MQ Application Programming Reference.

Select the Convert check box if you want WebSphere MQ to perform data
conversion on the message when it is retrieved from the queue.

WebSphere MQ converts the incoming message to the encoding and coded
character set specified in the MQMD that the input node supplies on the
MQGET call to retrieve the message from the input queue. The message flow
generates all its output messages using these values, and puts them to target
queues with these Encoding and CodedCharSetID values set in the MQMD.

This property maps to the MQGMO_CONVERT option of the MQGMO of
the MQI.

Clear the check box if you do not want WebSphere MQ to convert the
message.

If you select this box, you can also specify:

— Convert Encoding. Enter the number representing the encoding to which
you want to convert numeric data in the message body. Valid values
include:

- 546 for DOS and all Windows systems
- 273 for all Linux and UNIX systems
- 785 for z/OS systems

If you do not specify a value, the value in the incoming message MQMD
is used.

If you specify an invalid value, no conversion is done.

— Convert Coded Char Set ID. Enter the number representing the character set
identifier to which you want to convert character data in the message
body:.

If you do not specify a value, the value in the incoming message MQMD
is used.

If you specify an invalid value, no conversion is done.

For more information about WebSphere MQ data conversion, and why you
might choose to use this option, see the WebSphere MQ Application
Programming Guide. For further information about the values that you can
specify for Convert Encoding and Convert Coded Char Set ID, see the WebSphere
MQ Application Programming Reference.

Select the Commit by Message Group check box if you want message
processing to be committed only after the final message of a group has been
received and processed. If you leave this check box cleared, a commit is
performed after each message has been propagated completely through the
message flow.
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This property is relevant only if you have selected Logical Order.

Set the Order Mode property to By Queue Order if the messages in a group
must be retrieved and processed in the order in which they appear on the
queue.

* (z/OS only). Enter a serialization token in z/OS Serialization Token if you want
to use the serialized access to shared resources that is provided by
WebSphere MQ.

The value that you provide for the serialization token must conform to the
rules described in the WebSphere MQ Application Programming Reference.

For more information about serialization and queue sharing on z/OS, refer to
the WebSphere MQ Concepts and Planning Guide.

3. Select Description in the properties dialog navigator to enter a short
description, a long description, or both.

4. Click Apply to make the changes to the MQInput node without closing the
properties dialog. Click OK to apply the changes and close the properties
dialog.

Click Cancel to close the dialog and discard all the changes that you have
made to the properties.

Connecting the terminals:

MQInput routes each message that it retrieves successfully to the out terminal. If
this fails, the message is retried. If the retry timeout expires (as defined by the
BackoutThreshold attribute of the input queue), the message is routed to the failure
terminal; you can connect nodes to this terminal to handle this condition. If you
have not connected the failure terminal, the message is written to the backout
queue.

If the message is caught by this node after an exception has been thrown further
on in the message flow, the message is routed to the catch terminal. If you have
not connected the catch terminal, the message loops continually through the node
until the problem is resolved. You must define a backout queue or a dead-letter
queue (DLQ) to prevent the message looping continuously through the node.

Configuring for coordinated transactions:

When you include an MQInput node in a message flow, the value that you set for
Transaction Mode defines whether messages are received under syncpoint:

* If you set it to Yes (the default), the message is received under syncpoint (that is,
within a WebSphere MQ unit of work). Any messages subsequently sent by an
output node in the same instance of the message flow are put under syncpoint,
unless the output node has explicitly overridden this.

* If you set it to Automatic, the message is received under syncpoint if the
incoming message is marked persistent. Otherwise, it is not. Any message
subsequently sent by an output node is put under syncpoint, as determined by
the incoming persistence property, unless the output node has explicitly
overridden this.

 If you set it to No, the message is not received under syncpoint. Any messages
subsequently sent by an output node in the flow are not put under syncpoint,
unless an individual output node has specified that the message must be put
under syncpoint.

(The MQOutput node is the only output node that you can configure to override
this option.)



Configuring the node to handle message groups:

WebSphere MQ supports message groups; you can specify that a message belongs
to a group and that its processing and the processing of all other messages in the
group must be handled as one transaction. That is, if the processing on one
message in the group fails, all messages in the group are backed out. The message
processing is committed when the last message in the group has been processed
successfully only if processing of all messages has been successful.

If you include messages in a group, and it is important that all of the messages
within the group are read from the queue and processed in the order in which
they are defined in the group, you must complete all the actions stated below:

* Select the Commit by Message Group check box.
* Select the Logical Order check box.

* Set the Order Mode to By Queue Order or set the message flow property
Additional Instances to 0. (You can modify message flow properties when you add
the message flow to the bar file for deployment.) If you choose either of these
options (or both), the message flow processes the messages on a single thread of
execution, and a message is processed to completion before the next message is
retrieved from the queue. In all other cases, it is possible that multiple threads
within a single message flow are processing multiple messages, and there is no
guarantee that the final message in a group, which prompts the commit or roll
back action, is processed to completion after all other messages in the group.

You must also ensure that you do not have another message flow that is retrieving
messages from the same input queue. If you do, there is no guarantee about the
order in which the messages within a group are processed.

Terminals and properties

The terminals of the MQInput node are described in the following table.

Terminal

Description

Failure

The output terminal to which the message is routed if an error occurs. Even if the
Validation property is set, messages propagated to this terminal are not validated.

Out

The output terminal to which the message is routed if it is successfully retrieved from
the WebSphere MQ queue.

Catch

The output terminal to which the message is routed if an exception is thrown
downstream and caught by this node.

The following tables describe the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).

The Basic properties of the MQInput node are described in the following table.

Property

M C Default Description

Queue Name

Yes Yes The name of the WebSphere MQ input queue from
which this node retrieves messages (using MQGET) for
processing by this message flow.
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The Advanced properties of the MQInput node are described in the following

table.

Property

M

Default

Description

Transaction Mode

Yes

Yes

Whether the incoming message is received under
syncpoint. Valid values are Automatic, Yes, and No.

Order Mode

Yes

Default

The order in which messages are retrieved from the
input queue and processed. Valid values are Default,
By User ID, and By Queue Order.

Logical Order

Yes

Selected

Whether messages are received in logical order, as
defined by WebSphere MQ. If you select the check box,
this action is performed.

All Messages Available

Yes

Cleared

If you select the check box, all messages in a group
must be available before retrieval of a message is
possible.

Match Message 1D

No

A message ID that must match the message ID in the
MQMD of the incoming message.

Match Correlation ID

No

A correlation ID that must match the correlation ID in
the MQMD of the incoming message.

Convert

Yes

Cleared

Whether WebSphere MQ converts data in the message
to be received, in conformance with the
CodedCharSetld and Encoding values set in the
MQMD. If you select the check box, this action is
performed.

Convert Encoding

No

The representation used for numeric values in the
message data, expressed as an integer value. This
property is valid only if you have selected the Convert
check box.

Convert Coded
Character Set ID

No

The coded character set identifier of character data in

the message data, expressed as an integer value. This

property is valid only if you have selected the Convert
check box.

Commit By Message
Group

Yes

Cleared

When a transaction is committed when processing
messages that are part of a message group. If you select
the check box, the transaction is committed when the
message group has been processed.

z/0OS Serialization
Token

No

A user-defined token for serialized application support.
The value specified must conform to the rules for a
valid ConnTag in the WebSphere MQ MQCNO
structure. These rules are described in the WebSphere
MQ Application Programming Reference.

The Description properties of the MQInput node are described in the following

table.
Property M C Default Description
Short Description No No A brief description of the node.
Long Description No No Text that describes the purpose of the node in the
message flow.
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MQJMSTransform node

This topic contains the following sections:
* ["Purpose”]

» ["Using the MQJMSTransform node in a message flow”|
¢ [“Terminals and properties”|

Purpose

Use the MQJMSTransform node to receive messages that have a WebSphere MQ
JMS provider message tree format, and transform them into a format that is
compatible with messages that are to be sent to JMS destinations.

The MQJMSTransform node can be used to send messages to legacy message flows
and to interoperate with WebSphere MQ JMS and WebSphere Event Broker publish
subscribe.

The MQJMSTransform node is represented in the workbench by the following icon:

Using the MQJMSTransform node in a message flow

The [MS Nodes|sample contains a message flow in which the MQJMSTransform
node is used. Refer to this sample for an example of how to use the
MQJMSTransform node.

Terminals and properties

The terminals of the MQJMSTransform node are described in the following table:

Terminal Description

Failure The output terminal to which the message is routed if an error occurs. Even if the
Validation property is set, messages propagated to this terminal are not validated.

Out The output terminal to which the message is routed if it is successfully retrieved from
the WebSphere MQ queue.

In The input terminal that accepts a message for processing by the node.

There are no configurable attributes for this node.

MQOutput node

This topic contains the following sections:
. ”Purpose”l

e |“Using this node in a message flow” on page 142|
* [“Configuring the MQOutput node” on page 142
* [“Terminals and properties” on page 145

Purpose

Use the MQOutput node to send messages to clients that connect to the broker
using the WebSphere MQ Enterprise Transport and that use the MQI and AMI
application programming interfaces.
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The MQOutput node delivers an output message from a message flow to a
WebSphere MQ queue. The node uses MQPUT to put the message to the
destination queue that you specify.

If appropriate, you can define the queue as a WebSphere MQ clustered queue or
shared queue. When using a WebSphere MQ clustered queue, leave the queue
manager name empty.

You can configure the MQOutput node to put a message to a specific WebSphere
MQ queue defined on any queue manager accessible by the broker’s queue
manager.

You can set other properties to control the way in which messages are sent, by
causing appropriate MQPUT options to be set. For example, you can request that a
message is processed under transaction control. You can also specify that
WebSphere MQ can, if appropriate, break the message into segments in the queue
manager.

If you create a message flow to use as a subflow, you cannot use a standard output
node, you must use an instance of the Output node to create an out terminal for
the subflow through which to propagate the message.

If you do not want your message flow to send messages to a WebSphere MQ
queue, you can choose another supported output node.

The MQOutput node is represented in the workbench by the following icon:

H

Using this node in a message flow

For an example of how you can use this node, assume that you have written a
publishing application that publishes stock updates on a regular basis. The
application sends the messages to the broker on an MQInput node, and the
message flow makes the publications available to multiple subscribers through a
Publication node. You include an MQOutput node to send the message to an
application that records each price change that occurs.

Configuring the MQOutput node

When you have put an instance of the MQOutput node into a message flow, you
can configure it. Right-click the node in the editor view and click Properties. The
node’s basic properties are displayed.

All mandatory properties for which you must enter a value (those that do not have
a default value defined) are marked with an asterisk on the properties dialog.

Configure the MQOutput node as follows:

1. If you want to send the output message to a single destination queue that is
defined by this node, enter the name of the queue to which the message flow
sends messages in Queue Name. Enter the name of the queue manager to which
this queue is defined in Queue Manager Name. You must set these properties if
you set the Advanced property Destination Mode (described below) to Queue
Name. If you set Destination Mode to another value, these properties are ignored.



2. Select Advanced in the properties dialog navigator. These properties define the
transactional control for the message and the way that the message is put to
the queue. Many of these properties map to options on the MQPUT call.

* Select the Destination Mode from the drop-down list. This identifies the
queues to which the output message is put.

— Queue Name. The message is sent to the queue named in the Queue Name
property. The properties Queue Manager Name and Queue Name (on the
Basic tab) are mandatory if you select this option. This is the default.

— Reply To Queue. The message is sent to the queue named in the ReplyToQ
field in the MQMD.

* Select the Transaction Mode from the drop-down list to determine how the
message is put.

— If you select Automatic (the default), the message transactionality is
derived from the way that it was specified at the input node.

— If you select Yes, the message is put transactionally.
— If you select No, the message is put non-transactionally.

See |“Configuring for coordinated transactions” on page 144 for more
information.

* Select the Persistence Mode from the drop-down list to determine whether the
message is put persistently.

— If you select Automatic (the default), the persistence is as specified in the
incoming message.

- If you select Yes, the message is put persistently.
— If you select No, the message is put non-persistently.

— If you select As Defined for Queue, the message persistence is set as
defined for the WebSphere MQ queue.

* Select the New Message ID check box to generate a new message ID for this
message. This maps to the MQPMO_NEW_MSG_ID option of the MQPMO
of the MQI.

Clear the check box if you do not want to generate a new ID. Note that a
new message ID is still generated if you select the Request check box in the
Request panel of the properties dialog.

More information about the options to which this property maps is available
in the WebSphere MQ Application Programming Reference.

* Select the New Correlation ID check box to generate a new correlation ID for
this message. This maps to the MQPMO_NEW_CORREL_ID option of the
MQPMO of the MQI. Clear the check box if you do not want to generate a
new ID.

More information about the options to which this property maps is available
in the WebSphere MQ Application Programming Reference.

* Select the Segmentation Allowed check box if you want WebSphere MQ to
segment the message within the queue manager when appropriate. You must
also set MQMF_SEGMENTATION_ALLOWED in the MsgFlags field in the MQMD for
segmentation to occur. Clear the check box if you do not want segmentation.
More information about the options to which this property maps is available
in the WebSphere MQ Application Programming Reference.

* Select the Message Context to indicate how origin context is to be handled.
Choose one of the following options:

— Pass A1l (maps to the MQPMO_PASS_ALL_CONTEXT option of the
MQPMO of the MQL.)
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— Pass Identity (maps to the MQPMO_PASS_IDENTITY_CONTEXT option
of the MQPMO of the MQI.)

- Set A1l (maps to the MOPMO_SET_ALL_CONTEXT option of the
MQPMO of the MQL.)

— Set Identity (maps to the MQPMO_SET_IDENTITY_CONTEXT option of
the MQPMO of the MQIL.)

— Default (maps to the MQPMO_DEFAULT_CONTEXT option of the
MQPMO of the MQL.)

— None (maps to the MQPMO_NO_CONTEXT option of the MQPMO of the
MQL.)

More information about the options to which these properties map is

available in the WebSphere MQ Application Programming Reference.

Select the Alternate User Authority check box if you want the
MQOO_ALTERNATE_USER_AUTHORITY option set in the open options
(MQOO) of the MQIL. If you select this box, this option is specified when the
queue is opened for output. The alternate user information is retrieved from
the context information in the message. Clear the check box if you do not
want to specify alternate user authority. If you clear the box, the broker
service user ID is used when the message is put.

3. Select Request in the properties dialog navigator and set the properties to
define the characteristics of each output message generated.

Select the Request check box to mark each output message in the MQMD as a
request message (MQOMT_REQUEST), and clear the message identifier field
(set to MQMI_NONE) to ensure that WebSphere MQ generates a new
identifier. Clear the check box to indicate that each output message is not
marked as a request message. You cannot select this check box if you have
selected a Destination Mode of Reply To Queue.

Note that a new message identifier is generated even if the New Message ID
check box is not selected in the Advanced panel of the properties dialog
navigator.

Enter a queue manager name in Reply-to Queue Manager. This is inserted into
the MOMD of each output message as the reply-to queue manager.

Enter a queue name in Reply-to Queue. This is inserted into the MQMD of
each output message as the reply-to queue.

4. Select Description in the properties dialog navigator to enter a short
description, a long description, or both.

5. Click Apply to make the changes to the MQOutput node without closing the
properties dialog. Click OK to apply the changes and close the properties
dialog.

Click Cancel to close the dialog and discard all the changes that you have
made to the properties.

Connecting the terminals:

Connect the in terminal to the node from which outbound messages bound are
routed.

Connect the out or failure terminal of this node to another node in this message
flow if you want to send the message to an additional destination.

Configuring for coordinated transactions:



When you define an MQOutput node, the option that you select for the Transaction
Mode property defines whether the message is written under syncpoint:

 If Yes, the message is written under syncpoint (that is, within a WebSphere MQ
unit of work).

* If Automatic (the default), the message is written under syncpoint if the
incoming input message is marked persistent.

* If No, the message is not written under syncpoint.

Another property of the MQOutput node, Persistence Mode, defines whether the
output message is marked as persistent when it is put to the output queue:

 If Yes, the message is marked as persistent.

* If Automatic (the default), the message persistence is determined from the
properties of the incoming message, as set in the MQMD (the WebSphere MQ
message descriptor).

* If No, the message is not marked as persistent.

» If As Defined for Queue, the message persistence is set as defined in the
WebSphere MQ queue by the MQOutput node specifying the
MQPER_PERSISTENCE_AS_Q_DEF option in the MQMD.

Terminals and properties

The MQOutput node terminals are described in the following table.

Terminal Description
In The input terminal that accepts a message for processing by the node.
Failure The output terminal to which the message is routed if a failure is detected when the
message is put to the output queue.
Out The output terminal to which the message is routed if it has been successfully put to
the output queue, and if further processing is required within this message flow.
The following tables describe the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).
The MQOutput node Basic properties are described in the following table.
Property M C Default Description
Queue Manager Name | No Yes The name of the WebSphere MQ queue manager to
which the output queue, specified in Queue Name, is
defined.
Queue Name No Yes The name of the WebSphere MQ output queue to which
this node puts messages (using MQPUT).

The MQOutput node Advanced properties are described in the following table.

Property

M C Default Description

Destination Mode

Yes No Queue Name | The queues to which the output message is sent. Valid
values are , Reply To Queue, and Queue Name.
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Property M C Default Description

Transaction Mode Yes No Automatic Whether the message is put transactionally. Valid
values are Automatic, Yes, and No.

Persistence Mode Yes No Automatic Whether the message is put persistently. Valid values
are Automatic, Yes, No, and As Defined for Queue.

New Message ID Yes No Cleared Whether WebSphere MQ generates a new message
identifier to replace the contents of the Msgld field in
the MQMD. If you select the check box, this action is
performed.

New Correlation 1D Yes No Cleared Whether WebSphere MQ generates a new correlation
identifier to replace the contents of the Correlld field in
the MQMD. If you select the check box, this action is
performed.

Segmentation Allowed | Yes No Cleared If appropriate, WebSphere MQ breaks the message into
segments in the queue manager. If you select the check
box, this action is performed.

Message Context Yes No Pass All How to handle origin context. Valid values are Pass
A11, Pass Identity, Set All, Set Identity, and
Default.

Alternate User Yes No Cleared Whether alternate authority is used when the output

Authority message is put. If you select the check box, this action
is performed.

The MQOutput node Request properties are described in the following table.

Property M C Default Description

Request Yes No Cleared Whether to generate each output message as a request
message. If you select the check box, this action is
performed.

Reply-to Queue No Yes The name of the WebSphere MQ queue manager to

Manager which the output queue, specified in Reply-to Queute, is
defined.

Reply-to Queue No Yes The name of the WebSphere MQ queue to which to put

a reply to this request.

The MQOutput node Description properties are described in the following table.

Property M C Default Description

Short Description No No A brief description of the node.

Long Description No No Text that describes the purpose of the node in the
message flow.

Output node

146 Message Flows

This topic contains the following sections:

* |[“Purpose” on page 147]

» [“Configuring the Output node” on page 147|

+ [“Terminals and properties” on page 147]




Purpose

The Output node provides an out terminal for an embedded message flow (a
subflow). You can use a subflow to provide a common destination for output
messages.

You must use an Output node to provide the out terminal to a subflow; you
cannot use a standard output node (a built-in output node such as MQOutput, or a
user-defined output node).

You can include one or more Output nodes in a subflow. Each one that you
include provides a terminal through which you can propagate messages to
subsequent nodes in the message flow in which you include the subflow.

The Output node is represented in the workbench by the following icon:

When you select and include a subflow in a message flow, it is represented by the
icon:

When you include the subflow in a message flow, this icon exhibits a terminal for
each Output node that you included in the subflow, and the name of the terminal
(which you can see when you hover over it) matches the name of that instance of
the Output node. Give your Output nodes meaningful names, you can easily

recognize them when you use their corresponding terminal on the subflow node in
your message flow.

Configuring the Output node

When you have put an instance of the Output node into a message flow, you can
configure it by giving it a name.

Right-click the node in the editor view and select Properties. The Description
properties of the node are displayed.

Enter a short description, a long description, or both.

Click Apply to make the changes to the Input node without closing the properties
dialog, or click OK to apply the changes and close the properties dialog.

Click Cancel to close the dialog and discard all the changes that you have made to
the properties.

Terminals and properties

The Output node terminals are described in the following table.

Terminal

Description

In

The output terminal that defines an out terminal for the subflow.
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The following table describes the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).

The Output node Description properties are described in the following table.

Property M C Default Description

Short Description No No A brief description of the node.

Long Description No No Text that describes the purpose of the node in the
message flow.

Publication node

148 Message Flows

This topic contains the following sections:
. ”Purpose”|

+ |[“Using this node in a message flow”]
+ |“Configuring the Publication node” on page 149
* [“Terminals and properties” on page 149

Purpose

Use the Publication node to filter output messages from a message flow and
transmit them to subscribers who have registered an interest in a particular set of
topics. The Publication node must always be an output node of a message flow
and has no output terminals of its own.

Use the Publication node (or a user-defined node that provides a similar service) if
your message flow supports publish/subscribe applications. Applications expecting
to receive publications must register a subscription with a broker, and can
optionally qualify the publications that they get by providing restrictive criteria
(such as a specific publication topic).

If your subscriber applications use the WebSphere MQ Enterprise Transport to
connect to the broker, you can define the queues to which messages are published
as WebSphere MQ clustered queues or shared queues.

Publications can also be sent to subscribers within a WebSphere MQ cluster if a
cluster queue is nominated as the subscriber queue. In this case, the subscriber
should use the name of an "imaginary” queue manager that is associated with the
cluster, and should ensure that a corresponding blank queue manager alias
definition for this queue manager is made on the broker that satisfies the
subscription.

The Publication node is represented in the workbench by the following icon:

IEJ

Using this node in a message flow

Look at the following sample to see how you can use this node:

* |Soccer Results
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For an example of how you can use this node, assume that you have written a
publishing application that publishes stock updates on a regular basis. The
application sends the messages to the broker on an MQInput node, and the stock
publications are made available to multiple subscribers through a Publication node.

Configuring the Publication node

When you have put an instance of the Publication node into a message flow, you
can configure it. Right-click the node in the editor view and click Properties. The
node’s basic properties are displayed.

All mandatory properties for which you must enter a value (those that do not have
a default value defined) are marked with an asterisk on the properties dialog.

Configure the Publication node as follows:

1. Select the Implicit Stream Naming check box to take the name of the WebSphere
MQ queue on which the message was received by the message flow as the
stream name. This property provides forward compatibility with WebSphere
MQ Publish/Subscribe, and applies to messages with an MQRFH header when
MQPSStream is not specified.

Clear the check box if you do not want this action to be taken.

2. Specify the Subscription Point for this Publication node. If you do not specify a
value for this property, the default subscription point is assumed. This value
uniquely identifies the node, and can be used by subscribers to get a specific
publication (as described in the example scenario above).

For more information, refer to |Subscription points|

3. Select Description in the properties dialog navigator to enter a short
description, a long description, or both.

4. Click Apply to make the changes to the Publication node without closing the
properties dialog. Click OK to apply the changes and close the properties
dialog.

Click Cancel to close the dialog and discard all the changes that you have
made to the properties.

Terminals and properties

The Publication node terminals are described in the following table.

Terminal

Description

In

The input terminal that accepts a message for processing by the node.

The following tables describe the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).

The Publication node Basic properties are described in the following table.
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Property

M C Default Description

Implicit Stream

Yes No Cleared Whether to take the name of the WebSphere MQ queue

Naming on which the input message was received as the stream
name. If you select the check box, this action is
performed.

Subscription Point No No The subscription point value for the node.

The Publication node Description properties are described in the following table.

Property M C Default Description

Short Description No No A brief description of the node.

Long Description No No Text that describes the purpose of the node in the
message flow.

Real-timelnput node

150 Message Flows

This topic contains the following sections:
. ”Purpose”|

+ |[“Using this node in a message flow”]
+ [“Configuring the Real-timeInput node” on page 151
e [“Terminals and properties” on page 15

Purpose

Use the Real-timelnput node to receive messages, from clients that connect to the
broker using the WebSphere MQ Real-time Transport or the WebSphere MQ
Multicast Transport and that use JMS application programming interfaces, into a
message flow.

An output node in a message flow that starts with a Real-timeInput node can be
any of the supported output nodes, including user-defined output nodes. You can
create a message flow that receives messages from real-time clients and generates
messages for clients that use all supported transports to connect to the broker,
because you can configure the message flow to request the broker to provide any
conversion that is necessary.

If you are create a message flow to use as a subflow, you cannot use a standard
input node: you must use an instance of the Input node as the first node to create

an in terminal for the subflow.

If your message flow does not receive messages from JMS applications, you can
choose one of the supported input nodes.

The Real-timeInput node is represented in the workbench by the following icon:

H

Using this node in a message flow

For an example of how to use this node, assume that you have written a
publishing application that publishes stock updates on a regular basis. The




application sends the messages to the broker on a Real-timelnput node, and the
message flow makes the publications available to multiple subscribers through a
Publication node.

Configuring the Real-timelnput node

When you have put an instance of the Real-timelnput node into a message flow,
you can configure it. Right-click the node in the editor view and select Properties.
The node’s basic properties are displayed.

All mandatory properties for which you must enter a value (those that do not have
a default value defined) are marked with an asterisk on the properties dialog.

Configure the Real-timelnput node as follows:

1. In Port, identify the number of the port on which the node listens for messages
from JMS applications. Ensure that the port number that you specify does not
conflict with any other listener service. There is no default for this property;
you must enter a value.

2. If you want to authenticate users that send messages on receipt of their
messages, select the Authentication check box. If you clear the check box (the
default setting), users are not authenticated.

3. If you want clients to use HTTP tunneling, select the Tunnel through HTTP
check box. If you clear the check box (the default setting), messages do not use
HTTP tunneling. If you set this option, all client applications that connect must
use this feature. If they do not, their connection is rejected. The client
application cannot use this option in conjunction with the connect-via proxy
setting, which is activated from the client side.

4. In Read Threads, enter the number of threads that you want the broker to
allocate to read messages. The broker starts as many instances of the message
flow as are necessary to process current messages, up to this limit. The default
setting is 10.

5. In Write Threads, enter the number of threads that you want the broker to
allocate to write messages. The broker starts as many instances of the message
flow as are necessary to process current messages, up to this limit. The default
setting is 10.

6. In Authentication Threads, enter the number of threads that you want the broker
to allocate to user authentication checks. The user authentication check is
performed when a message is received. The broker starts as many instances of
the message flow as are necessary to process current messages, up to this limit.
The default setting is 10.

7. Select Description in the properties dialog navigator to enter a short
description, a long description, or both.

8. Click Apply to make the changes to the Real-timelnput node without closing
the properties dialog. Click OK to apply the changes and close the properties
dialog.

Click Cancel to close the dialog and discard all the changes that you have
made to the properties.

Connecting the terminals:

The Real-timelnput node routes each message that it retrieves successfully to the
out terminal. If this fails, the message is retried.
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Terminals and properties

The Real-timelnput node terminals are described in the following table.

Terminal Description
Out The output terminal to which the message is routed if it is successfully retrieved from
TMS.

The following tables describe the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).
The Real-timeInput node Basic properties are described in the following table.

Property M C Default Description

Port Yes Yes 0 The port number on which the input node listens for

publish or subscribe requests.
Authentication Yes No Cleared Select the check box to authenticate users.
Tunnel through HTTP | Yes No Cleared Select the check box to indicate that users use HTTP

tunneling. Clear the check box to indicate that HTTP
tunneling is not used.

Read Threads No Yes 10 The number of threads used for reading.
Write Threads No Yes 10 The number of threads used for writing.
Authentication Threads | No Yes 10 The number of threads used for accepting connections

and authenticating users.

The properties of the General Message Options for the Real-timelnput node are
described in the following table.

The Real-timelnput node Description properties are described in the following
table.

Property M C Default Description

Short Description No No A brief description of the node.

Long Description No No Text that describes the purpose of the node in the
message flow.

Real-timeOptimizedFlow node

152 Message Flows

This topic contains the following sections:

e |“Purpose” on page 153|

+ [“Using this node in a message flow” on page 153

» [“Configuring the Real-timeOptimizedFlow node” on page 153
¢ [“Terminals and properties” on page 154




Purpose

Use the Real-timeOptimizedFlow node to receive messages from clients that
connect using the WebSphere MQ Real-time Transport or the WebSphere MQ
Multicast Transport, and that use JMS application programming interfaces.

The Real-timeOptimizedFlow node is a complete message flow that provides a
high performance publish/subscribe message flow. The actions taken by this node
are all internalized; you cannot influence its operation except by configuring its
properties, and you cannot connect it to any other node.

This node also supports publication to, or subscription from, standard WebSphere
MQ applications, but its performance for these applications is not as good as the
performance achieved for JMS applications.

The Real-timeOptimizedFlow node is represented in the workbench by the
following icon:

H

Using this node in a message flow

Include the Real-timeOptimizedFlow node in a message flow when you want to
distribute messages through a broker to and from client applications that use JMS.

Configuring the Real-timeOptimizedFlow node

When you have put an instance of the Real-timeOptimizedFlow node into a
message flow, you can configure it. Right-click the node in the editor view and
select Properties. The node’s basic properties are displayed.

All mandatory properties for which you must enter a value (those that do not have
a default value defined) are marked with an asterisk on the properties dialog.

Configure the Real-timeOptimizedFlow node as follows:

1. In Port, identify the number of the port on which the node listens for publish
or subscribe requests from JMS applications. Ensure that the port number that
you specify does not conflict with any other listener service. There is no default
for this property; you must enter a value.

2. If you want users to authenticate that send messages on receipt of their
messages, select the Authentication check box. If you clear the check box (the
default setting), users are not authenticated.

3. If you want clients to use HTTP tunneling, select the Tunnel through HTTP
check box. If you clear the check box (the default setting), messages do not use
HTTP tunneling. If you select the check box, all client applications that connect
must use this feature. If they do not, their connection is rejected. The client
application cannot use this option in conjunction with the connect-via proxy
setting, which is activated from the client side.

4. In Read Threads, enter the number of threads that you want the broker to
allocate to read messages. The broker starts as many instances of the message
flow as are necessary to process current messages, up to this limit. The default
setting is 10.
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In Write Threads, enter the number of threads that you want the broker to
allocate to write messages. The broker starts as many instances of the message
flow as are necessary to process current messages, up to this limit. The default
setting is 10.

In Authentication Threads, enter the number of threads that you want the broker
to allocate to user authentication checks. The user authentication check is
performed when a message is received. The broker starts as many instances of
the message flow as are necessary to process current messages, up to this limit.
The default setting is 10.

Select Description in the properties dialog navigator to enter a short
description, a long description, or both.

Click Apply to make the changes to the Real-timeOptimizedFlow node without
closing the properties dialog. Click OK to apply the changes and close the
properties dialog.

Click Cancel to close the dialog and discard all the changes that you have
made to the properties.

Terminals and properties

The Real-timeOptimizedFlow node has no terminals. It is a complete message flow
and cannot be connected to other nodes to extend the message processing.

The following tables describe the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).

The Real-timeOptimizedFlow node Basic properties are described in the following

table.
Property M C Default Description
Port Yes Yes The port number on which the node listens for publish or
subscribe requests. You must provide a value for this
property.
Authentication Yes No Cleared Select the check box to authenticate users.
Tunnel through Yes No Cleared Select the check box to indicate that clients use HTTP
HTTP tunneling. Clear the check box to indicate that HTTP
tunneling is not used.
Read Threads No Yes 10 The number of threads used for reading.
Write Threads No Yes 10 The number of threads used for writing.
Authentication No Yes 10 The number of threads used for accepting connections and
Threads authenticating users.
The Real-timeOptimizedFlow node Description properties are described in the
following table.
Property C Default Description
Short Description No No A brief description of the node.
Long Description No No Text that describes the purpose of the node in the
message flow.
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SCADAInput node

This topic contains the following sections:
* ["Purpose”]

« [“Using this node in a message flow” on page 156
» [“Configuring the SCADAInput node” on page 156
* [“Terminals and properties” on page 158§|

Purpose

Use the SCADAInput node to receive messages from clients that connect to the
broker across the WebSphere MQ Telemetry Transport. SCADA device clients use
the MQIsdp protocol to send messages, which are converted by the SCADAInput
node into a format recognized by WebSphere Event Broker. The node also
establishes the processing environment for these messages.

Message flows that handle messages received from SCADA devices must always
start with a SCADAInput node. Set the SCADAInput node’s properties to control
the way that messages are received: for example, you can indicate that a message
is to be processed under transaction control.

When you deploy message flows containing SCADA nodes to a broker, you must
deploy them to a single execution group, regardless of the number of message
flows.

Because SCADA is primarily publish/subscribe, you typically include a Publication
node to terminate the flow. In scenarios where you do not want a Publication
node, you can include a SCADAOQOutput node. If you do so, you must also include
a SCADAInput node regardless of the source of the messages, because the
SCADAInput node provides the connectivity information required by the
SCADAOutput node.

If you include an output node in a message flow that starts with a SCADAInput
node, it can be any of the supported output nodes, including user-defined output
nodes. You can create a message flow that receives messages from SCADA devices
and generates messages for clients that use all supported transports to connect to
the broker, because you can configure the message flow to request the broker to
provide any necessary conversion.

You can request that the broker start or stop a SCADA listener by publishing
messages with a specific topic. This can be done for all ports or for a single port

identified in the message.

You cannot use SCADAInput nodes in message flows that are to be deployed on
z/0OS systems.

If you create a message flow to use as a subflow, you cannot use a standard input
node, you must use an instance of the Input node as the first node to create an in

terminal for the subflow.

If your message flow does not receive messages across SCADA connections, you
can choose one of the supported input nodes.

The SCADAInput node is represented in the workbench by the following icon:
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Using this node in a message flow

For an example of how to use this node, assume that you create a message flow
with a SCADAInput node that receives messages from a remote sensor when it
detects a change in its operating environment (for example, a drop in outside
temperature). You connect the node to an MQOutput node that makes these
messages available on a queue serviced by a WebSphere MQ application that
analyses and responds to the information received.

Configuring the SCADAInput node

When you have put an instance of the SCADAInput node into a message flow, you
can configure it. Right-click the node in the editor view and click Properties. The
node’s basic properties are displayed in the properties dialog.

All mandatory properties for which you must enter a value (those that do not have
a default value defined) are marked with an asterisk on the properties dialog.

Configure the SCADAInput node as follows:
1. Set the following basic properties:

a. The Enable listener on startup check box is initially selected. This means that
the listener for MQIsdp clients is initialized when the message flow is
deployed.

You can update the status of the listener by publishing on the control topic
$SYS/SCADA/MQIsdpListener/<port_number> with the Payload part of the
message set to ON or OFF.

b. Specify the Port number on which the MQIsdp server is to listen. This must
be a unique port, and must not conflict with other listeners (for example,
those set up for WebSphere MQ or WebSphere MQ Everyplace). The default
number is 1883.

C. Set the Max Threads value to indicate the maximum number of threads
available to the MQIsdp server to support clients. The default value is 500.
If you are using DB2 for your broker database, you must specify a value
that is less than or equal to the value that you have set for the DB2

configuration parameters maxappls and maxagents. See [Connecting to the]
‘

atabases| for further information.

d. Select Use Thread Pooling if you want the node to use a pool of threads to
service clients. If you select this option, the number of threads available to
the MQIsdp server is limited by Max Threads, which you are recommended
to set to a value of no more than 20. If you do not select this option, a new
thread is created for each client that connects. The check box is initially
clear.

Use this option only if you expect a large number of clients (greater than
200) to connect.

2. Select Advanced in the properties dialog navigator and set the required value
for Transaction Mode to define the transactional characteristics of how this
message is handled:

* If you select Automatic, the incoming message is received under syncpoint if
it is marked persistent, otherwise it is not. The transactionality of any
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derived messages subsequently sent by an output node is determined by the
incoming persistence property, unless the output node has explicitly
overridden transactionality.

* If you select Yes, the incoming message is received under syncpoint. Any
derived messages subsequently sent by an output node in the same instance
of the message flow are sent transactionally, unless the output node has
explicitly overridden transactionality.

* If you select No, the incoming message is not received under syncpoint. Any
derived messages subsequently sent by an output node in the flow are sent
non-transactionally, unless the output node has specified that the message
should be put under syncpoint.

3. Select Description in the properties dialog navigator to enter a short
description, a long description, or both.

4. Click Apply to make the changes to the SCADAInput node without closing the
properties dialog. Click OK to apply the changes and close the properties
dialog.

Click Cancel to close the dialog and discard all the changes that you have
made to the properties.

Connecting the terminals:

SCADAInput routes each message that it retrieves successfully to the out terminal.
If this fails, the message is propagated to the failure terminal; you can connect
nodes to this terminal to handle this condition. If you have not connected the
failure terminal, the message loops continually through the node until the problem
is resolved.

If the message is caught by this node after an exception has been thrown further
on in the message flow, the message is routed to the catch terminal. If you have
not connected the catch terminal, the message loops continually through the node
until the problem is resolved. Ensure that a node is always connected to this
terminal if there is the possibility of the message rolling back within a message
flow.

Configuring for coordinated transactions:

When you include a SCADAInput node in a message flow, the value that you set
for Transaction Mode defines whether messages are received under syncpoint:

* If you set it to Yes (the default), the message is received under syncpoint (that is,
within a WebSphere MQ unit of work). Any messages subsequently sent by an
output node in the same instance of the message flow are put under syncpoint,
unless the output node has explicitly overridden this.

* If you set it to Automatic, the message is received under syncpoint if the
incoming message is marked persistent. Otherwise, it is not. Any message
subsequently sent by an output node is put under syncpoint, as determined by
the incoming persistence property, unless the output node has explicitly
overridden this.

 If you set it to No, the message is not received under syncpoint. Any messages
subsequently sent by an output node in the flow are not put under syncpoint,
unless an individual output node has specified that the message should be put
under syncpoint.

(The MQOutput node is the only output node that you can configure to override
this option.)
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Terminals and properties

The SCADAInput node terminals are described in the following table.

Terminal Description
Failure The output terminal to which the message is routed if an error occurs.
Out The output terminal to which the message is routed if it is successfully retrieved from
the queue.
Catch The output terminal to which the message is routed if an exception is thrown
downstream and caught by this node.
The following tables describe the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).
The SCADAInput node Basic properties are described in the following table.
Property M C Default Description
Enable listener on Yes No Selected When the listener is started. If you select the check box,
startup the listener starts when the message flow is started by
the broker. If you clear the check box, the listener starts
on the arrival of a message on the specified port.
Port Yes Yes 1883 The port on which the SCADA protocol is listening.
Max Threads Yes Yes 500 The maximum number of threads to be started to
support SCADA devices.
Use Thread Pooling Yes Yes Cleared Whether to use thread pooling. If you select the check
box, this action is performed.

The SCADAInput node Advanced property are described in the following table.

Property

M

C

Default

Description

Transaction Mode

Yes

No

Yes

Whether the incoming message is received under
syncpoint. Valid values are Automatic, Yes, and No.

The Description properties of the SCADAInput node are described in the following

table.
Property M C Default Description
Short Description No No A brief description of the node.
Long Description No No Text that describes the purpose of the node in the
message flow.

SCADAOutput node
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This topic contains the following sections:

* |[“Purpose” on page 159

* [“Using this node in a message flow” on page 159

+ |[“Configuring the SCADAOQutput node” on page 159




* |"Terminals and properties” on page 160

Purpose

Use the SCADAOutput node to send a message to a client that connects to the
broker using the MQIsdp protocol across the WebSphere MQ Telemetry Transport.
You would typically use the Publication node to send output to a SCADA client.
The SCADAOutput node lets you write your own Publication node.

If you include a SCADAOutput node in a message flow, you must also include a
SCADAInput node, regardless of the source of the messages, because the
SCADAInput node provides the connectivity information required by the
SCADAOutput node.

When you deploy message flows containing SCADA nodes to a broker, you must
deploy them to a single execution group, regardless of the number of message
flows.

You cannot use the SCADAOutput node to change the transactional characteristics
of the message flow. The transactional characteristics set by the message flow’s
input node determine the transactional behavior of the flow.

You cannot use SCADAOutput nodes in message flows that you deploy to z/OS
systems.

If you create a message flow to use as a subflow, you cannot use a standard output
node; you must use an instance of the Output node to create an out terminal for
the subflow through which the message can be propagated.

If you do not want your message flow to send messages to a SCADA device, you
can choose another supported output node.

The SCADAOutput node is represented in the workbench by the following icon:

H

Using this node in a message flow

Use the Publication node to publish messages for SCADA devices. Use this node if
you want to process the publication messages in a particular way for these devices.

Configuring the SCADAOutput node

When you have put an instance of the SCADAOutput node into a message flow
you can configure it. Right-click the node in the editor view and click Properties.
The node’s description properties are displayed.

All mandatory properties for which you must enter a value (those that do not have
a default value defined) are marked with an asterisk on the properties dialog.

Configure the SCADAOutput node as follows:

1. Select Description in the properties dialog navigator to enter a short
description, a long description, or both.
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2. Click Apply to make the changes to the SCADAOQOutput node without closing
the properties dialog. Click OK to apply the changes and close the properties
dialog.

Click Cancel to close the dialog and discard all the changes that you have
made to the properties.

Now connect the node’s terminals to determine how it operates within this
message flow.

Connecting the terminals:

Connect the in terminal to the node from which messages bound for SCADA
destinations are routed.

Connect the out or failure terminal of this node to another node in this message
flow to send the message to an additional destination.

Terminals and properties

The SCADAOutput node terminals are described in the following table.

Terminal Description
In The input terminal that accepts a message for processing by the node.
Failure The output terminal to which the message is routed if a failure is detected when the
message is put to the output queue.
Out The output terminal to which the message is routed if it has been successfully put to
the output queue, and if further processing is required within this message flow.
The following table describes the node properties; the column headed M indicates
whether the property is mandatory (marked with an asterisk on the properties
dialog if you must enter a value when no default is defined), the column headed C
indicates whether the property is configurable (you can change the value when
you add the message flow to the bar file to deploy it).
The SCADAOutput node Description properties are described in the following
table.
Property M C Default Description
Short Description No No A brief description of the node.
Long Description No No Text that describes the purpose of the node in the
message flow.

User-defined nodes
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You can deploy user-defined nodes that are created and supplied by WebSphere
Message Broker Version 6.0 users or by independent software vendors and other
companies. Use these nodes in WebSphere Event Broker message flows, to add to
the function provided by the supplied or built-in nodes.

If WebSphere Message Broker Version 6.0 users and other vendors can provide
help information for user-defined nodes. If help information has been provided, it
is displayed after this topic when you install the user-defined node.




Supported code pages

Application messages must conform to supported code pages.

The message flows that you create, configure, and deploy to a broker ¢
application messages in any code page listed in the table. You can also

Inew code page converter,

an process
cenerate a

For detailed information about Chinese code page GB18030 support, see

kcode page GB18030” on page 188

WebSphere Event Broker supports the codepages given in the following tables by
default. To find a code page for a specific CCSID, search for a internal converter
name in the form ibm-ccsid, where ccsid is the CCSID you are looking for.

* |Unicode converters

+ [European and American language converters

+ |Asian language converters|

+ [Windows US and European converters|

* [MAC related converters|

+ |Hebrew, Cyrillic and ECMA language converters|

* [Indian language converters|
+ [EBCDIC converters|

Table 1. Unicode converters

Internal converter name

Aliases

UTE-8

UTEF-8
ibm-1208
ibm-1209
ibm-5304
ibm-5305
windows-65001
cp1208

UTEF-16

UTEF-16
ISO-10646-UCS-2
unicode
csUnicode

ucs-2

UTE-16BE

UTF-16BE
x-utf-16be
ibm-1200
ibm-1201
ibm-5297
ibm-13488
ibm-17584
windows-1201
cp1200

cp1201
UTF16_BigEndian
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Table 1. Unicode converters (continued)

Internal converter name

Aliases

UTF-16LE

UTF-16LE

x-utf-16le

ibm-1202

ibm-13490
ibm-17586
UTF16_LittleEndian

windows-1200

UTE-32

UTE-32
ISO-10646-UCS-4
csUCS4

ucs-4

UTF-32BE

UTF-32BE
UTF32_BigEndian
ibm-1232
ibm-1233

UTE-32LE

UTF-32LE
UTE32_LittleEndian
ibm-1234

UTF16_PlatformEndian

UTF16_PlatformEndian

UTF16_OppositeEndian

UTF16_OppositeEndian

UTE32_PlatformEndian

UTF32_PlatformEndian

UTF32_OppositeEndian

UTF32_OppositeEndian

UTE-7

UTF-7
windows-65000

IMAP-mailbox-name

IMAP-mailbox-name

SCsU sSCSyU

BOCU-1 BOCU-1
csBOCU-1

CESU-8 CESU-8

Table 2. European and American language converters

Internal converter name

Aliases

ISO-8859-1

ISO-8859-1

ibm-819

IBM819

cp819

latinl

8859_1

csISOLatin1 iso-ir-100
ISO_8859-1:1987 11 819




Table 2. European and American language converters (continued)

Internal converter name Aliases
US-ASCII US-ASCII
ASCII

ANSI_X3.4-1968
ANSI_X3.4-1986
1SO_646.irv:1991
iso_646.irv:1983
[SO646-US

us

csASCII

iso-ir-6

cp367

ascii7

646
windows-20127

gb18030

gb18030
ibm-1392
windows-54936

ibm-367_P100-1995

ibm-367_P100-1995
ibm-367 IBM367

ibm-912_P100-1995

ibm-912_P100-1995
ibm-912
is0-8859-2
1SO_8859-2:1987
latin2
csISOLatin2
iso-ir-101

12

8859 _2

cp912 912
windows-28592

ibm-913_P100-2000

ibm-913_P100-2000
ibm-913
is0-8859-3
1SO_8859-3:1988
latin3
csISOLatin3
iso-ir-109

13

8859_3

cp913

913
windows-28593
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Table 2. European and American language converters (continued)

Internal converter name

Aliases

ibm-914_P100-1995

ibm-914_P100-1995
ibm-914
is0-8859-4

latin4
csISOLatin4
iso-ir-110
1SO_8859-4:1988
14

8859_4

cp914

914
windows-28594

ibm-915_P100-1995

ibm-915_P100-1995
ibm-915
i50-8859-5

cyrillic
csISOLatinCyrillic
iso-ir-144
ISO_8859-5:1988
8859_5

cp915

915
windows-28595

ibm-1089_P100-1995

ibm-1089_P100-1995
ibm-1089
i50-8859-6

arabic
csISOLatinArabic
iso-ir-127
ISO_8859-6:1987
ECMA-114
ASMO-708
8859_6

cp1089

1089
windows-28596
1SO-8859-6-1
1SO-8859-6-E




Table 2. European and American language converters (continued)

Internal converter name

Aliases

ibm-813_P100-1995

ibm-813_P100-1995
ibm-813
is0-8859-7

greek

greek8
ELOT_928
ECMA-118
csISOLatinGreek
iso-ir-126
1SO_8859-7:1987
8859_7

cp813

813
windows-28597

ibm-916_P100-1995

ibm-916_P100-1995
ibm-916 iso-8859-8
hebrew
csISOLatinHebrew
iso-ir-138
1SO_8859-8:1988
1SO-8859-8-1 ISO-8859-8-E
8859_8

cp916

916
windows-28598

ibm-920_P100-1995

ibm-920_P100-1995
ibm-920
is0-8859-9
latin5
csISOLatin5
iso-ir-148
1SO_8859-9:1989
15
8859_9
cp920
920
windows-28599
ECMA-128

ibm-921_P100-1995

ibm-921_P100-1995
ibm-921
is0-8859-13
8859_13
cp921
921
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Table 2. European and American language converters (continued)

Internal converter name

Aliases

ibm-923_P100-1998

ibm-923_P100-1998
ibm-923
is0-8859-15
Latin-9

19

8859_15

latin0
csisolatin0
csisolatin9
is08859_15_fdis
cp923

923
windows-28605

Table 3. Asian language converters

Internal converter name

Aliases

ibm-942_P12A-1999

ibm-942_P12A-1999

ibm-942

ibm-932

cp932

shift_jis78

sjis78 ibm-942_VSUB_VPUA
ibm-932_VSUB_VPUA

ibm-943_P15A-2003

ibm-943_P15A-2003
ibm-943

Shift_JIS

MS_Kanji

csShift]JIS
windows-31j
csWindows31]
Xx-sjis

x-ms-cp932

cp932

windows-932
cp943c

IBM-943C

ms932

pck

sjis
ibm-943_VSUB_VPUA




Table 3. Asian language converters (continued)

Internal converter name

Aliases

ibm-943_P130-1999

ibm-943_P130-1999

ibm-943

Shift_JIS

cp943

943
ibm-943_VASCII_VSUB_VPUA

ibm-33722_P12A-1999

ibm-33722_P12A-1999
ibm-33722

ibm-5050

EUC-JP

Extended_UNIX_Code_Packed_Format_for_]

csEUCPkdFmtJapanese
X-EUC-JP

eucjis

windows-51932
ibm-33722_VPUA
IBM-euc]P

ibm-33722_P120-1999

ibm-33722_P120-1999
ibm-33722

ibm-5050

cp33722

33722
ibm-33722_VASCII_VPUA

ibm-954_P101-2000

ibm-954_P101-2000
ibm-954
EUC-JP

ibm-1373_1100-2002

ibm-1373_P100-2002
ibm-1373

windows-950

windows-950-2000

windows-950-2000
Bigh

csBigh

windows-950 x-bigh

ibm-950_P110-1999

ibm-950_P110-1999
ibm-950

cp950

950

macos-2566-10.2

macos-2566-10.2
Big5-HKSCS
bigbhk
HKSCS-BIG5
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Table 3. Asian language converters (continued)

Internal converter name Aliases

ibm-1375_P100-2003 ibm-1375_P100-2003
ibm-1375
Big5-HKSCS

ibm-1386_P100-2002 ibm-1386_P100-2002
ibm-1386

cp1386

windows-936
ibm-1386_VSUB_VPUA

windows-936-2000 windows-936-2000

GBK

CP936
MS936
windows-936

ibm-1383_P110-1999 ibm-1383_P110-1999
ibm-1383

GB2312

csGB2312

EUC-CN
ibm-eucCN
hp15CN

cp1383

1383
ibm-1383_VPUA

ibm-5478_P100-1995 ibm-5478_P100-1995
ibm-5478
GB_2312-80

chinese

iso-ir-58
csISO58GB231280
gb2312-1980
GB2312.1980-0

ibm-964_P110-1999 ibm-964_P110-1999
ibm-964

EUC-TW
ibm-eucTW
cns11643

cp964

964
ibm-964_VPUA
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Table 3. Asian language converters (continued)

Internal converter name Aliases

ibm-949_P110-1999

ibm-949_P110-1999

ibm-949

cp949

949
ibm-949_VASCII_VSUB_VPUA

ibm-949_P11A-1999

ibm-949_P11A-1999
ibm-949

cp949c
ibm-949_VSUB_VPUA

ibm-970_P110-1995

ibm-970_P110-1995
ibm-970 EUC-KR
KS_C_5601-1987
windows-51949
csEUCKR
ibm-eucKR
KSC_5601

5601
ibm-970_VPUA

ibm-971_P100-1995

ibm-971_P100-1995
ibm-971
ibm-971_VPUA

ibm-1363_P11B-1998

ibm-1363_P11B-1998
ibm-1363
KS_C_5601-1987
KS_C_5601-1989
KSC_5601
csKSC56011987
korean

is0-ir-149

5601

cp1363

ksc

windows-949
ibm-1363_VSUB_VPUA

ibm-1363_P110-1997

ibm-1363_P110-1997
ibm-1363
ibm-1363_VASCII_VSUB_VPUA
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Table 3. Asian language converters (continued)

Internal converter name

Aliases

windows-949-2000

windows-949-2000
windows-949
KS_C_5601-1987
KS_C_5601-1989
KSC_5601
csKSC56011987
korean

iso-ir-149

ms949

ibm-1162_P100-1999

ibm-1162_P100-1999
ibm-1162

ibm-874_P100-1995

ibm-874_P100-1995
ibm-874

ibm-9066

cp874

TIS-620

tis620.2533

eucTH

cp9066

windows-874-2000

windows-874-2000
TIS-620
windows-874
MS874

Table 4. Windows US and European converters

Internal converter name

Aliases

ibm-437_P100-1995

ibm-437_P100-1995
ibm-437

IBM437

cp437

437
csPC8CodePage437

windows-437

ibm-850_P100-1995

ibm-850_P100-1995
ibm-850 IBM850
cp850

850
csPC850Multilingual

windows-850




Table 4. Windows US and European converters (continued)

Internal converter name

Aliases

ibm-851_P100-1995

ibm-851_P100-1995
ibm-851

IBM851

cp851

851

csPC851

ibm-852_P100-1995

ibm-852_P100-1995
ibm-852

IBM852

cp852

852

csPCp852

windows-852

ibm-855_P100-1995

ibm-855_P100-1995
ibm-855

IBM855

cp855

855

csIBM855
csPCp855

ibm-856_P100-1995

ibm-856_P100-1995
ibm-856

cp856

856

ibm-857_P100-1995

ibm-857_P100-1995
ibm-857

IBM857

cp857

857

csIBM857

windows-857

ibm-858_P100-1997

ibm-858_P100-1997

ibm-858

IBMO00858

CCSID00858

CP00858
PC-Multilingual-850+euro cp858

ibm-860_P100-1995

ibm-860_P100-1995
ibm-860

IBM860

cp860

860

csIBM860

Message flows

171



172 Message Flows

Table 4. Windows US and European converters (continued)

Internal converter name

Aliases

ibm-861_P100-1995

ibm-861_P100-1995
ibm-861

IBM861

cp861

861

cp-is

csIBM861

windows-861

ibm-862_P100-1995

ibm-862_P100-1995
ibm-862

IBM862

cp862

862
csPC862LatinHebrew
DOS-862
windows-862

ibm-863_P100-1995

ibm-863_P100-1995
ibm-863

IBM863

cp863

863

csIBM863

ibm-864_X110-1999

ibm-864_X110-1999
ibm-864

IBM864

cp864

csIBM864

ibm-865_P100-1995

ibm-865_1100-1995
ibm-865

IBM865

cp865

865

csIBM865

ibm-866_P100-1995

ibm-866_P100-1995
ibm-866

IBM866

cp866

866

csIBM866
windows-866

ibm-867_P100-1998

ibm-867_1100-1998
ibm-867
cp867




Table 4. Windows US and European converters (continued)

Internal converter name

Aliases

ibm-868_P100-1995

ibm-868_P100-1995
ibm-868

IBM868

cp868

868

csIBM868

Cp-ar

ibm-869_P100-1995

ibm-869_P100-1995
ibm-869

1BM869

cp869

869

cp-gr

csIBM869

windows-869

ibm-878_P100-1996

ibm-878_P100-1996
ibm-878

KOI8-R

koi8

csKOI8R

cp878

ibm-901_P100-1999

ibm-901_P100-1999
ibm-901_P100-1999
ibm-901

ibm-902_P100-1999

ibm-902_P100-1999
ibm-902

ibm-922_P100-1999

ibm-922_P100-1999
ibm-922

cp922

922

ibm-4909_P100-1999

ibm-4909_P100-1999
ibm-4909

ibm-5346_P100-1998

ibm-5346_P100-1998
ibm-5346
windows-1250
cp1250

ibm-5347_P100-1998

ibm-5347_P100-1998
ibm-5347
windows-1251
cpl251
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Table 4. Windows US and European converters (continued)

Internal converter name

Aliases

ibm-5348_P100-1997

ibm-5348_1P100-1997
ibm-5348
windows-1252

cp1252

ibm-5349_P100-1998

ibm-5349_P100-1998
ibm-5349
windows-1253
cp1253

ibm-5350_1100-1998

ibm-5350_P100-1998
ibm-5350
windows-1254

cpl254

ibm-9447_P100-2002

ibm-9447_P100-2002
ibm-9447
windows-1255
cp1255

windows-1256-2000

windows-1256-2000
windows-1256
cp1256

ibm-9449_P100-2002

ibm-9449_P100-2002
ibm-9449
windows-1257

cpl257

ibm-5354_P100-1998

ibm-5354_P100-1998
ibm-5354
windows-1258
cp1258

ibm-1250_P100-1995

ibm-1250_P100-1995
ibm-1250

windows-1250

ibm-1251_P100-1995

ibm-1251_P100-1995
ibm-1251
windows-1251

ibm-1252_P100-2000

ibm-1252_1P100-2000
ibm-1252

windows-1252

ibm-1253_P100-1995

ibm-1253_P100-1995
ibm-1253

windows-1253




Table 4. Windows US and European converters (continued)

Internal converter name

Aliases

ibm-1254_P100-1995

ibm-1254_P100-1995
ibm-1254
windows-1254

ibm-1255_P100-1995

ibm-1255_P100-1995
ibm-1255

ibm-5351_P100-1998

ibm-5351_P100-1998
ibm-5351
windows-1255

ibm-1256_P110-1997

ibm-1256_P110-1997
ibm-1256

ibm-5352_100-1998

ibm-5352_P100-1998
ibm-5352

windows-1256

ibm-1257_P100-1995

ibm-1257_P100-1995
ibm-1257

ibm-5353_P100-1998

ibm-5353_P100-1998
ibm-5353
windows-1257

ibm-1258_P100-1997

ibm-1258_P100-1997
ibm-1258

windows-1258

Table 5. MAC related converters

Internal converter name

Aliases

macos-0_2-10.2

macos-0_2-10.2
macintosh

mac
csMacintosh
windows-10000

macos-6-10.2

macos-6-10.2
x-mac-greek
windows-10006

macgr

macos-7_3-10.2

macos-7_3-10.2
x-mac-cyrillic
windows-10007

maccy

macos-29-10.2

macos-29-10.2
X-mac-centraleurroman
windows-10029

X-mac-ce macce
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Table 5. MAC related converters (continued)

Internal converter name

Aliases

macos-35-10.2

macos-35-10.2
x-mac-turkish
windows-10081

mactr

ibm-1051_P100-1995

ibm-1051_P100-1995
ibm-1051
hp-roman8

roman§

r8

csHPRoman8

ibm-1276_P100-1995

ibm-1276_P100-1995
ibm-1276
Adobe-Standard-Encoding
csAdobeStandardEncoding

ibm-1277_1P100-1995

ibm-1277_P100-1995
ibm-1277
Adobe-Latin1-Encoding

Table 6. Hebrew, Cyrillic, and ECMA language converters

Internal converter name

Aliases

ibm-1006_P100-1995

ibm-1006_P100-1995
ibm-1006

cp1006

1006

ibm-1098_P100-1995

ibm-1098_P100-1995
ibm-1098

cp1098

1098

ibm-1124_P100-1996

ibm-1124_P100-1996
ibm-1124

cpll24

1124

ibm-1125_P100-1997

ibm-1125_P100-1997
ibm-1125 cp1125

ibm-1129_P100-1997

ibm-1129_P100-1997
ibm-1129

ibm-1131_P100-1997

ibm-1131_P100-1997
ibm-1131
cpl131

ibm-1133_P100-1997

ibm-1133_P100-1997
ibm-1133




Table 6. Hebrew, Cyrillic, and ECMA language converters (continued)

Internal converter name

Aliases

ibm-1381_P110-1999

ibm-1381_P110-1999
ibm-1381

cp1381

1381

ISO_2022,locale=ja,version=0

ISO_2022,locale=ja,version=0
1SO-2022-JP
csISO2022]P

ISO_2022,locale=ja,version=1

ISO_2022,locale=ja,version=1
1SO-2022-JP-1

JIS

JIS_Encoding

ISO_2022,locale=ja,version=2

ISO_2022,locale=ja,version=2
1SO-2022-JP-2
csISO2022]P2

ISO_2022,locale=ja,version=3

ISO_2022,locale=ja,version=3
J1S7
csJISEncoding

ISO_2022,locale=ja,version=4

ISO_2022,locale=ja,version=4
J1S8

1SO_2022,locale=ko,version=0

I1SO_2022,locale=ko,version=0
1SO-2022-KR
csISO2022KR

I1SO_2022 locale=ko,version=1

1SO_2022,locale=ko,version=1
ibm-25546

1SO_2022,locale=zh,version=0

1SO_2022,locale=zh,version=0
ISO-2022-CN

1SO_2022,locale=zh,version=1

I1SO_2022 locale=zh,version=1
1SO-2022-CN-EXT

HZ

HZ
HZ-GB-2312

ibm-897_P100-1995

ibm-897_P100-1995
ibm-897

JIS_X0201

X0201
csHalfWidthKatakana

Table 7. Indian language converters

Internal converter name

Aliases

ISCII,version=0 ISCII,version=0

x-iscii-de
windows-57002

iscii-dev
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Table 7. Indian language converters (continued)

Internal converter name

Aliases

ISCII,version=1 ISCII,version=1

x-iscii-be
windows-57003
iscii-bng
windows-57006

X-iscii-as

ISCII,version=2 ISCII,version=2

x-iscii-pa
windows-57011

iscii-gur

ISCII,version=3 ISCII,version=3

x-iscii-gu
windows-57010

iscii-guj

ISCII,version=4 ISCII,version=4

X-iscii-or
windows-57007

iscii-ori

ISCII,version=5 ISCII,version=5

x-iscii-ta
windows-57004

iscii-tml

ISCII,version=6 ISCII,version=6

X-iscii-te
windows-57005
iscii-tlg

ISCII,version=7 ISCII,version=7 x-iscii-ka
windows-57008
iscii-knd

ISCII,version=8 ISCII,version=8 x-iscii-ma
windows-57009
iscii-mlm

Table 8. EBCDIC converters

Internal converter name Aliases

LMBCS-1 LMBCS-1
Imbcs

LMBCS-2 LMBCS-2

LMBCS-3 LMBCS-3

LMBCS-4 LMBCS-4

LMBCS-5 LMBCS-5

LMBCS-6 LMBCS-6

LMBCS-8 LMBCS-8

LMBCS-11 LMBCS-11

LMBCS-16 LMBCS-16




Table 8. EBCDIC converters (continued)

Internal converter name Aliases
LMBCS-17 LMBCS-17
LMBCS-18 LMBCS-18
LMBCS-19 LMBCS-19
ibm-37_P100-1995 ibm-37_P100-1995
ibm-37
IBM037
ibm-037

ebcdic-cp-us
ebcdic-cp-ca
ebcdic-cp-wt
ebedic-cp-nl
csIBM037
cp037

037

cpibm37
cp37

ibm-273_P100-1995

ibm-273_P100-1995
ibm-273

1BM273

CP273

csIBM273
ebcdic-de
cpibm273

273

ibm-277_P100-1995

ibm-277_P100-1995
ibm-277

IBM277

cp277
EBCDIC-CP-DK
EBCDIC-CP-NO
csIBM277
ebcdic-dk
cpibm277

277
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Table 8. EBCDIC converters (continued)

Internal converter name

Aliases

ibm-278_P100-1995

ibm-278_P100-1995
ibm-278

IBM278

cp278

ebcdic-cp-fi
ebcdic-cp-se
csIBM278
ebedic-sv
cpibm278

278

ibm-280_P100-1995

ibm-280_P100-1995
ibm-280

IBM280

CP280

ebcdic-cp-it
csIBM280
cpibm280

280

ibm-284_P100-1995

ibm-284_P100-1995
ibm-284

IBM284

CP284

ebcdic-cp-es
csIBM284
cpibm284

284

ibm-285_P100-1995

ibm-285_P100-1995
ibm-285

IBM285

CP285
ebedic-cp-gb
csIBM285
ebcdic-gb
cpibm285

285

ibm-290_P100-1995

ibm-290_P100-1995
ibm-290

IBM290

cp290
EBCDIC-JP-kana
csIBM290




Table 8. EBCDIC converters (continued)

Internal converter name

Aliases

ibm-297_P100-1995

ibm-297_P100-1995
ibm-297

IBM297

cp297

ebcdic-cp-fr
csIBM297
cpibm297

297

ibm-420_X120-1999

ibm-420_X120-1999
1BM420

cp420
ebcdic-cp-arl
csIBM420 420

ibm-424_P100-1995

ibm-424_P100-1995
ibm-424

1BM424

cp424

ebcdic-cp-he
csIBM424

424

ibm-500_P100-1995

ibm-500_P100-1995
ibm-500

IBM500

CP500
ebcdic-cp-be
csIBM500
ebcdic-cp-ch
cpibm500

500

ibm-803_P100-1999

ibm-803_P100-1999
ibm-803
cp803

ibm-838_P100-1995

ibm-838_P100-1995
ibm-838

IBM-Thai
csIBMThai

cp838

838

ibm-9030
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Table 8. EBCDIC converters (continued)

Internal converter name

Aliases

ibm-870_P100-1995

ibm-870_P100-1995
ibm-870

IBM870

CP870
ebcdic-cp-roece
ebcdic-cp-yu
csIBM870

ibm-871_P100-1995

ibm-871_P100-1995
ibm-871

IBM871
ebcdic-cp-is
csIBM871

CP871

ebcdic-is

cpibm871

871

ibm-875_P100-1995

ibm-875_1P100-1995
ibm-875

IBM875

cp875

875

ibm-918_P100-1995

ibm-918_P100-1995
ibm-918

IBM918

CP918
ebcdic-cp-ar2
csIBM918

ibm-930_P120-1999

ibm-930_P120-1999
ibm-930

ibm-5026

cp930

cpibm930

930

ibm-933_P110-1995

ibm-933_P110-1995
ibm-933

cp933

cpibm933

933

ibm-935_P110-1999

ibm-935_P110-1999
ibm-935

cp935

cpibm935

935




Table 8. EBCDIC converters (continued)

Internal converter name

Aliases

ibm-937_P110-1999

ibm-937_P110-1999
ibm-937

cp937

cpibm937

937

ibm-939_P120-1999

ibm-939_P120-1999
ibm-939

ibm-931

ibm-5035

cp939

939

ibm-1025_P100-1995

ibm-1025_P100-1995
ibm-1025

cp1025

1025

ibm-1026_P100-1995

ibm-1026_P100-1995
ibm-1026

1IBM1026

CP1026

csIBM1026

1026

ibm-1047_P100-1995

ibm-1047_P100-1995
ibm-1047

1BM1047

cpibm1047

ibm-1097_P100-1995

ibm-1097_P100-1995
ibm-1097

cp1097

1097

ibm-1112_P100-1995

ibm-1112_P100-1995
ibm-1112

cplll2

1112

ibm-1122_P100-1999

ibm-1122_P100-1999
ibm-1122

cpl122

1122

ibm-1123_P100-1995

ibm-1123_P100-1995
ibm-1123

cpl1123

1123

cpibm1123
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Table 8. EBCDIC converters (continued)

Internal converter name

Aliases

ibm-1130_P100-1997

ibm-1130_P100-1997
ibm-1130

ibm-1132_P100-1998

ibm-1132_P100-1998
ibm-1132

ibm-1140_P100-1997

ibm-1140_P100-1997
ibm-1140

IBM01140
CCSID01140
CP01140

cp1140

cpibm1140
ebcdic-us-37+euro

ibm-1141_P100-1997

ibm-1141_P100-1997
ibm-1141

IBMO01141
CCSID01141
CP01141

cpll4l

cpibm1141
ebcdic-de-273+euro

ibm-1142_P100-1997

ibm-1142_P100-1997
ibm-1142

IBMO01142
CCSID01142
CP01142

cpl142

cpibm1142
ebcdic-dk-277+euro
ebcdic-no-277+euro

ibm-1143_P100-1997

ibm-1143_P100-1997
ibm-1143

IBM01143
CCSID01143
CP01143

cpl143

cpibm1143
ebcdic-fi-278+euro

ebedic-se-278+euro




Table 8. EBCDIC converters (continued)

Internal converter name

Aliases

ibm-1144_P100-1997

ibm-1144_P100-1997
ibm-1144

IBMO01144
CCSID01144
CP01144

cpll44

cpibm1144
ebcdic-it-280+euro

ibm-1145_P100-1997

ibm-1145_P100-1997
ibm-1145

1BM01145
CCSID01145
CP01145

cpl145

cpibm1145
ebcdic-es-284+euro

ibm-1146_P100-1997

ibm-1146_P100-1997
ibm-1146

IBM01146
CCSID01146
CP01146

cpl146

cpibm1146
ebcdic-gb-285+euro

ibm-1147_P100-1997

ibm-1147_P100-1997
ibm-1147

IBM01147
CCSIDO01147
CP01147

cpl147

cpibm1147
ebcdic-fr-297+euro

ibm-1148_P100-1997

ibm-1148_P100-1997
ibm-1148

IBM01148
CCSID01148
CP01148

cpl148

cpibm1148

ebcdic-international-500+euro
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Table 8. EBCDIC converters (continued)

Internal converter name

Aliases

ibm-1149_P100-1997

ibm-1149_P100-1997
ibm-1149

IBMO01149
CCSID01149
CP01149

cp1149

cpibm1149

ebedic-is-871+euro

ibm-1153_P100-1999

ibm-1153_P100-1999
ibm-1153
cpibm1153

ibm-1154_P100-1999

ibm-1154_P100-1999
ibm-1154
cpibm1154

ibm-1155_P100-1999

ibm-1155_P100-1999
ibm-1155
cpibm1155

ibm-1156_P100-1999

ibm-1156_P100-1999
ibm-1156
cpibm1156

ibm-1157_P100-1999

ibm-1157_P100-1999
ibm-1157
cpibm1157

ibm-1158_P100-1999

ibm-1158_P100-1999
ibm-1158
cpibm1158

ibm-1160_P100-1999

ibm-1160_P100-1999
ibm-1160
cpibm1160

ibm-1164_P100-1999

ibm-1164_P100-1999
ibm-1164
cpibm1164

ibm-1364_P110-1997

ibm-1364_P110-1997
ibm-1364
cpl364

ibm-1371_P100-1999

ibm-1371_P100-1999
ibm-1371
cpibm1371

ibm-1388_P103-2001

ibm-1388_P103-2001
ibm-1388
ibm-9580




Table 8. EBCDIC converters (continued)

Internal converter name

Aliases

ibm-1390_P110-2003

ibm-1390_P110-2003
ibm-1390
cpibm1390

ibm-1399_P110-2003

ibm-1399_P110-2003
ibm-1399

ibm-16684_P110-2003

ibm-16684_P110-2003
ibm-16684

ibm-4899_P100-1998

ibm-4899_P100-1998
ibm-4899
cpibm4899

ibm-4971_P100-1999

ibm-4971_P100-1999
ibm-4971
cpibm4971

ibm-12712_P100-1998

ibm-12712_P100-1998
ibm-12712
cpibm12712
ebcdic-he

ibm-16804_X110-1999

ibm-16804_X110-1999
ibm-16804
cpibm16804
ebcdic-ar

ibm-1137_P100-1999

ibm-1137_P100-1999
ibm-1137

ibm-5123_P100-1999

ibm-5123_P100-1999
ibm-5123

ibm-8482_1100-1999

ibm-8482_P100-1999
ibm-8482

ibm-37_P100-1995,swaplfnl

ibm-37_P100-1995,swaplfnl
ibm-37-s390
ibm037-s390

ibm-1047_P100-1995,swaplfnl

ibm-1047_P100-1995,swaplinl
ibm-1047-s390

ibm-1140_P100-1997, ,swaplfnl

ibm-1140_P100-1997,swaplfnl
ibm-1140-s390

ibm-1142_P100-1997, ,swaplfnl

ibm-1142_P100-1997, ,swaplfnl
ibm-1142-s390

ibm-1143_P100-1997,swaplfnl

ibm-1143_P100-1997,swaplfnl
ibm-1143-s390

ibm-1144_P100-1997,swaplfnl

ibm-1144_P100-1997 ,swaplfnl
ibm-1144-s390
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Table 8. EBCDIC converters (continued)

Internal converter name Aliases

ibm-1145_P100-1997,swaplfnl ibm-1145_P100-1997,swaplfnl
ibm-1145-s390

ibm-1146_P100-1997 swaplfnl ibm-1146_P100-1997,swaplfnl
ibm-1146-s390

ibm-1147_P100-1997,swaplinl ibm-1147_P100-1997 swaplfnl
ibm-1147-s390

ibm-1148_P100-1997,swaplfnl ibm-1148_P100-1997,swaplfnl
ibm-1148-s390

ibm-1149_P100-1997 swaplfnl ibm-1149_P100-1997,swaplfnl
ibm-1149-s390

ibm-1153_P100-1999,swaplfnl ibm-1153_P100-1999,swaplfnl
ibm-1153-s390

ibm-12712_P100-1998 swaplfnl ibm-12712_P100-1998 swaplfnl
ibm-12712-5390

ibm-16804_X110-1999 swaplinl ibm-16804_X110-1999 swaplfnl
ibm-16804-s390

ebcdic-xml-us ebcdic-xml-us

Chinese code page GB18030

There are some restrictions if you are working with messages in Chinese code page
GB18030.

The broker can input and output application messages encoded in code page
IBM-5488 (GB18030 support) with the following restrictions:

* To enable support for GB18030 in the workbench and Configuration Manager:

— If you run a workbench or Configuration Manager that requires GB18030
support on a Windows 2000 system, apply the GB18030 patch supplied by
Microsoft. This support is included in Windows XP.

— Create the Configuration Manager configuration repository with a code set of
UTF-8.

— Change the text font preference in the workbench to use GB18030:
- Select Preferences in the Window menu.

- Expand the Workbench item on the left side of the Preferences dialog (click
the plus sign) and select Fonts.

- In the Fonts display, select Text Font. Click Change, and select the correct
values in the Fonts selection dialog.

- Click OK to confirm the selection and close the dialog.
- Click Apply to apply the change, then OK to close the Preference dialog.
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Data integrity within message flows

Code pages in which data is manipulated must be compatible between brokers and
databases.

Subscription data retrieved from client applications (for example, topics from
publishers and subscribers, and content filters from subscribers) and the character
data entered through the workbench (for example, message flow names) are stored
in the configuration repository. This data is translated from its originating code
page to the code page of the process in which the broker or Configuration
Manager is running, and then by the database manager to the code page in which
the database or databases were created.

To preserve data consistency and integrity, ensure that all this subscription data
and workbench character data is originated in a compatible code page to the two
code pages to which it is translated. If you do not do so, you might get
unpredictable results and lose data.

Data stored in the broker database is not affected in this way.

Configurable message flow properties

When you add a message flow to a broker archive (bar) file in preparation for
deploying it to a broker, you can set additional properties that influence its
runtime operation. These properties are available for review and update when you
select the Configure tab for the broker archive file.

Additional Instances
Specifies the number of additional threads that the broker can use to
service the message flow. These additional threads are created only if there
are sufficient input messages. You can have up to 256 threads. The default
value is 0. Additional threads can increase the throughput of a message
flow but you should consider the potential impact on message order.

If the message flow processes WebSphere MQ messages, you can configure
the message flow to control the message order. Set the Order Mode property
on the MQInput node accordingly. You might also need to set the Commit
by Message Group and Logical Order properties.

The broker opens the input queue as shared (using the
MQOO_INPUT_SHARED option), so you must ensure that the input
queue has been defined with the SHARE property to enable multiple
broker threads to read from the same input queue.

For more information about the node properties, refer to the
lnode” on page 134

Commit Count
Specifies how many input WebSphere MQ messages are processed by a
message flow before a syncpoint is taken (by issuing an MQCMIT).

Set this property only if you have set Additional Instances to 0.

The default value of 1 is also the minimum permitted value. Change this
property to avoid frequent MQCMIT calls when messages are being
processed quickly and the lack of an immediate commit can be tolerated
by the receiving application.
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Use the Commit Interval to ensure that a commit is performed periodically
when not enough messages are received to fulfill the Commit Count.

This property has no effect if the message flow does not process
WebSphere MQ messages.

Commit Interval
For WebSphere MQ messages, specifies a time interval at which a commit
is taken when the Commit Count property is greater than 1 (that is, where
the message flow is batching messages), but the number of messages
processed has not reached the value of the Commit Count property. It
ensures that a commit is performed periodically when not enough
messages are received to fulfill the Commit Count.

The time interval is specified in seconds , as a decimal number with a
maximum of 3 decimal places (millisecond granularity). The value must be
in the range 0.000 through 60.000. The default value is 0.

Set this property only if you have set Additional Instances to 0.

This property has no effect if the message flow does not process
WebSphere MQ messages.

User-defined properties
A user-defined property (UDP) is a user-defined constant whose initial
value can be modified, at design time, by the [Message Flow editor] or
overridden, at deployment time, by the [Broker Archive editor| The
advantage of UDDs is that their values can be changed by operational staff
at deployment time. If, for example, you use UDPs to hold configuration
data, you can configure a message flow for a particular machine, task, or
environment at deployment time, without having to change the code at the
node level.

For introductory information about UDPs, see [User-defined propertied For
information about configuring UDPs at deployment time, see .

You can view and update other configurable properties for the message flow. The
properties that are displayed depend on the nodes within the message flow; some
have no configurable properties to display. The node properties that are
configurable are predominantly system-related properties that are likely to change
for each broker to which the message flow is deployed. These properties include
the names of WebSphere MQ queues and queue managers. For full details of
configurable properties for a node, see the appropriate node description.

Message flow porting considerations
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If you have configured a message flow that runs on a broker on a distributed
system, and you now want to deploy it to a broker that runs on z/OS, be aware of
the following:

WebSphere MQ queue manager and queue names
There are restrictions on WebSphere MQ resource names on z/OS:
* The queue manager name cannot be greater than four characters.

* All queue names must be in uppercase. Although using quotation marks
preserves the case, certain WebSphere MQ activities on z/OS cannot find
the queue names being referenced.

For more information about configuring on z/OS, refer to the WebSphere
MQ for z/OS Concepts and Planning Guide.



File system references

File system references must reflect a UNIX file path. If you deploy a
message flow to z/OS that you have previously run on Windows, you
might have to make changes. If you have previously deployed the message
flow to a UNIX system (AIX, Linux, Solaris, or HP-UX), you do not have
to make any changes.

Message flow accounting and statistics data

This section provides information for message flow accounting and statistics data.

Details of the information that is collected, and the output formats in which it can
be recorded, are provided:

Statistics detailsl
Data formats|

Example output]

You can also find information on how to use accounting and statistics data to
improve the performance of a message flow in this [developerWorks article on|

imessage flow performance)

Message flow accounting and statistics details

This topic identifies the statistics that are collected for message flows.

The details that are available are:

Message flow statistics
One record is created for each message flow in an execution group. Each
record contains the following details:

Message flow name and UUID

Execution group name and UUID

Broker name and UUID

Start and end times for data collection

Type of data collected (snapshot or archive)

CPU and elapsed time spent processing messages
CPU and elapsed time spent waiting for input
Number of messages processed

Minimum, maximum, and average message sizes
Number of threads available and maximum assigned at any time
Number of messages committed and backed out
Accounting origin

Thread statistics
One record is created for each thread assigned to the message flow. Each
record contains the following details:

Thread number (this has no significance and is for identification only)
CPU and elapsed time spent processing messages

CPU and elapsed time spent waiting for input

Number of messages processed

Minimum, maximum, and average message sizes

Node statistics
One record is created for each node in the message flow. Each record
contains the following details:

Node name
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* Node type (for example MQInput)

* CPU time spent processing messages

* Elapsed time spent processing messages

* Number of times that the node is invoked

* Number of messages processed

* Minimum, maximum, and average message sizes

Terminal statistics
One record is created for each terminal on a node. Each record contains the
following details:
e Terminal name
* Terminal type (input or output)
* Number of times that a message is propagated through this terminal

For further details, see the description of the output format that you are interested
in.

Message flow accounting and statistics data formats

The message flow accounting and statistics data is written in one of three formats:
* XML publication|

* [User trace entries|

+ |z/OS SMF records|

XML publication for message flow accounting and statistics data

This topic describe the information that is written to the XML publication for
message flow accounting and statistics data. The data is created within the folder
WMQIStatisticsAccounting, which contains subfolders that provide more detailed
information. All folders are present within the publication even if you set current
data collection parameters to specify that the relevant data is not collected.

Snapshot data is used for performance analysis, and is published as retained and
non-persistent. Archive data is used for accounting where an audit trail might be
required, and is published as retained and persistent. All publications are global
and can be collected by a subscriber that has registered anywhere in the network.
They can also be collected by more than one subscriber.

If you are concerned about the safe delivery of these messages, for example for
charging purposes, use a secure delivery mechanism such as WebSphere MQ.

The folders and subfolders in the XML publication have the following identifiers:
* WMQIStatisticsAccounting

* MessageFlow

* Threads

* ThreadStatistics

* Nodes

* NodesStatistics

* TerminalStatistics

The tables provided here describe the contents of each of these folders in the order
listed above.

The table below describes the general accounting and statistics information, created
in folder WMQIStatisticsAccounting.
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Field Data type Details
RecordType Character Type of output, one of:
* Archive
* Snapshot
RecordCode Character Reason for output, one of:
* MajorInterval
* Snapshot
* Shutdown
¢ ReDeploy
e StatsSettingsModified
The table below describes the message flow statistics information, created in folder
MessageFlow.
Field Data type Details
BrokerLabel Character Broker name
(maximum 32)
BrokerUUID Character Broker universal unique
(maximum 32) |identifier
ExecutionGroupName Character Execution group name
(maximum 32)
ExecutionGroupUUID Character Execution group universal
(maximum 32) |unique identifier
MessageFlowName Character Message flow name
(maximum 32)
StartDate Character Interval start date
(YYYY-MM-DD)
StartTime Character Interval start time
(HH:MM:SS:NNNNNN)
EndDate Character Interval end date
(YYYY-MM-DD)
EndTime Character Interval end time
(HH:MM:SS:NNNNNN)
TotalElapsedTime Numeric Total elapsed time spent
processing input messages
(microseconds)
MaximumElapsedTime Numeric Maximum elapsed time spent
processing an input message
(microseconds)
MinimumElapsedTime Numeric Minimum elapsed time spent
processing an input message
(microseconds)
Total CPUTime Numeric Total CPU time spent
processing input messages
(microseconds)
MaximumCPUTime Numeric Maximum CPU time spent
processing an input message
(microseconds)
MinimumCPUTime Numeric Minimum CPU time spent
processing an input message
(microseconds)
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(for example, a format error).

1. For example, a conversion error occurs when the message is got from the queue.
2. These include exceptions that are thrown downstream of the input node, and errors detected by the input node
after it has successfully retrieved the message from the queue but before it has propagated it to the out terminal

Field Data type Details
CPUTimeWaitingForInputMessage Numeric Total CPU time spent waiting
for input messages
(microseconds)
ElapsedTimeWaitingForInputMessage Numeric Total elapsed time spent
waiting for input messages
(microseconds)
TotalInputMessages Numeric Total number of messages
processed
TotalSizeOfInputMessages Numeric Total size of input messages
(bytes)
MaximumSizeOfInputMessages Numeric Maximum input message
size (bytes)
MinimumSizeOfInputMessages Numeric Minimum message input size
(bytes)
NumberOfThreadsInPool Numeric Number of threads in pool
TimesMaximumNumberofThreadsReached Numeric Number of times the
maximum number of threads
is reached
TotalNumberOfMQErrors? Numeric Number of MQGET errors
(MQInput node)
TotalNumberOfMessagesWithErrors® Numeric Number of messages that
contain errors
TotalNumberOfErrorsProcessingMessages Numeric Number of errors processing
a message
TotalNumberOfTimeOutsWaitingForRepliesToAggregateMessages | Numeric Number of timeouts
processing a message
(AggregateReply node only)
TotalNumberOfCommits Numeric Number of transaction
commits
TotalNumberOfBackouts Numeric Number of transaction
backouts
AccountingOrigin Character Accounting origin
(maximum 32)
Notes:

The table below describes the thread statistics information, created in folder

Threads.

Field Data type

Details

Number Numeric

Number of thread statistics subfolders within Threads
folder

The table below describes the thread statistics information for each individual
thread, created in folder ThreadStatistics, a subfolder of Threads.
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Field Data type Details

Number Numeric Relative thread number in pool

TotalNumberOfInputMessages Numeric Total number of messages processed by
thread

TotalElapsedTime Numeric Total elapsed time spent processing input
messages (microseconds)

Total CUPTime Numeric Total CPU time spent processing input
messages (microseconds)

CPUTimeWaitingForInputMessage Numeric Total CPU time spent waiting for input
messages (microseconds)

ElapsedTimeWaitingForInputMessage Numeric Total elapsed time spent waiting for input
messages (microseconds)

TotalSizeOfInputMessages Numeric Total size of input messages (bytes)

MaximumSizeOfInputMessages Numeric Maximum size of input messages (bytes)

MinimumSizeOfInputMessages Numeric Minimum size of input messages (bytes)

The table below describes the node statistics information, created in folder Nodes.

Field Data type Details
Number Numeric Number of node statistics subfolders within Nodes
folder
The table below describes the node statistics information for each individual node,
created in folder NodesStatistics, a subfolder of Nodes.

Field Data type Details

Label Character Name of node (Label)

Type Character Type of node

TotalElapsedTime Numeric Total elapsed time spent processing input
messages (microseconds)

MaximumElapsedTime Numeric Maximum elapsed time spent processing input
messages (microseconds)

MinimumElapsedTime Numeric Minimum elapsed time spent processing input
messages (microseconds)

Total CPUTime Numeric Total CPU time spent processing input messages
(microseconds)

MaximumCPUTime Numeric Maximum CPU time spent processing input
messages (microseconds)

MinimumCPUTime Numeric Minimum CPU time spent processing input
messages (microseconds)

CountOfInvocations Numeric Total number of messages processed by this node

NumberOfInputTerminals Numeric Number of input terminals

NumberOfOutputTerminals Numeric Number of output terminals

The table below describes the terminal statistics information, created in folder
TerminalStatistics.
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Field Data type Details
Label Character Name of terminal
Type Character Type of terminal, one of:
e Input
* Output
CountOfInvocations Numeric Total number of invocations
User trace entries for message flow accounting and statistics
data
This topic describe the information that is written to the user trace log for message
flow accounting and statistics data.
The data records are identified by the following message numbers:
* BIP23801I
» BIP23811
» BIP23821
» BIP23831
The inserts for each message are described in the following tables, in the order
shown above.
The following table describes the inserts in message BIP2380I. One message is
written for the message flow.
Field Data type Details
ProcessID Numeric Process ID
Key Numeric Key used to associate related
accounting and statistics BIP
messages
Type Character Type of output, one of:
* Archive
* Snapshot
Reason Character Reason for output, one of:
* MajorInterval
* Snapshot
* Shutdown
* ReDeploy
e StatsSettingsModified
BrokerLabel Character Broker name
(maximum 32)
BrokerUUID Character Broker universal unique
(maximum 32) identifier
ExecutionGroupName Character Execution group name
(maximum 32)
ExecutionGroupUUID Character Execution group universal
(maximum 32) unique identifier
MessageFlowName Character Message flow name
(maximum 32)
StartDate Character Interval start date

(YYYY-MM-DD)
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Field

Data type

Details

StartTime

Character

Interval start time
(HH:MM:SS:NNNNNN)

EndDate

Character

Interval end date
(YYYY-MM-DD)

EndTime

Character

Interval end time
(HH:MM:SS:NNNNNN)

TotalElapsedTime

Numeric

Total elapsed time spent
processing input messages
(microseconds)

MaximumElapsedTime

Numeric

Maximum elapsed time spent
processing an input message
(microseconds)

MinimumElapsedTime

Numeric

Minimum elapsed time spent
processing an input message
(microseconds)

Total CPUTime

Numeric

Total CPU time spent
processing input messages
(microseconds)

MaximumCPUTime

Numeric

Maximum CPU time spent
processing an input message
(microseconds)

MinimumCPUTime

Numeric

Minimum CPU time spent
processing an input message
(microseconds)

CPUTimeWaitingForInputMessage

Numeric

Total CPU time spent waiting
for input messages
(microseconds)

ElapsedTimeWaitingForInputMessage

Numeric

Total elapsed time spent
waiting for input messages
(microseconds)

TotallInputMessages

Numeric

Total number of messages
processed

TotalSizeOfInputMessages

Numeric

Total size of input messages
(bytes)

MaximumSizeOfInputMessages

Numeric

Maximum input message
size (bytes)

MinimumSizeOfInputMessages

Numeric

Minimum input message size
(bytes)

NumberOfThreadsInPool

Numeric

Number of threads in pool

TimesMaximumNumberofThreadsReached

Numeric

Number of times the
maximum number of threads
is reached

TotalNumberOfMQErrors’

Numeric

Number of MQGET errors
(MQInput node)

TotalNumberOfMessagesWithErrors®

Numeric

Number of messages that
contain errors

TotalNumberOfErrorsProcessingMessages

Numeric

Number of errors processing
a message
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Field Data type Details

TotalNumberOfTimeOutsWaitingForRepliesToAggregateMessages | Numeric Number of timeouts
processing a message
(AggregateReply node only)

TotalNumberOfCommits Numeric Number of transaction
commits

TotalNumberOfBackouts Numeric Number of transaction
backouts

AccountingOrigin Character Accounting origin

(maximum 32)
Notes:

1. For example, a conversion error occurs when the message is got from the queue.
2. These include exceptions that are thrown downstream of the input node, and errors detected by the input node
after it has successfully retrieved the message from the queue (for example, a format error).

The following table describes the inserts in message BIP2381I. One message is
written for each thread.

Field Data type Details

ProcessID Numeric Process ID

Key Numeric Key used to associate related accounting and
statistics BIP messages

Number Numeric Relative thread number in pool

TotalNumberOfInputMessages Numeric Total number of messages processed by
thread

TotalElapsedTime Numeric Total elapsed time spent processing input
messages (microseconds)

Total CUPTime Numeric Total CPU time spent processing input
messages (microseconds)

CPUTimeWaitingForInputMessage Numeric Total CPU time spent waiting for input
messages (microseconds)

ElapsedTimeWaitingForInputMessage Numeric Total elapsed time spent waiting for input
messages (microseconds)

TotalSizeOfInputMessages Numeric Total size of input messages (bytes)

MaximumSizeOfInputMessages Numeric Maximum size of input messages (bytes)

MinimumSizeOfInputMessages Numeric Minimum size of input messages (bytes)

The following table describes the inserts in message BIP2382I. One message is
written for each node.

Field Data type Details

ProcessID Numeric Process ID

Key Numeric Key used to associate related accounting and
statistics BIP messages

Label Character Name of node (Label)

Type Character Type of node

TotalElapsedTime Numeric Total elapsed time spent processing input

messages (microseconds)
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Field Data type Details

MaximumElapsedTime Numeric Maximum elapsed time spent processing input
messages (microseconds)

MinimumElapsedTime Numeric Minimum elapsed time spent processing input
messages (microseconds)

Total CPUTime Numeric Total CPU time spent processing input messages
(microseconds)

MaximumCPUTime Numeric Maximum CPU time spent processing input
messages (microseconds)

MinimumCPUTime Numeric Minimum CPU time spent processing input
messages (microseconds)

CountOfInvocations Numeric Total number of messages processed by this node

NumberOfInputTerminals Numeric Number of input terminals

NumberOfOutputTerminals Numeric Number of output terminals

The following table describes the inserts in message BIP23831. One message is
written for each terminal on each node.

Field Data type Details
ProcessID Numeric Process ID
Key Numeric Key used to associate related accounting and
statistics BIP messages
Label Character Name of terminal
Type Character Type of terminal, one of:
e Input
e Output
CountOfInvocations Numeric Total number of invocations
z/OS SMF records for message flow accounting and statistics
data
This topic describes the information that is written to z/OS SMF records for
message flow accounting and statistics data.
The data records are type 117 records with the following identifiers:
* BipSMFDate
* BipSMFRecordHdr
* BipSMFTriplet
* BipSMFMessageFlow
* BipSMFThread
* BipSMFNode
* BipSMFTerminal
The following tables describe the contents of each of these records in the order
listed above.
The following table describes the contents of the BipSMFDate record.
Field Data type Details
YYYY signed short int 2 byte year
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Field Data type Details
MM char 1 byte month
DD char 1 byte day
The following table describes the contents of the BipSMFRecordHdr record.
Field Data type Details
SM117LEN unsigned short int SMF record length
SM117SEG unsigned short int System reserved
SM117FLG char System indicator
SM117RTY char Record type 117 (x'75)
SM117TME unsigned int Time when SMF moved the record (time since
midnight in hundredths of a second)
SM117DTE unsigned int Date when SMF moved the record in packed decimal
form OcyydddF where:
cis 0 (19xx) or 1 (20xx)
yy is the current year (0-99)
ddd is the current day (1-366)
F is the sign
SM117SID unsigned int System ID
SM117SSI1 unsigned int Subsystem ID
SM117STY unsigned short int Record subtype, one of :
* 1 (only message flow or threads data is being
collected)
* 2 (node data is being collected)’
SM117TCT unsigned int Count of triplets
SM117SRT unsigned char Record type, one of:
* Archive
* Snapshot
SM117SRC unsigned char Record code, one of:
* 00 = None
* 01 = Major Interval
* 02 = Snapshot
* 03 = Shutdown
* 04 = Redeploy
* 05 = Stats Settings Modified
SM117RSQ unsigned short int Sequence number of the record when multiple records
are written for a collection interval.
SM117NOR unsigned short int Total number of related records in a collection interval.
Note:
1. When only nodes data is being collected, a single subtype 2 record is written. If nodes and terminals data is
being collected, multiple subtype 2 records are written.

The following table describes the contents of the BipSMFTriplet record.

Field Data type Details
TRPLTOSE signed int Offset of record from start of SMF record
TRPLTDLE signed short int Length of data type
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Field

Data type

Details

TRPLTNDR signed short int Number of data types in SMF record
The following table describes the contents of the BipSMFMessageFlow record.

Field Data type Details

IMFLID short int Control block hex ID (BipSMFMessageFlow_ID)

IMFLLEN short int Length of control block

IMFLEYE char[4] Eyecatcher (IMFL)

IMFLVER int Version number (BipSMFRecordVersion)

IMFLBKNM char32] Broker name

IMFLBKID char[36] Broker universal unique identifier

IMFLEXNM char([32] Execution group name

IMFLEXID char[36] Execution group universal unique identifier

IMFLMFNM char([32] Message flow name

IMFLSTDT BipSMFDate Interval start date

IMFLSTTM unsigned int Interval start time (format as for SM117TME)

IMFLENDT BipSMFDate Interval end date

IMFLENTM unsigned int Interval end time (format as for SM117TME)

IMFLTPTM long long int Total elapsed time spent processing input messages (8
bytes binary, microseconds)

IMFLMXTM long long int Maximum elapsed time spent processing an input
message (8 bytes binary, microseconds)

IMFLMNTM long long int Minimum elapsed time spent processing an input
message (8 bytes binary, microseconds)

IMFLTPCP long long int Total CPU time spent processing input messages (8
bytes binary, microseconds)

IMFLMXCP long long int Maximum CPU time spent processing an input
message (8 bytes binary, microseconds)

IMFLMNCP long long int Minimum CPU time spent processing an input message
(8 bytes binary, microseconds)

IMFLWTCP long long int Total CPU time spent waiting for input messages (8
bytes binary, microseconds)

IMFLWTIN long long int Total elapsed time spent waiting for input messages (8
bytes binary, microseconds)

IMFLTPMG unsigned int Total number of messages processed

IMFLTSMG long long int Total size of input messages (bytes)

IMFLMXMG long long int Maximum input message size (bytes)

IMFLMNMG long long int Minimum input message size (bytes)

IMFLTHDP unsigned int Number of threads in pool

IMFLTHDM unsigned int Number of times the maximum number of threads is
reached

IMFLERMQ' unsigned int Number of MQGET errors (MQInput node)

IMFLERMG? unsigned int Number of messages that contain errors

IMFLERPR unsigned int Number of errors processing a message
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Field

Data type

Details

IMFLTMOU unsigned int Number of timeouts processing a message
(AggregateReply node only)

IMFLCMIT unsigned int Number of transaction commits

IMFLBKOU unsigned int Number of transaction backouts

IMFLACCT char[32] Accounting origin

Notes:

1. For example, a conversion error occurs when the message is got from the queue.
2. These include exceptions that are thrown downstream of the input node, and errors detected by the input node
after it has successfully retrieved the message from the queue (for example, a format error).

The following table describes the contents of the BipSMFThread record.

Field Data type Details

ITHDID short int Control block hex ID (BipSMFThread_ID)

ITHDLEN short int Length of control block

ITHDEYE char[4] Eyecatcher (ITHD)

ITHDVER int Version number (BipSMFRecordVersion)

ITHDNBR unsigned int Relative thread number in pool

ITHDTPMG unsigned int Total number of messages processed by thread

ITHDTPTM long long int Total elapsed time spent processing input messages (8 bytes
binary, microseconds)

ITHDTPCP long long int Total CPU time spent processing input messages (8 bytes
binary, microseconds)

ITHDWTCP long long int Total CPU time spent waiting for input messages (8 bytes
binary, microseconds)

ITHDWTIN long long int Total elapsed time spent waiting for input messages (8
bytes binary, microseconds)

ITHDTSMG long long int Total size of input messages (bytes)

ITHDMXMG long long int Maximum size of input messages (bytes)

ITHDMNMG long long int Minimum size of input messages (bytes)

The following table describes the contents of the BipSMFNode record.

Field Data type Details

INODID short int Control block hex ID (BipPSMFNode_ID)

INODLEN short int Length of control block

INODEYE char[4] Eyecatcher (INOD)

INODVER int Version number (BipSMFRecordVersion)

INODNDNM char[32] Name of node (Label)

INODTYPE char[32] Type of node

INODTPTM long long int Total elapsed time spent processing input messages (8

bytes binary, microseconds)
INODMXTM long long int Maximum elapsed time spent processing input messages
(8 bytes binary, microseconds)
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Field Data type Details

INODMNTM long long int Minimum elapsed time spent processing input messages
(8 bytes binary, microseconds)

INODTPCP long long int Total CPU time spent processing input messages (8 bytes
binary, microseconds)

INODMXCP long long int Maximum CPU time spent processing input messages (8
bytes binary, microseconds)

INODMNCP long long int Minimum CPU time spent processing input messages (8
bytes binary, microseconds)

INODTPMG unsigned int Total number of messages processed by this node

INODNITL unsigned int Number of input terminals

INODNOTL unsigned int Number of output terminals

The following table describes the contents of the BipSMFTerminal record.

Field Data type Details

ITRMID short int Control block hex ID (BipSMFTerminal_ID)

ITRMLEN short int Length of control block

ITRMEYE char[4] Eyecatcher (ITRM)

ITRMVER int Version number (BipSMFRecordVersion)

ITRMTLNM char[32] Name of terminal

ITRMTYPE char[8] Type of terminal, one of:
e Input
e Output

ITRMTINV unsigned int Total number of invocations

Example message flow accounting and statistics data

Examples are provided of the output generated for message flow accounting and

statistics data.

The following topics give example output in two formats:
* XML publication|
* |User trace entries|

An example is not provided for z/OS SMF records, because these contain
hexadecimal data and are not easily viewed in that form. To view SMF records, use
any available utility program that processes SMF records. For example, you can
download WebSphere MQ SupportPac IS11, which generates formatted SMF
records that are very similar to formatted user trace entries.

Example of an XML publication for message flow accounting and
statistics

This topic shows an XML publication that contains message flow accounting and
statistics data.

The following example shows the output generated for a snapshot report. The
content of this publication message shows that the message flow is called
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XMLflow, and that it is running in an execution group named default on broker
MQO2BRK. The message flow contains the following nodes:

* An MQInput node called INQueue3

* An MQOutput node called OUTQueue

* An MQOutput node called FAILQueue

The MQInput node out terminal is connected to the OUTQueue node. The
MQInput node failure terminal is connected to the FAILQueue node.

During the interval for which statistics have been collected, this message flow
processed no messages.

A publication generated for this data always includes the appropriate folders, even
if there is no current data.

The following command has been issued to achieve these results:

mgsichangeflowstats MQO2BRK -s -c active -e default -f XMLFlow -n advanced -t basic -b basic -o xml

Blank lines have been added between folders to improve readability.

<psc>
<Command>Pub1ish</Command>
<PubOpt>RetainPub</PubOpt>
<Topic>$SYS/Broker/MQO2BRK/StatisticsAccounting/SnapShot/default/XMLf1ow
</Topic>

</psc>

<mcd>
<Msd>xm1</Msd>
</mcd>

<WMQIStatisticsAccounting RecordType="SnapShot" RecordCode="Snapshot">

<MessageFlow BrokerLabel="MQO02BRK"
BrokerUUID="7d951e31-f200-0000-0080-efelb9d849dc"
ExecutionGroupName="default"
ExecutionGroupUUID="77cfle31-f200-0000-0080-efelb9d849dc"
MessageFTowName="XMLflow" StartDate="2003-01-17"
StartTime="14:44:34.581320" EndDate="2003-01-17" EndTime="14:44:44.582926"
TotalElapsedTime="0"
MaximumETapsedTime="0" MinimumElapsedTime="0" TotalCPUTime="0"
MaximumCPUTime="0"MinimumCPUTime="0" CPUTimeWaitingForInputMessage="685"
ElapsedTimeWaitingForInputMessage="10001425" TotalInputMessages="0"
TotalSizeOfInputMessages="0" MaximumSizeOfInputMessages="0"
MinimumSizeOfInputMessages="0" NumberOfThreadsInPool="1"
TimesMaximumNumberOfThreadsReached="0" TotalNumberOfMQErrors="0"
TotalNumberOfMessagesWithErrors="0" TotalNumberOfErrorsProcessingMessages="0"
TotalNumberOfTimeQutsWaitingForRepliesToAggregateMessages="0"
TotalNumberOfCommits="0" TotalNumberOfBackouts="0" AccoutingOrigin="Anonymous"/>

<Threads Number="1">

<ThreadStatistics Number="5" TotalNumberOfInputMessages="0"
TotalElapsedTime="0" TotalCPUTime="0" CPUTimeWaitingForInputMessage="685"
ElapsedTimeWaitingForInputMessage="10001425" TotalSizeOfInputMessages="0"
MaximumSizeOfInputMessages="0" MinimumSizeOfInputMessages="0"/>
</Threads>

<Nodes Number="3">
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<NodeStatistics Label="FAILQueue" Type="MQOutput" TotalElapsedTime="0"
MaximumElapsedTime="0" MinimumElapsedTime="0" TotalCPUTime="0"
MaximumCPUTime="0" MinimumCPUTime="0" CountOfInvocations="0"
NumberOfInputTerminals="1" NumberOfOutputTerminals="2">
<TerminalStatistics Label="failure" Type="Output" CountOfInvocations="0"/>
<TerminalStatistics Label="in" Type="Input" CountOfInvocations="0"/>
<TerminalStatistics Label="out" Type="Output" CountOfInvocations="0"/>
</NodeStatistics>

<NodeStatistics Label="INQueue3" Type="MQInput" TotalElapsedTime="0"
MaximumElapsedTime="0" MinimumElapsedTime="0" TotalCPUTime="0"
MaximumCPUTime="0" MinimumCPUTime="0"CountOfInvocations="0"
NumberOfInputTerminals="0" NumberOfOutputTerminals="3">
<TerminalStatistics Label="catch" Type="Output" CountOfInvocations="0"/>
<TerminalStatistics Label="failure" Type="Output" CountOfInvocations="0"/>
<TerminalStatistics Label="out" Type="Output" CountOfInvocations="0"/>

</NodeStatistics>

<NodeStatistics Label="0UTQueue" Type="MQOutput" TotalElapsedTime="0"
MaximumElapsedTime="0" MinimumElapsedTime="0" TotalCPUTime="0"
MaximumCPUTime="0" MinimumCPUTime="0" CountOfInvocations="0"
NumberOfInputTerminals="1" NumberOfOutputTerminals="2">
<TerminalStatistics Label="failure" Type="Output" CountOfInvocations="0"/>
<TerminalStatistics Label="in" Type="Input" CountOfInvocations="0"/>
<TerminalStatistics Label="out" Type="Output" CountOfInvocations="0"/>
</NodeStatistics>

</Nodes>

</WMQIStatisticsAccounting>

Example of user trace entries for message flow accounting and
statistics

This topic shows an XML publication that contains message flow accounting and
statistics data.

The following example shows the output generated for a snapshot report. The
messages written to the trace show that the message flow is called
myExampleFlow, and that it is running in an execution group named default on
broker MQO1BRK. The message flow contains the following nodes:

* An MQInput node called inNode

* An MQOutput node called outNode

The nodes are connected together (out terminal to in terminal for each connection).

During the interval for which statistics have been collected, this message flow
processed 150 input messages.

The records show that there are two threads assigned to this message flow. One
thread is assigned when the message flow is deployed (this is the default number);
an additional thread (thread 0) listens on the input queue. The listening thread
starts additional threads to process input messages dependent on the number of
instances that you have configured for the message flow, and the rate of arrival of
the input messages on the input queue.

The following command has been issued to achieve these results:
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mgsichangeflowstats MQO1BRK -s -c active -e default -f myExampleFlow -n advanced -t basic -b basic

The trace entries have been retrieved with the mgsireadlog command and
formatted using the mgsiformatlog command. The output from mgsiformatlog is
shown below. Line breaks have been added to aid readability.

BIP2380I: WMQI message flow statistics. ProcessID='328467', Key='6', Type='SnapShot', Reason='Snapshot',
BrokerLabel="MQO1BRK', BrokerUUID='18792e66-e100-0000-0080-f197e5ed81hd",
ExecutionGroupName="'default', ExecutionGroupUUID="'15d4314a-3607-11d4-8000-09140f7b0000",
MessageF1owName="'myExampleFlow',

StartDate='2003-05-20", StartTime='13:44:31.885862"',

EndDate='2003-05-20"', EndTime='13:44:51.310080",

TotalETapsedTime='9414843"', MaximumElapsedTime="'1143442"', MinimumElapsedTime="'35154",
TotalCPUTime='760147"', MaximumCPUTime='70729', MinimumCPUTime="'3124",
CPUTimeWaitingForInputMessage='45501", ElapsedTimeWaitingForInputMessage='11106438",
TotalInputMessages='150"', TotalSizeOfInputMessages='437250",
MaximumSizeOfInputMessages='2915"', MinimumSizeOfInputMessages='2915",
NumberOfThreadsInPool="'1"', TimesMaximumNumberOfThreadsReached="'150",
TotalNumberOfMQErrors='0"', TotalNumberOfMessagesWithErrors='0",
TotalNumberOfErrorsProcessingMessages='0"', TotalNumberOfTimeOuts='0",
TotalNumberOfCommits="'150"', TotalNumberOfBackouts='0"', AccountingOrigin="Anonymous".
Statistical information for message flow 'myExampleFlow' in broker 'MQO1BRK"'.

This is an information message produced by WMQI statistics.

BIP2381I: WMQI thread statistics. ProcessID='328467', Key='6', Number='0",
TotalNumberOfInputMessages='0",

TotalETapsedTime='0', TotalCPUTime='0"', CPUTimeWaitingForInputMessage='110",
ETapsedTimeWaitingForInputMessage='5000529', TotalSizeOfInputMessages='0",
MaximumSizeOfInputMessages='0"', MinimumSizeOfInputMessages='0".

Statistical information for thread '0'.

This is an information message produced by WMQI statistics.

BIP23811: WMQI thread statistics. ProcessID='328467', Key='6', Number='18",
TotalNumberOfInputMessages="'150",

TotalETapsedTime='9414843"', TotalCPUTime='760147"', CPUTimeWaitingForInputMessage='45391",
ElapsedTimeWaitingForInputMessage='6105909', TotalSizeOfInputMessages='437250",
MaximumSizeOfInputMessages='2915"', MinimumSizeOfInputMessages='2915".

Statistical information for thread '18'.

This is an information message produced by WMQI statistics.

BIP2382I: WMQI node statistics. ProcessID='328467', Key='6",

Label="inNode', Type='MQInputNode',

TotalETapsedTime="'1813446"', MaximumETlapsedTime='1040209', MinimumElapsedTime='1767",
TotalCPUTime='70565"', MaximumCPUTime='686"', MinimumCPUTime="'451",
CountOfInvocations='150"', NumberOfInputTerminals='0"', NumberOfOutputTerminals='3".
Statistical information for node 'inNode'.

This is an information message produced by WMQI statistics.

BIP2383I: WMQI terminal statistics. ProcessID='328467', Key='6",
Label="'catch', Type='Output', CountOfInvocations='0",
Statistical information for terminal 'catch'.

This is an information message produced by WMQI statistics.

BIP2383I: WMQI terminal statistics. ProcessID='328467', Key='6",
Label="'failure', Type='Output', CountOfInvocations='0",
Statistical information for terminal 'failure'.

This is an information message produced by WMQI statistics.

BIP2383I: WMQI terminal statistics. ProcessID='328467', Key='6",
Label="'out', Type='Output', CountOfInvocations='150",
Statistical information for terminal 'out'.

This is an information message produced by WMQI statistics.

BIP23821: WMQI node statistics. ProcessID='328467', Key='6"',

Label="'outNode', Type='MQOutputNode',

TotalETapsedTime='1172582"', MaximumElapsedTime='177516"', MinimumElapsedTime="'3339",
TotalCPUTime='85522"', MaximumCPUTime='762"', MinimumCPUTime='536",
CountOfInvocations='150"', NumberOfInputTerminals='1"', NumberOfOutputTerminals='2".
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Statistical information for node 'outNode'.
This is an information message produced by WMQI statistics.

BIP2383I: WMQI terminal statistics. ProcessID='328467', Key='6",
Label="'failure', Type='Output', CountOfInvocations='0",
Statistical information for terminal 'failure'.

This is an information message produced by WMQI statistics.

BIP2383I: WMQI terminal statistics. ProcessID='328467', Key='6",
Label="in', Type='Input', CountOfInvocations='150",

Statistical information for terminal 'in'.

This is an information message produced by WMQI statistics.

BIP2383I: WMQI terminal statistics. ProcessID='328467', Key='6"',
Label='out', Type='Output', CountOfInvocations='0",

Statistical information for terminal 'out'.

This is an information message produced by WMQI statistics.
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Appendix. Notices
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this information
in other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this information. The furnishing of this information does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032,

Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the information. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
information at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM United Kingdom Laboratories,
Mail Point 151,

Hursley Park,

Winchester,

Hampshire,

England

5021 2]JN

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Programming License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information includes examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not



been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

(C) (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.

Trademarks

The following terms are trademarks of International Business Machines
Corporation in the United States, other countries, or both:

AIX CICS Cloudscape

DB2 DB2 Connect DB2 Universal Database

developerWorks Domino

Everyplace FFST First Failure Support
Technology

IBM IBMLink ™MS

IMS/ESA iSeries Language Environment

Lotus MQSeries MVS

NetView 0S/400 0S/390

pSeries RACF Rational

Redbooks RETAIN RS/6000

SupportPac Tivoli VisualAge

WebSphere xSeries z/0OS

zSeries

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Intel and Pentium are trademarks or registered trademark of Intel Corporation or
its subsidiaries in the United States and other countries.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product, or service names may be trademarks or service marks of
others.
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